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Executive Summary 1 

▪ Privileged accounts are used to access and manage an organization’s information assets and 2 
systems. Often described as the “keys to the kingdom,” these accounts are used by trusted 3 
users who perform tasks that ordinary users are not authorized to perform. 4 

▪ Controlling these accounts is challenging, as the very nature of the functions that they perform 5 
requires broad access and authority. Additionally, this broad access makes privileged accounts a 6 
tempting target for external and internal malicious actors and increases the impact of accidental 7 
mistakes. 8 

▪ Malicious actors can inflict substantial harm, often without notice. Industry reports have 9 
identified that privilege misuse is a major component of reported cyber incidents, with 10 
estimates up to 80 percent of all data breaches (Forrester 2016). 11 

▪ To address this challenge, the National Cybersecurity Center of Excellence (NCCoE) has 12 
developed a reference design that illustrates how financial institutions can implement a 13 
privileged account management (PAM) system to secure, manage, control, and audit the use of 14 
privileged accounts. 15 

▪ This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide 16 
describes how financial-services companies can use commercially available technology to 17 
implement PAM to reduce the risk associated with privileged accounts. 18 

CHALLENGE 19 

Financial organizations rely on privileged accounts to enable authorized users to perform their duties 20 

with little to no direct oversight or technical control of their actions. Companies have difficulty managing 21 

these accounts, which, in turn, opens a significant risk to the business. If used improperly, these 22 

accounts can cause substantial operational damage, including data theft, espionage, sabotage, or 23 

ransom. Malicious external actors can gain unauthorized access to privileged accounts through a variety 24 

of techniques, such as leveraging stolen credentials or social engineering schemes. In addition, there are 25 

rare instances of disgruntled employees who abuse their accounts, as well as honest employees who 26 

make mistakes. Misuse and mistakes can affect both high-value applications (e.g., payment systems) 27 

and core systems (e.g., human resources, database access, access control). 28 

Managing privileged accounts is an important, yet complicated, task. Financial institutions often operate 29 

highly complex infrastructure and disparate systems that run on multiple operating systems. Managing 30 

and controlling access to these privileged accounts is further complicated by the significant pace of 31 

workforce and responsibility changes over time. Lastly, changes made at a system level can be used to 32 

bypass controls, to hide activity, and to cause financial institutions to breach their stringent reporting 33 

and compliance requirements.  34 

SOLUTION 35 

The NCCoE, in collaboration with experts from the financial services sector and technology vendors, 36 

developed a PAM system that controls, monitors, logs, and alerts on the use of privileged accounts. The 37 

example implementation highlights how organizations can add a security layer between users and the 38 

privileged accounts they access. This guide outlines the practical steps to secure privileged accounts in 39 

https://csrc.nist.gov/csrc/media/publications/sp/800-53/rev-5/draft/documents/sp800-53r5-draft.pdf
https://csrc.nist.gov/csrc/media/publications/sp/800-53/rev-5/draft/documents/sp800-53r5-draft.pdf
https://www.forrester.com/report/The+Forrester+Wave+Privileged+Identity+Management+Q3+2016/-/E-RES123903
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your organization. We developed representative use-case scenarios to address specific challenges that 40 

the financial services sector faces during normal day-to-day business operations. 41 

This guide references NIST guidance and industry standards, including the Federal Financial Institutions 42 

Examination Council Cybersecurity Assessment Tool. 43 

The NCCoE sought existing technologies that provided the following capabilities: 44 

▪ privileged account control 45 

▪ privileged account command filtering (allow or deny specific commands, such as disk 46 
formatting) 47 

▪ multifactor authentication capability 48 

▪ access logging/database system 49 

▪ password management, including storage (vault) 50 

▪ separation of duties management 51 

▪ support least privileged policies 52 

▪ password obfuscation (hiding passwords from PAM users) 53 

▪ temporary access management 54 

▪ automated logging and log management (analytics, storage, alerting) 55 

▪ secure communications between components, where applicable 56 

▪ ad hoc reporting to answer management, performance, and security questions 57 

▪ support for multiple access levels for the PAM system (e.g., administrator, operator, viewer) 58 

▪ protection from the introduction of new attack vectors into existing systems 59 

▪ a complement to, rather than the replacement of, the existing security infrastructure 60 

While the NCCoE used a suite of commercial products to address this challenge, this guide does not 61 

endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. Your 62 

organization’s information security experts should identify the products that will best integrate with 63 

your existing tools and information-technology system infrastructure. Your organization can adopt this 64 

solution or one that adheres to these guidelines in whole, or you can use this guide as a starting point 65 

for tailoring and implementing parts of a solution. 66 

BENEFITS 67 

Implementing a PAM system is an essential way for financial institutions to effectively secure, manage, 68 

control, and audit the activities of privileged accounts. A properly implemented and administered PAM 69 

system can help your organization meet compliance requirements, limit opportunity for and reduce the 70 

damage that a privileged user can cause, and improve the enforcement of access policies. The NCCoE’s 71 

practice guide to address PAM for the financial services sector can help your organization: 72 

▪ identify vulnerabilities and risk factors within your organization 73 

▪ limit opportunity for a successful attack by improving control over privileged accounts 74 
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▪ improve efficiencies by reducing the complexity associated with managing privileged accounts, 75 
which leads to the following results: 76 

• minimized damage that results from misuse and mistakes by internal/external actors 77 

• automated enforcement of existing access policies 78 

▪ simplify compliance by producing automated reports and documentation 79 

SHARE YOUR FEEDBACK 80 

You can view or download the guide at https://www.nccoe.nist.gov/projects/use-cases/privileged-81 

account-management. Help the NCCoE make this guide better by sharing your thoughts with us as you 82 

read the guide. If you adopt this solution for your own organization, please share your experience and 83 

advice with us. We recognize that technical solutions alone will not fully enable the benefits of our 84 

solution, so we encourage organizations to share lessons learned and best practices for transforming the 85 

processes associated with implementing this guide.  86 

To provide comments or to learn more by arranging a demonstration of this example implementation, 87 

contact the NCCoE at financial_nccoe@nist.gov. 88 

 89 

TECHNOLOGY PARTNERS/COLLABORATORS 90 

Organizations participating in this project submitted their capabilities in response to an open call in the 91 

Federal Register for all sources of relevant security capabilities from academia and industry (vendors 92 

and integrators). The following respondents with relevant capabilities or product components (identified 93 

as “Technology Partners/Collaborators” herein) signed a Cooperative Research and Development 94 

Agreement (CRADA) to collaborate with NIST in a consortium to build this example solution.  95 

 96 

Certain commercial entities, equipment, products, or materials may be identified by name or company 97 

logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 98 

experimental procedure or concept adequately. Such identification is not intended to imply special 99 

status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 100 

intended to imply that the entities, equipment, products, or materials are necessarily the best available 101 

for the purpose. 102 

 

The National Cybersecurity Center of Excellence (NCCoE), a part of the 
National Institute of Standards and Technology (NIST), is a collaborative 
hub where industry organizations, government agencies, and academic 
institutions work together to address businesses’ most pressing 
cybersecurity challenges. Through this collaboration, the NCCoE 
develops modular, easily adaptable example cybersecurity solutions 
demonstrating how to apply standards and best practices using 
commercially available technology. 

 Learn More  
Visit https://www.nccoe.nist.gov 
nccoe@nist.gov 
301-975-0200 

 

https://www.nccoe.nist.gov/projects/use-cases/privileged-account-management
https://www.nccoe.nist.gov/projects/use-cases/privileged-account-management
mailto:financial_nccoe@nist.gov
https://www.nccoe.nist.gov/
mailto:nccoe@nist.gov
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DISCLAIMER 
Certain commercial entities, equipment, products, or materials may be identified in this document in 
order to describe an experimental procedure or concept adequately. Such identification is not intended 
to imply recommendation or endorsement by NIST or NCCoE, nor is it intended to imply that the 
entities, equipment, products, or materials are necessarily the best available for the purpose. 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 
The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 
public-private partnership enables the creation of practical cybersecurity solutions for specific 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 
Fortune 50 market leaders to smaller companies specializing in information technology (IT) security—
the NCCoE applies standards and best practices to develop modular, easily adaptable example 
cybersecurity solutions using commercially available technology. The NCCoE documents these example 
solutions in the NIST Special Publication 1800 series, which maps capabilities to the NIST Cyber Security 
Framework and details the steps needed for another entity to recreate the example solution. The NCCoE 
was established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 
Md. 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 
https://www.nist.gov. 

NIST CYBERSECURITY PRACTICE GUIDES 
NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 
adoption of standards-based approaches to cybersecurity. They show members of the information 
security community how to implement example solutions that help them align more easily with relevant 
standards and best practices, and provide users with the materials lists, configuration files, and other 
information they need to implement a similar approach. 

The documents in this series describe example implementations of cybersecurity practices that 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 
or mandatory practices, nor do they carry statutory authority.  

ABSTRACT 
Privileged account management (PAM) is a domain within identity and access management (IdAM) that 
focuses on monitoring and controlling the use of privileged accounts. Privileged accounts include local 
and domain administrative accounts, emergency accounts, application management, and service 
accounts. These powerful accounts provide elevated, often nonrestricted, access to the underlying IT 
resources and technology, which is why external and internal malicious actors seek to gain access to 
them. Hence, it is critical to monitor, audit, control, and manage privileged account usage. Many 
organizations, including financial sector companies, face challenges in managing privileged accounts.  

https://www.nccoe.nist.gov/
https://www.nist.gov/
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The goal of this project is to demonstrate a PAM capability that effectively protects, monitors, and 
manages privileged account access, including life-cycle management, authentication, authorization, 
auditing, and access controls. 

KEYWORDS 
Access control, auditing, authentication, authorization, life-cycle management, multifactor 
authentication, PAM, privileged account management, provisioning management  
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1 Summary 93 

Financial organizations rely on privileged accounts to enable authorized users, such as systems 94 
administrators, to perform essential duties that ordinary users are not authorized to perform [1]. For 95 
example, system administrators use privileged “super user” accounts to manage information technology 96 
(IT) infrastructures and resources or to access high-value applications (e.g., payment systems, 97 
accounting systems) and core systems (e.g., human resources, database access, access control). 98 

Despite being the “keys to the kingdom,” these privileged accounts rarely receive direct oversight or 99 
technical control of how they are used. The lack of oversight and technical control poses a substantial 100 
operational and financial risk for organizations. If used improperly, privileged accounts can cause much 101 
damage, including data theft, espionage, sabotage, or ransom—often without notice. Privilege misuse is 102 
a major contributor of reported cyber incidents, with estimates as much as 80 percent of all data 103 
breaches [2]. Malicious external actors can gain unauthorized access to privileged accounts through 104 
various techniques, including leveraging stolen credentials, malware, social engineering schemes, or 105 
default passwords. In addition, there are occasional instances of disgruntled employees who abuse their 106 
accounts, even after they have left the company. Honest employees or contractors can also cause 107 
damage and downtime by making accidental mistakes with privileged accounts, even though that access 108 
was unnecessary for them to perform their work.  109 

Organizations must harden themselves against these operational and reputational risks by implementing 110 
policies and technologies that detect and prevent the misuse of privileged accounts by external and 111 
internal actors. This combination of detection and prevention technologies and policies is referred to as 112 
privileged account management (PAM). PAM systems typically use one of two techniques for controlling 113 
account access and use: account escalation or account sharing. The account escalation technique 114 
escalates the privileged/authorized activity for each user’s personal account for the duration of the 115 
session with the target system, based on the organizational policies. The account sharing technique 116 
utilizes a set of privileged accounts that are shared among the authorized privileged users via the PAM 117 
system. 118 

Managing the access and use of privileged accounts is difficult without proper planning and tools. The 119 
National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 120 
Technology (NIST) built a laboratory environment to explore methods to manage and monitor the use 121 
of privileged accounts by authorized users as they perform their normal activities, as well as techniques 122 
to protect against and detect the unauthorized use of privileged accounts. NIST Special Publication (SP) 123 
800-171 [1], Protecting Controlled Unclassified Information in Nonfederal Information Systems and 124 
Organizations, defines a privileged user as “a user that is authorized (and therefore, trusted) to perform 125 
security-relevant functions that ordinary users are not authorized to perform.” Privileged accounts are 126 
utilized in managing IT infrastructures, resources, and applications, as well as access to, and the use of, 127 
high-value applications like payment systems, accounting systems, and social media accounts.  128 
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The reference design and example solutions outlined in this guide describe example solutions built in 129 
the NCCoE lab. After reading this NIST Cybersecurity Practice Guide, an organization should be able to 130 
implement a PAM system that effectively monitors and manages privileged accounts. The solutions built 131 
in the NCCoE lab are not the only combination of technologies that can address this issue. They are 132 
examples demonstrating that off-the-shelf and open-source technologies are available to implement 133 
PAM.  134 

The goals of this NIST Cybersecurity Practice Guide are to help organizations confidently: 135 

 control access to, and the use of, privileged accounts (both on-premises and in the cloud) 136 

 manage and monitor the activity of privileged accounts 137 

 audit the activity of privileged accounts 138 

 receive alerts or notifications when privileged accounts are used for unauthorized or out-of-139 
policy activities  140 

 encourage personal accountability among the users of privileged accounts 141 

 enforce stringent policies for “least privilege” and separation of duties 142 

For ease of use, a short description of the different sections of this volume is provided below: 143 

 Section 1, Summary, presents the challenges addressed by the NCCoE project, with a look at the 144 
solution demonstrated to address the challenge, as well as benefits of the solution. This section 145 
also explains how to provide feedback on this guide. 146 

 Section 2, How to Use This Guide, explains how readers—business decision makers, program 147 
managers, cybersecurity practitioners, and IT professionals (e.g., systems administrators)—148 
might use each volume of this guide. 149 

 Section 3, Approach, offers a detailed treatment of the scope of the project. This section also 150 
describes the assumptions on which the security architecture development was based; the risk 151 
assessment that informed architecture development; and NIST Cybersecurity Framework [3] 152 
functions supported by each component of the architecture and reference design, which 153 
industry collaborators contributed to support in building, demonstrating, and documenting the 154 
solution. This section also includes a mapping of the Cybersecurity Framework subcategories to 155 
other industry guidance, and identifies the products used to address each subcategory. 156 

 Section 4, Architecture, describes the usage scenarios supported by the project architecture and 157 
reference design, as well as the capability descriptions, including a description of the 158 
relationship among the capabilities. 159 

 Section 5, Example Implementations, provides in-depth descriptions of the implementations 160 
developed in the NCCoE’s lab environment. 161 
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 Section 6, Security Characteristics Analysis, analyzes how to secure the components within the 162 
solution and minimize any vulnerabilities that they might have. This section also explains how 163 
the architecture addresses the security goals of the project. 164 

 Section 7, Functional Evaluation, summarizes the test cases that we employed to demonstrate 165 
the example implementations’ functionality and the Cybersecurity Framework functions to 166 
which each test case is relevant. 167 

1.1 Challenge 168 

In modern financial organizations, employees need access to a variety of applications, resources, and 169 
systems to ensure efficient business operations and meaningful customer experiences. Employees often 170 
access those systems through user accounts—commonly secured by usernames and passwords. Not all 171 
accounts are created equal, however. Some accounts—known as privileged accounts—are authorized to 172 
perform actions that ordinary accounts do not have authorization to perform. These privileged accounts 173 
provide elevated, often unrestricted, access to corporate resources and critical systems (e.g., crown 174 
jewels) beyond what a regular user would have. IT administrators and managers use these privileged 175 
accounts to perform system-critical actions, including maintenance, system management, and access 176 
control.  177 

Privileged accounts pose significant operational, legal, and reputational risk to organizations if not 178 
secured effectively. The accounts become the virtual “keys to the kingdom,” permitting unfettered 179 
access to many, if not all, systems within an organization. 180 

The core risk of privileged accounts is that an organization faces significant damage to business 181 
operations if the accounts are misused for malicious or erroneous purposes. Malicious external 182 
attackers understand the value of privileged accounts and target them to maximize their access to the 183 
data, applications, and infrastructure of an organization, putting the organization at risk of data breach, 184 
espionage, sabotage, or ransom. Further, malicious actors may also be able to leverage privileged 185 
accounts to bypass, defeat, or otherwise render inoperable, other cybersecurity or legal compliance 186 
protections that protect critical systems or data. 187 

The risk of privileged accounts is not limited to malicious external actors. Though relatively infrequent, 188 
there are instances of disgruntled employees leveraging their own or colleagues’ privileged accounts for 189 
malicious purposes, including exfiltrating sensitive data, industrial sabotage, or creating technical 190 
backdoors that they or others can abuse after leaving the organization. Although less malicious, there 191 
are also instances in which well-meaning employees make mistakes while using their privileged 192 
accounts; these unintentional mistakes can cause significant disruption, which can influence business 193 
operations and customer satisfaction. 194 

Managing access to, and the use of, privileged accounts is difficult without planning and tools. This 195 
practice guide provides the much-needed guidance and examples that financial institutions can use to 196 
reduce the risk of privileged accounts in their organization. 197 
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1.2 Solution 198 

Organizations require a PAM solution that appropriately secures privileged accounts and enforces 199 
organizational policies for privileged account use. The NCCoE developed a PAM reference design that 200 
addresses these issues, providing control, oversight, and management of privileged accounts. The 201 
reference design outlines how monitoring, auditing, and authentication controls can combine to prevent 202 
unauthorized access to, and allow rapid detection of unapproved use, of privileged accounts.  203 

The NCCoE developed example solutions, based on the reference design, that incorporate appropriate, 204 
commercially available technologies to manage and control the use of privileged accounts. The solutions 205 
are composed of multiple systems working together to enforce organizational access policies and to 206 
protect privileged accounts from misuse. These example solutions illustrate the various technical 207 
approaches available for PAM and the multiple areas of an organization (e.g., infrastructure, 208 
applications, cloud services, security monitoring), that can be considered for policy enforcement. This 209 
guide will also explain the importance of implementing policies, such as least privilege and separation of 210 
duties, for accounts that provide access to the data, applications, and infrastructure across an 211 
organization.  212 

The NCCoE sought existing technologies that provided the following capabilities: 213 

 privileged account control (password management and privilege escalation techniques) 214 

 multifactor authentication (MFA) 215 

 support both on-premises and cloud business systems 216 

 event logging (e.g., access requests, logins, users) 217 

 password management (including hiding passwords from users) 218 

 policy management 219 

 emergency/break-glass access 220 

 log management (analytics, storage, alerting) 221 

 user behavior analytics (UBA) 222 

While the NCCoE used a suite of commercial products to address this cybersecurity challenge, this guide 223 
does not endorse these particular, nor does it guarantee compliance with any regulatory initiatives. Your 224 
organization’s information security experts should identify the products that will best integrate with 225 
your existing tools and IT system infrastructure. Your organization can adopt this solution or one that 226 
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and 227 
implementing parts of the design to the needs of your organization and its risk management decisions.  228 
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In developing our reference design, we used portions of the following standards and guidance, which 229 
can also provide your organization with relevant standards and best practices: 230 

 NIST SP 800-171 Rev. 1: Protecting Controlled Unclassified Information in Nonfederal Systems 231 
and Organizations [1] 232 

 NIST Framework for Improving Critical Infrastructure Cybersecurity (commonly known as the 233 
NIST Cybersecurity Framework) [3] 234 

 NIST SP 800-30 Rev. 1: Guide for Conducting Risk Assessments [4] 235 

 NIST SP 800-37 Rev. 1: Guide for Applying the Risk Management Framework to Federal 236 
Information Systems: A Security Life Cycle Approach [5] 237 

 NIST SP 800-39: Managing Information Security Risk [6] 238 

 NIST SP 800-53 Rev. 4: Security and Privacy Controls for Federal Information Systems and 239 
Organizations [7] 240 

 Federal Information Processing Standards (FIPS) 140-2: Security Requirements for Cryptographic 241 
Modules [8] 242 

 NIST SP 800-92: Guide to Computer Security Log Management [9] 243 

 NIST SP 800-100: Information Security Handbook: A Guide for Managers [10] 244 

 Office of Management and Budget (OMB), Circular Number A-130: Managing Information as a 245 
Strategic Resource [11] 246 

 Federal Financial Institutions Examination Council (FFIEC), Cybersecurity Assessment Tool (CAT) 247 
[12] 248 

 NIST SP 800-63B: Digital Identity Guidelines: Authentication and Lifecycle Management [13] 249 

1.3 Benefits 250 

Implementing a PAM system is an essential way for financial institutions to effectively secure, manage, 251 
control, and audit the activities of privileged accounts. A properly implemented and administered PAM 252 
system can help an organization meet compliance requirements; limit opportunity for and reduce the 253 
damage that users of privileged accounts—whether authorized or unauthorized—can cause; and 254 
improve the enforcement of an organization’s access policies. 255 

The NCCoE’s practice guide can help an organization: 256 

 identify vulnerabilities and manage enterprise risk factors within the organization (consistent 257 
with the foundations of the NIST Cybersecurity Framework) [3] 258 

 reduce the opportunity for a successful attack by improving control over privileged accounts 259 

 improve efficiencies by reducing complexity associated with managing privileged accounts 260 
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 maintain the integrity and availability of data and systems that are critical to supporting 261 
business operations and revenue-generating activities 262 

 reduce the impact of insider and external threats and other malicious or unintentional activity 263 
utilizing privileged accounts and accessing business-critical systems 264 

 develop an implementation plan for PAM 265 

 automate the enforcement of existing access policies  266 

2 How to Use This Guide 267 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 268 
users with the information they need to replicate a solution for managing privileged accounts. This 269 
reference design is modular and can be deployed in whole or in part. 270 

This guide contains three volumes: 271 

 NIST SP 1800-18A: Executive Summary 272 

 NIST SP 1800-18B: Approach, Architecture, and Security Characteristics – what we built and why 273 
(you are here) 274 

 NIST SP 1800-18C: How-To Guides – instructions for building the example solution 275 

Depending on your role in your organization, you might use this guide in different ways: 276 

Business decision makers, including chief security and technology officers, will be interested in the 277 
Executive Summary, NIST SP 1800-18A, which describes the following topics: 278 

 challenges enterprises face in managing privileged accounts 279 

 example solutions built at the NCCoE 280 

 benefits of adopting an example solution 281 

Technology or security program managers who are concerned with how to identify, understand, assess, 282 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-18B, which describes what we 283 
did and why. The following sections will be of particular interest: 284 

 Section 3.4, Risk Assessment, provides a description of the risk analysis we performed 285 

 Section 3.4.2, Security Control Map, maps the security characteristics of this example solution to 286 
cybersecurity standards and best practices 287 

You might share the Executive Summary, NIST SP 1800-18A, with your leadership team members to help 288 
them understand the importance of adopting a standards-based PAM reference design that provides the 289 
control, oversight, and management of privileged accounts. 290 
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IT professionals who want to implement an approach like this will find the whole practice guide useful. 291 
You can use the How-To portion of the guide, NIST SP 1800-18C, to replicate all or parts of the build 292 
created in our lab. The How-To portion of the guide provides specific product installation, configuration, 293 
and integration instructions for implementing the example solution. We do not recreate the product 294 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 295 
incorporated the products together in our environment to create an example solution. 296 

This guide assumes that IT professionals have experience implementing security products within the 297 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 298 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 299 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 300 
parts of a PAM solution. Your organization’s security experts should identify the products that will best 301 
integrate with your existing tools and IT system infrastructure. We hope that you will seek products that 302 
are congruent with applicable standards and best practices. Section 3.6, Technologies, lists the products 303 
we used and maps them to the cybersecurity controls provided by this reference solution. 304 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 305 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 306 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 307 
financial_nccoe@nist.gov. 308 

2.1 Typographic Conventions 309 

The following table presents typographic conventions used in this volume. 310 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For detailed definitions of terms, see 
the NCCoE Glossary. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
on-screen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

mailto:financial_nccoe@nist.gov
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Typeface/Symbol Meaning Example 

blue text link to other parts of the doc-
ument, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

3 Approach 311 

Based on discussions with cybersecurity practitioners in the financial sector, the NCCoE pursued a PAM 312 
project to illustrate the broad set of capabilities available to manage privileged accounts. NCCoE 313 
engineers further worked to define the requirements for the PAM project by collaborating with the 314 
NCCoE Financial Sector Community of Interest (COI). 315 

Members of the COI, which include participating vendors referenced in this document, contributed to 316 
developing a reference design and example implementations. Vendors provided technologies that met 317 
the project requirements, and assisted in installing and configuring those technologies. This practice 318 
guide highlights the approach that was used to develop the NCCoE reference design. Elements include 319 
risk assessment and analysis, logical design, example implementation development, test and evaluation, 320 
and security control mapping. This guide is intended to provide practical guidance to any organization 321 
interested in implementing a solution for managing and controlling the use of privileged accounts and 322 
for accessing business-critical/high-value systems and applications. 323 

3.1 Audience 324 

This guide is intended for individuals responsible for securing an organization’s IT infrastructure, 325 
business systems, and applications (including cloud services). Current IT systems, particularly in the 326 
private sector, often lack PAM. The reference design and example solutions demonstrated by this 327 
project, and the implementation information provided in this practice guide, permit the integration of 328 
products to implement a PAM system and to protect current IT systems. The technical components will 329 
appeal to system administrators, IT managers, IT security managers, cybersecurity practitioners, and 330 
others directly involved in the secure and safe operation of the IT systems on which businesses rely. 331 

3.2 Scope 332 

This PAM practice guide includes a high-level architecture, reference design, and example 333 
implementations that depict approaches to manage and control the use of privileged accounts that use 334 
off-the-shelf and open-source technologies. This guide provides practical, real-world general guidance 335 
for developing and implementing a PAM solution consistent with the principles in the NIST Framework 336 
for Improving Critical Infrastructure Cybersecurity Volume 1 (Cybersecurity Framework) [3]. The PAM 337 
reference design addresses subcategories within each of the Cybersecurity Framework core functions, 338 
as shown in the mapping of the reference design capabilities to the Cybersecurity Framework. Example 339 

https://www.nccoe.nist.gov/
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implementations (demonstrable lab implementations) include a broad range of technologies that 340 
provide organizations with various methods to control, monitor, audit, and enforce policies for the use 341 
of privileged accounts by privileged users. The architecture and technologies demonstrated by this 342 
project, and the implementation information provided in this practice guide, can inform the 343 
implementation of a PAM system by the integration of standards-based products. In addition, this guide 344 
describes how to monitor for unauthorized privilege escalation changes. Unauthorized-privilege-345 
escalation monitoring is described in Section 4.1.2, Reference Design. 346 

The following items were determined to be out of scope for this practice guide: 347 

 specific PAM policy recommendations, other than following best-practice policies for least 348 
privilege and separation of duties 349 

 specific PAM implementation guidance: The example solutions illustrated in this practice guide 350 
are intended to offer a broad set of examples of PAM deployments. 351 

 specific security controls appropriate to secure the PAM system: General guidance is provided in 352 
Section 6. 353 

In addition, the NCCoE is not recommending any one example solution as the approach to implement 354 
PAM. The example solutions illustrated in this practice guide are intended to offer a broad set of 355 
examples of PAM deployments. An organization implementing PAM should consider an implementation 356 
that is consistent with its risk management decisions.  357 

3.3 Assumptions 358 

This project is guided by the following assumptions: 359 

 The solutions were developed in a lab environment. The environment is based on a typical 360 
organization’s IT enterprise. The environment does not reflect the complexity of a production 361 
environment. 362 

 An organization can access the skills and resources required to implement a PAM solution. 363 

3.4 Risk Assessment 364 

NIST SP 800-30 [4], Guide for Conducting Risk Assessments, states that risk is “a measure of the extent to 365 
which an entity is threatened by a potential circumstance or event, and typically a function of (i) the 366 
adverse impacts that would arise if the circumstance or event occurs and (ii) the likelihood of 367 
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and 368 
prioritizing risks to organizational operations (including mission, functions, image, reputations), 369 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 370 
an information system. Part of risk management incorporates threat and vulnerability analyses, and 371 
considers mitigations provided by security controls planned or in place.” 372 
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The NCCoE recommends that any discussion of risk management, particularly at the enterprise level, 373 
begins with a comprehensive review of NIST 800-37 [5], Guide for Applying the Risk Management 374 
Framework to Federal Information Systems—material that is available to the public. The risk 375 
management framework guidance, as a whole, proved to be invaluable in giving us a baseline to assess 376 
risks, from which we developed the project, the security characteristics of the build, and this guide. 377 

We performed two types of risk assessment: 378 

 initial analysis of the risk factors that were discussed with financial institutions: This analysis led 379 
to the creation of the PAM project and the desired security posture. 380 

 analysis of how to secure the components within a solution and minimize any vulnerabilities 381 
that they might introduce (see Section 6, Security Characteristics Analysis) 382 

3.4.1 Assessing Risk Posture 383 

Using the guidance in NIST’s series of publications concerning risk, we worked with financial institutions 384 
and the Financial Sector Information Sharing and Analysis Center to identify the most-compelling risk 385 
factors encountered by this business group. We participated in conferences and met with members of 386 
the financial sector to define the main security risks to business operations. These discussions gave us an 387 
understanding of strategic (mission) risks for organizations, with respect to PAM. NIST SP 800-39, 388 
Managing Information Security Risk [6], focuses on the business aspect of risk, namely at the enterprise 389 
level. This understanding is essential for any further risk analysis, risk response/mitigation, and risk 390 
monitoring activities. A summary of the strategic risk areas that we identified, and their mitigations, is 391 
provided below: 392 

 Impact on system function: Ensuring the acceptable system availability, PAM reduces the risk of 393 
systems being compromised due to insiders and external malicious actors. 394 

 Compliance with industry regulations: PAM complies with industry regulatory compliance 395 
requirements for access control for privileged accounts and corporate resources (e.g., data, 396 
applications). 397 

 Maintenance of reputation and public image: PAM helps reduce the level of impact of insiders 398 
and external malicious actors, in turn helping maintain image. 399 

These discussions also resulted in identifying a technical (operational) area of concern: the inability to 400 
adequately control the use of privileged accounts. We then identified the core operational risks, 401 
resulting from a privileged account compromise: 402 

 data theft 403 

 malicious/unauthorized/out-of-policy use of corporate resources (e.g., applications, computing 404 
resources) 405 



DRAFT 

 
NIST SP 1800-18B: Privileged Account Management for the Financial Services Sector 11 

 system unavailability 406 

 data manipulation 407 

We subsequently translated the identified operational risk factors to security functions and 408 
subcategories within the NIST Cybersecurity Framework.  409 

3.4.2 Security Control Map 410 

As explained in Section 3.4.1, we used a risk analysis process to identify the Cybersecurity Framework 411 
security functions and subcategories that we wanted the reference design to support. This was a critical 412 
first step in designing the reference design and example implementations to mitigate the risk factors. 413 
Table 3-1 lists the addressed Cybersecurity Framework functions and subcategories, and maps them to 414 
relevant NIST standards, industry standards, and controls and best practices. In Table 3-1, we mapped 415 
the categories to NIST’s SP 800-53 Rev. 4 [7] controls, to International Electrotechnical Commission 416 
(IEC) / International Organization for Standardization (ISO) controls, and to FFIEC CAT [12], for additional 417 
guidance. The references provide solution validation points, as they list specific security capabilities that 418 
a solution addressing the Cybersecurity Framework subcategories would be expected to exhibit. 419 
Additionally, from NIST SP 800-181, National Initiative for Cybersecurity Education (NICE) Cybersecurity 420 
Workforce Framework [14], work roles are identified so that organizations may understand the work 421 
roles that are typically used by those implementing the capabilities contained in this practice guide. 422 

Note: Not all of the Cybersecurity Framework subcategory guidance can be implemented by using 423 
technology. Any organization executing a PAM solution would need to adopt processes and 424 
organizational policies that address organization risk management. Many of the subcategories require 425 
that processes and policies be developed prior to implementing the technical recommendations within 426 
this practice guide. 427 
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Table 3-1 PAM Reference Design Cybersecurity Framework Core Components Map 428 

Function Category Subcategory 

Informative References NIST SP 800-181 
NICE Framework 
Work Roles FFIEC CAT 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

IDENTIFY 
(ID) 

Asset Management (ID.AM): 
The data, personnel, devices, 
systems, and facilities that ena-
ble the organization to achieve 
business purposes are identified 
and managed consistent with 
their relative importance to 
business objectives and the or-
ganization’s risk strategy. 

ID.AM-3: Organizational 
communication and data 
flows are mapped. 

D4.C.Co.B.4 
D4.C.Co.Int.1 

A.13.2.1 AC-4, CA-9, 
PL-8 

PR-CDA-001 

 

ID.AM-6: Cybersecurity 
roles and responsibilities for 
the entire workforce and 
third-party stakeholders 
(e.g., suppliers, customers, 
partners) are established. 

D1.R.St.B.1 
D1.TC.Cu.B.1 

A.6.1.1 PM-11 OV-SPP-001 

 

Business Environment (ID.BE): 
The organization’s mission, ob-
jectives, stakeholders, and activ-
ities are understood and priori-
tized; this information is used to 
inform cybersecurity roles, re-
sponsibilities, and risk manage-
ment decisions. 

ID.BE-4: Dependencies and 
critical functions for deliv-
ery of critical services are 
established. 

D4.C.Co.B.1 
D1.G.IT.B.2 

Not ap-
plicable 
(N/A) 

PM-8, 
SA-14 

OV-MGT-001 

 

ID.BE-5: Resilience require-
ments to support delivery 
of critical services are estab-
lished. 

D5.IR.Pl.B.5 
D5.IR.Pl.E.3 

A.17.1.1, 
A.17.1.2, 
A.17.2.1 

CP-2, SA-14 OV-MGT-001 



DRAFT 

NIST SP 1800-18B: Privileged Account Management for the Financial Services Sector 13 

Function Category Subcategory 

Informative References NIST SP 800-181 
NICE Framework 
Work Roles FFIEC CAT 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

 
Governance (ID.GV): The poli-
cies, procedures, and processes 
to manage and monitor the or-
ganization’s regulatory, legal, 
risk, environmental, and opera-
tional requirements are under-
stood and inform the manage-
ment of cybersecurity risk. 

ID.GV-1: Organizational in-
formation security policy is 
established. 

D1.G.SP.B.4 A.5.1.1 -1 controls 
from all 
families 

OV-SPP-002 

 

ID.GV-2: Information secu-
rity roles & responsibilities 
are coordinated and aligned 
with internal roles and ex-
ternal partners. 

D1.G.SP.B.7 A.6.1.1, 
A.7.2.1 

PM-1, PS-7 OV-SPP-001 

 

ID.GV-4: Governance and 
risk management processes 
address cybersecurity risks. 

D1.G.SP.E.1 N/A PM-9, 
PM-11 

SP-RSK-002 

PROTECT 
(PR) 

Access Control (PR.AC): Access 
to assets and associated facili-
ties is limited to authorized us-
ers, processes, or devices, and 
to authorized activities and 
transactions. 

PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers. 

D3.PC.Im.B.7 
D3.PC.Am.B.6 

A.9.2.1, 
A.9.2.2, 
A.9.2.3, 
A.9.2.4, 
A.9.3.1, 
A.9.4.1, 
A.9.4.2, 
A.9.4.3 

AC-2, IA 
Family 

SP-DEV-001 
OV-PMA-003 
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Function Category Subcategory 

Informative References NIST SP 800-181 
NICE Framework 
Work Roles FFIEC CAT 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

 

PR.AC-4: Access permis-
sions are managed, incorpo-
rating the principles of least 
privilege and separation of 
duties. 

D3.PC.Am.B.1 
D3.PC.Am.B.2 
D3.PC.Am.B.5 

A.6.1.2, 
A.9.1.2, 
A.9.2.3, 
A.9.4.4 

AC-2, AC-3, 
AC-5, AC-6, 
AC-16 

OM-STS-001 

 

PR.AC-5: Network integrity 
is protected, incorporating 
network segregation where 
appropriate. 

D3.DC.Im.B.1 
D3.DC.Im.Int.1 

A.13.1.1, 
A.13.1.3, 
A.13.2.1 

AC-4, SC-7 OM-NET-001 

 
Data Security (PR.DS): Infor-
mation and records (data) are 
managed consistent with the or-
ganization’s risk strategy to pro-
tect the confidentiality, integ-
rity, and availability of infor-
mation. 

PR.DS-1: Data-at-rest is pro-
tected. 

D1.G.IT.B.13 
D3.PC.Am.A.1 

N/A SC-28 OM-DTA-002 

 

PR.DS-2: Data-in-transit is 
protected. 

D3.PC.Am.B.13 
D3.PC.Am.E.5 
D3.PC.Am.Int.7 

A.8.2.3, 
A.13.1.1, 
A.13.2.1, 
A.13.2.3, 
A.14.1.2, 
A.14.1.3 

SC-8 OM-DTA-002 
PR-CDA-001 
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Function Category Subcategory 

Informative References NIST SP 800-181 
NICE Framework 
Work Roles FFIEC CAT 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

 

PR.DS-5: Protections 
against data leaks are im-
plemented. 

D3.PC.Am.B.15 
D3.PC.Am.Int.1 
D3.PC.De.Int.1 
D3.DC.Ev.Int.1 

A.6.1.2, 
A.9.1.1, 
A.9.1.2, 
A.9.2.3, 
A.9.2.4, 
A.9.4.1, 
A.9.4.2, 
A.9.4.3, 
A.9.4.4, 
A.13.1.3, 
A.13.2.1, 
A.13.2.3 

AC-4, AC-5, 
AC-6, 
PE-19, 
PS-3, PS-6, 
SC-7, SC-8, 
SC-13, 
SC-31, SI-4 

SP-SYS-001 

 

Protective Technology (PR.PT): 
Technical security solutions are 
managed to ensure the security 
and resilience of systems and 
assets, consistent with related 
policies, procedures, and agree-
ments. 

PR.PT-1: Audit/log records 
are determined, docu-
mented, implemented, and 
reviewed in accordance 
with policy. 

D1.G.SP.B.3 
D2.MA.Ma.B.1 
D2.MA.Ma.B.2 

A.12.4.1, 
A.12.4.2, 
A.12.4.3, 
A.12.4.4, 
A.12.7.1 

AU Family OV-LGA-002 

 

PR.PT-3: Access to systems 
and assets is controlled, in-
corporating the principle of 
least functionality. 

D3.PC.Am.B.3 
D3.PC.Am.B.4 
D3.PC.Am.B.7 
D4.RM.Om.Int.1 

A.9.1.2 AC-3 OM-ANA-001 
PR-CDA-001 
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Function Category Subcategory 

Informative References NIST SP 800-181 
NICE Framework 
Work Roles FFIEC CAT 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

 
PR.PT-4: Communications 
and control networks are 
protected. 

D3.PC.Im.B.1 
D3.PC.Im.Int.1 

A.13.1.1, 
A.13.1.2, 
A.13.2.1 

AC-4, SC-7 SP-ARC-002 

DETECT (DE) Anomalies and Events (DE.AE): 
Anomalous activity is detected 
in a timely manner and the po-
tential impact of events is un-
derstood. 

DE.AE-1: A baseline of net-
work operations and ex-
pected data flows for users 
and systems is established 
and managed. 

D4.C.Co.B.4 N/A AC-4, CA-3, 
CM-2, SI-4 

SP-ARC-001 

 
DE.AE-2: Detected events 
are analyzed to understand 
attack targets and methods. 

D5.IR.Pl.Int.4 A.16.1.1, 
A.16.1.2, 
A.16.1.4, 
A.16.1.7 

AU family, 
CA-7, IR-4, 
SI-4 

PR-CDA-001 

 
DE.AE-3: Event data are ag-
gregated and correlated 
from multiple sources and 
sensors. 

D3.DC.Ev.E.1 A.16.1.1, 
A.16.1.2, 
A.16.1.4, 
A.16.1.7 

AU-6, CA-7, 
IR-4, IR-5, 
IR-8, SI-4 

PR-CIR-001 
CO-OPS-001 

 
DE.AE-5: Incident alert 
thresholds are established. 

D3.DC.An.E.4 
D3.DC.An.Int.3 
D5.DR.De.B.1 

A.16.1.1, 
A.16.1.2, 
A.16.1.4, 
A.16.1.7 

IR-4, IR-5, 
IR-8 

PR-CIR-001 
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Function Category Subcategory 

Informative References NIST SP 800-181 
NICE Framework 
Work Roles FFIEC CAT 

ISO/IEC 
27001: 
2013 

NIST SP 
800-53 
Rev. 4 

 

Security Continuous Monitor-
ing (DE.CM): The information 
system and assets are moni-
tored at discrete intervals to 
identify cybersecurity events 
and verify the effectiveness of 
protective measures. 

DE.CM-3: Personnel activity 
is monitored to detect po-
tential cybersecurity events. 

D3.DC.An.A.3 A.12.4.1, 
A.12.4.3 

AC-2, 
AU-12, 
AU-13, 
CA-7, 
CM-10, 
CM-11 

AN-TWA-001 

 

DE.CM-7: Monitoring for 
unauthorized personnel, 
connections, devices, and 
software is performed. 

D3.DC.Ev.B.3 A.12.4.1, 
A.14.2.7, 
A.15.2.1 

AU-12, 
CA-7, 
CM-3, SI-4 

AN-TWA-001 

RESPOND 
(RS) 

Communications (RS.CO): Re-
sponse activities are coordi-
nated with internal and external 
stakeholders, as appropriate, to 
include external support from 
law enforcement agencies. 

RS.CO-2: Events are re-
ported consistent with es-
tablished criteria. 

D5.ER.Es.B.4 
D5.DR.Re.B.4 
D5.IR.Pl.B.2 

A.16.1.2 AU family, 
IR-6 

IN-FOR-002 

Analysis (RS.AN): Analysis is 
conducted to ensure adequate 
response and support recovery 
activities. 

RS.AN-3: Forensics are per-
formed. 

D3.CC.Re.Int.3 
D3.CC.Re.Int.4 

A.16.1.7 AU-7 PR-CDA-001 

 429 
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3.5 Security Functions and Subcategories Related to FFIEC 430 

The example implementations are responsive to the desire to support compliance with the FFIEC CAT 431 
[12] guidance and with the NIST standards and best practices, as detailed in Table 3-1. 432 

One example implementation is informed by FFIEC CAT guidance and may contribute to CAT-aligned 433 
implementations by providing PAM capabilities efficiently and cost-effectively. With this solution in 434 
place, privileged users have access to the only resources that they are authorized to 435 
maintain/administer or operate. 436 

Table 3-2 describes how the PAM solution supports compliance with FFIEC CAT guidance. 437 

Table 3-2 FFIEC CAT Guidance 438 

FFIEC CAT Guidance PAM Solution Characteristics 

D4.C.Co.B.4: Data flow diagrams are in place and 
document information flows to external parties.  

The solutions utilize data flows to deter-
mine the implementation approach. 

D4.C.Co.Int.1: A validated asset inventory is used to 
create comprehensive diagrams depicting data re-
positories, data flow, infrastructure, and connectivity. 

Data flows within the PAM solutions are 
documented and enforced because of the 
asset value to the organization. 

D1.R.St.B.1: Information security roles and responsi-
bilities have been identified. 
D1.TC.Cu.B.1: Management holds employees ac-
countable for complying with the information secu-
rity program. 
D1.G.SP.B.4: The institution has board-approved poli-
cies commensurate with its risk and complexity that 
address information security. 
D1.G.SP.B.7: All elements of the information security 
program are coordinated enterprise-wide. 
D1.G.SP.E.1: The institution augmented its infor-
mation security strategy to incorporate cybersecurity 
and resilience. 
D5.IR.P1.E.1: The remediation plan and process out-
line the mitigating actions, resources, and time pa-
rameters. 

The PAM solutions provide policy enforce-
ment for privileged account access by us-
ing automation to ensure access policy 
compliance. 

D1.G.IT.B.2: Organizational assets (e.g., hardware, 
systems, data, and applications) are prioritized for 
protection based on the data classification and busi-
ness value. 

A PAM solution may be classified as a criti-
cal asset that needs to be protected. 
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FFIEC CAT Guidance PAM Solution Characteristics 

D5.IR.Pl.B.5: A formal backup and recovery plan ex-
ists for all critical business lines. 
D5.IR.Pl.E.3: Alternative processes have been estab-
lished to continue critical activity within a reasonable 
time. 

The solutions include emergency access 
and can be implemented with high-availa-
bility components. 

D3.PC.Im.B.7: Access to make changes to systems 
configurations (including virtual machines and hyper-
visors) is controlled and monitored. 
D3.PC.Am.B.6: Identification and authentication are 
required and managed for access to systems, applica-
tions, and hardware. 

The solutions provide automated account 
access control for privileged users and for 
MFA authentication. 

D3.PC.Am.B.1: Employee access is granted to sys-
tems and confidential data based on job responsibili-
ties and the principles of least privilege. 
D3.PC.Am.B.2: Employee access to systems and con-
fidential data provides for separation of duties. 
D3.PC.Am.B.5: Changes to physical and logical user 
access, including those that result from voluntary and 
involuntary terminations, are submitted to and ap-
proved by appropriate personnel. 

The solutions provide automated policy en-
forcement for account access control for 
privileged users. 

D3.DC.Im.B.1: Network perimeter defense tools 
(e.g., border router and firewall) are used. 
D3.DC.Im.Int.1: The enterprise network is segmented 
in multiple, separate trust/security zones with de-
fense-in-depth strategies (e.g., logical network seg-
mentation, hard backups, air-gapping) to mitigate at-
tacks. 

The solutions are implemented by using 
network defense tools and network seg-
mentation to illustrate support for this 
guidance. 

D1.G.IT.B.13: Confidential data is identified on the in-
stitution’s network. 
D3.PC.Am.A.1: Encryption of select data at rest is de-
termined by the institution’s data classification and 
risk assessment. 

The solutions protect confidential data by 
using encryption of data-at-rest (PAM 
passwords) and can support this guidance. 

D3.PC.Am.B.13: Confidential data is encrypted when 
transmitted across public or untrusted networks 
(e.g., internet). 
D3.PC.Am.E.5: Controls are in place to prevent unau-
thorized access to cryptographic keys. 

The solutions include encryption capabili-
ties and can be implemented to support 
this guidance. 
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FFIEC CAT Guidance PAM Solution Characteristics 

D3.PC.Am.Int.7: Confidential data is encrypted in 
transit across private connections (e.g., frame relay 
and T1) and within the institution’s trusted zones. 

D3.DC.Ev.Int.1: Controls or tools (e.g., data loss pre-
vention) are in place to detect potential unauthorized 
or unintentional transmissions of confidential data. 
D3.PC.Am.B.15: Remote access to critical systems by 
employees, contractors, and third parties uses en-
crypted connections and multifactor authentication. 
D3.PC.Am.Int.1: The institution has implemented 
tools to prevent unauthorized access to or exfiltra-
tion of confidential data. 
D3.PC.De.Int.1: Data-loss prevention controls or de-
vices are implemented for inbound and outbound 
communications (e.g., email, file transfer protocol, 
Telnet, prevention of large file transfers). 

The solutions provide automated account 
access control, including MFA for privi-
leged users. Account access to confidential 
data is controlled to support this guidance. 

D1.G.SP.B.3: The institution has policies commensu-
rate with its risk and complexity that address the con-
cept of threat information sharing. 
D2.MA.Ma.B.1: Audit log records and other security 
event logs are reviewed and retained in a secure 
manner. 
D2.MA.Ma.B.2: Computer event logs are used for in-
vestigations once an event has occurred. 

The solutions provide automated log col-
lection and analysis to support this guid-
ance. 

D3.PC.Am.B.3: Elevated privileges (e.g., administra-
tor privileges) are limited and tightly controlled 
(e.g., assigned to individuals, not shared, and require 
stronger password controls). 
D3.PC.Am.B.4: User access reviews are performed 
periodically for all systems and applications based on 
the risk to the application or system. 
D3.PC.Am.B.7: Access controls include password 
complexity and limits to password attempts and re-
use. 
D4.RM.Om.Int.1: Third-party employee access to the 
institution’s confidential data is tracked actively 
based on the principles of least privilege. 

The solutions provide automated account 
access control and access reporting/log-
ging for privileged users. The solutions in-
clude policies that can be audited and re-
ported. 
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FFIEC CAT Guidance PAM Solution Characteristics 

D5.IR.P1.Int.4: Lessons learned from real-life cyber 
risk incidents and attacks on the institution and other 
organizations are used to improve the institution’s 
risk mitigation capabilities and response plan. 

The solutions implemented are reconfigu-
rable to support this guidance. 

D3.DC.Ev.E.1: A process is in place to correlate event 
information from multiple sources (e.g., network, ap-
plication, or firewall). 

The solutions are designed by using auto-
mated log collection and analysis to sup-
port this guidance. 

D3.DC.An.E.4: Thresholds have been established to 
determine activity within logs that would warrant 
management response. 
D3.DC.An.Int.3: Tools actively monitor security logs 
for anomalous behavior and alert within established 
parameters. 
D5.DR.De.B.1: Alert parameters are set for detecting 
information security incidents that prompt mitigating 
actions. 

The solutions are designed by using auto-
mated log collection and analysis to sup-
port this guidance. 

D3.DC.Ev.B.3: Processes are in place to monitor for 
the presence of unauthorized users, devices, connec-
tions, and software. 

The solutions are configured to block and 
log all unauthorized PAM system-use at-
tempts, as well as to automatically dis-
cover new accounts/users, to support this 
guidance. 

D5.ER.Re.B.4: Incidents are classified, logged, and 
tracked. 
D5.ER.Es.B.4: Incidents are detected in real time 
through automated processes that include instant 
alerts to appropriate personnel who can respond. 
D5.IR.Pl.B.2: Communication channels exist to pro-
vide employees a means for reporting information 
security events in a timely manner. 

The solutions are designed by using auto-
mated log collection and analysis to sup-
port this guidance. 

D3.CC.Re.Int.3: Security investigations, forensic anal-
ysis, and remediation are performed by qualified 
staff or third parties. 
D3.CC.Re.Int.4: Generally accepted and appropriate 
forensic procedures, including chain of custody, are 
used to gather and present evidence to support po-
tential legal action. 

The solutions can be implemented to sup-
port this guidance. 
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3.6 Technologies 439 

Table 3-3 lists all of the technologies used in this project and provides a mapping between the generic 440 
application term, the specific product used, and the security control(s) that the product provides. Refer 441 
to Table 3-1 for an explanation of the Cybersecurity Framework subcategory codes. Table 3-3 describes 442 
only the product capabilities that were used in our example solutions. Many of the products have 443 
additional security capabilities that were not used. 444 

Table 3-3 Products and Technologies 445 

Component ID Specific 
Product Function 

Cybersecurity 
Framework 
Subcategories 

1. Identity 
Store 
Lightweight 
Directory 
Access 
Protocol 
(LDAP)  

Radiant Logic 
RadiantOne 
Federated 
Identity (FID) 

1. An identity repository specifically re-
served for the privileged users of the 
organization 

2. Account change monitoring and re-
porting 

ID.AM-6, ID.GV-1, 
ID.GV-2, PR.AC-1, 
PR.AC-4  

2. MFA RSA SecureID 
Access 
 
IdRamp Secure 
Access 
combined with 
Microsoft 
Authenticator 
and Azure 
Active Directory 
services 
 
OneSpan 
DIGIPASS 
(formerly 
VASCO) 
 
Remediant 
SecureOne 

3. Add-on MFA capabilities for PAM 
system user login authentication 

4. Logs of each authentication attempt 

PR.AC-1 
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Component ID Specific 
Product Function 

Cybersecurity 
Framework 
Subcategories 

3. User 
Interface  

Bomgar 
(formerly 
Lieberman 
Software) Red 
Identity Suite 
 
Remediant 
SecureONE 
 
TDi 
Technologies 
ConsoleWorks 

5. Login authentication and a user-to-
PAM-system interactive interface 
through which users interact to es-
tablish work sessions for each system 
that they administer or access to per-
form their work functions 

N/A 

4. Policy 
Management  

Bomgar 
(formerly 
Lieberman 
Software) Red 
Identity Suite 
 
Remediant 
SecureONE 
 
TDi 
Technologies 
ConsoleWorks 

6. The enterprise privileged-user access 
and control policies, such as privi-
leged user sessions, are limited to 
four hours. 

ID.AM-6, ID.GV-1, 
ID.GV-2, ID.GV-4, 
PR.AC-1, PR.AC-4  

5. Password 
Management  

Bomgar 
(formerly 
Lieberman 
Software) Red 
Identity Suite 

7. Management and enforcement of 
the enterprise password policies 

ID.GV-4, PR.AC-1 
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Component ID Specific 
Product Function 

Cybersecurity 
Framework 
Subcategories 

6. Session ID 
Management  

Bomgar 
(formerly 
Lieberman 
Software) Red 
Identity Suite 
 
TDi 
Technologies 
ConsoleWorks 

8. The session start and stop functional-
ity 

9. Enforces the enterprise access and 
control policies within each work ses-
sion, such as limiting sessions to Se-
cure Shell (SSH) or Remote Desktop 
Protocol (RDP) or limiting allowed 
application use on the target system 

PR.AC-1, PR.DS-2, 
PR.PT-3, PR.PT-4 

7. Password 
Vault 

Bomgar 
(formerly 
Lieberman 
Software) Red 
Identity Suite 
 
TDi 
Technologies 
ConsoleWorks 

10. Provides secure storage of the cur-
rent password for each privileged ac-
count managed by the PAM system 

PR.DS-1 

8. Emergency 
Access  

Bomgar 
(formerly 
Lieberman 
Software) Red 
Identity Suite 
 
Remediant 
SecureONE 
 
TDi 
Technologies 
ConsoleWorks 

11. PAM use in unpredicted or emer-
gency situations when access to priv-
ileged accounts is required by unan-
ticipated users (privileged or 
nonprivileged) 

ID.BE-5, ID.GV-1, 
ID.GV-2, ID.GV-4, 
PR.AC-1, PR.AC-4 
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Component ID Specific 
Product Function 

Cybersecurity 
Framework 
Subcategories 

9. Automated 
Account 
Discovery  

Bomgar 
(formerly 
Lieberman 
Software) Red 
Identity Suite 
 
Remediant 
SecureONE 

12. Automated search of the enterprise 
for evidence and identification of 
privileged accounts, such as domain 
administrators or accounts that di-
rectly or indirectly (through inher-
itance of privileges) have privileged-
account-level authority 

ID.GV-4, PR.AC-1, 
PR.AC-4, DE.CM-7 

10. Session 
Monitoring 

Ekran System 
Client 
 
TDi 
Technologies 
ConsoleWorks 

13. A mechanism to identify, log, and 
alert on anomalous privileged-ac-
count activity 

DE.CM-3 

11. Session 
Replay  

Ekran System 
Client 
 
TDi 
Technologies 
ConsoleWorks 

14. Session review for training and event 
review and investigations 

RS.AN-3 

12. Security 
Monitoring 

Splunk 
Enterprise 
 
Radiant Logic 
RadiantOne FID 

15. Logging and auditing provide log 
storage, analysis, and alerting com-
ponents 

DE.AE-2, DE.AE-3, 
DE.AE-5, DE.CM-3, 
DE.CM-7, PR.PT-1, 
RS.CO-2 

13. Lab 
Environment 

Miscellaneous 16. Virtual machines, networking, rout-
ing, firewalls, etc. 

PR.AC-5, PR.DS-5 

4 Architecture 446 

PAM is a domain within identity and access management (IdAM) that focuses on monitoring and 447 
controlling the access rights assigned to privileged users for their privileged accounts. Privileged 448 
accounts include local, domain, and system administrative accounts, and application, application 449 
management, and service accounts. These accounts can also be used to gain access and conduct 450 



DRAFT 

NIST SP 1800-18B: Privileged Account Management for the Financial Services Sector 26 

transactions that use business-critical/high-value applications, such as payroll, social media, cloud 451 
services, and human resources.  452 

The PAM architecture and reference design identify the set of capabilities and their relationships that, 453 
when combined, can be used to control and monitor the use of privileged accounts by privileged users, 454 
for both on-premises and cloud implementations. This section presents a high-level architecture and 455 
reference design for implementing such a solution. The reference design includes a broad set of 456 
capabilities available in the marketplace, to illustrate the full breadth of PAM capabilities that an 457 
organization may implement. The NCCoE understands that an organization may not need all of these 458 
capabilities. An organization may choose to implement a subset of the depicted capabilities, depending 459 
on its risk management decisions. 460 

4.1 Architecture Description 461 

4.1.1 High-Level Architecture 462 

The PAM solution is designed to address the security functions and subcategories described in Table 3-1 463 
and is composed of the capabilities illustrated in Figure 4-1 and Figure 4-2. 464 

Figure 4-1 High-Level Architecture 465 

 466 

Figure 4-1 depicts the PAM architecture within the context of an enterprise. A PAM system is designed 467 
to mediate/control access to, and the use of, privileged accounts between enterprise systems and 468 
services and authorized “privileged” users. In Figure 4-1, “(X)aaS” stands for “[fill in the blank] as a 469 
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service,” such as software as a service (SaaS), platform as a service (PaaS), and infrastructure as a service 470 
(IaaS) cloud services. Examples of each of these cloud services are as follows: 471 

 SaaS: email, customer relationship management software 472 

 PaaS: application development, streaming services 473 

 IaaS: caching, storage, networking 474 

4.1.2 Reference Design 475 

The reference design shown in Figure 4-2 depicts the detailed PAM design, including the relationships 476 
among the capabilities that compose the design. 477 

Figure 4-2 PAM Reference Design 478 

 479 

The solid lines in Figure 4-2 represent the user data flow between privileged users and systems within 480 
the enterprise. The dashed lines represent the management data flow among PAM architecture 481 
components. The dotted lines represent the security monitoring data flow (logs). The PAM 482 
capabilities/components are briefly described below: 483 

1. The identity store (LDAP) provides an identity repository specifically reserved for the privileged 484 
users of the organization. 485 

2. MFA enables two or three authentication factors to improve the authentication level for 486 
privileged users (see NIST 800-63B [13] for a more detailed description of authentication factor 487 
requirements). 488 
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3. The user interface provides login authentication and a user-to-PAM-system interactive interface 489 
through which users interact to establish or request work sessions for each system that they 490 
administer or access to perform their work functions. 491 

4. Policy management maintains the enterprise privileged-user access and control policies, such as 492 
limiting privileged user sessions to four hours. 493 

5. Password management maintains and enforces the enterprise password policies. 494 

6. Session management enforces the enterprise access and control policies within each work 495 
session, such as limiting sessions to SSH or RDP or limiting allowed application use on the target 496 
system. 497 

7. The password vault provides secure storage of the current password for each privileged account 498 
managed by the PAM system. 499 

8. Emergency access provides PAM use in unpredicted or emergency situations when access to 500 
privileged accounts is required by unanticipated users (privileged or nonprivileged). 501 

9. Automated account discovery searches the enterprise for evidence and identification of 502 
privileged accounts, such as domain administrators or accounts that directly or indirectly 503 
(through inheritance of privileges) have privileged-account-level authority. 504 

10. Session monitoring provides a mechanism to identify, log, and alert on anomalous activity as 505 
well as for real-time training for privileged account use. 506 

11. Session replay provides session review for training and event review and investigations. 507 

12. Security monitoring, logging, and auditing provides log storage, analysis, and alerting 508 
components, generally referred to as security information and event management (SIEM). 509 

13. UBA monitors the activity of the privileged users for activity or actions that are considered to be 510 
unexpected or outside a recognized pattern of activity.  511 

14. High availability/replication ensures the availability of the PAM solution. 512 

PAM systems typically use one of two techniques for controlling account access and use: account 513 
escalation or account sharing. The account escalation technique escalates the privileged/authorized 514 
activity for each user’s personal account for the duration of the session with the target system, based on 515 
the organizational policies. When each session is completed, the user’s account is returned to its 516 
“normal”/nonprivileged authorization level. The account sharing technique utilizes a set of privileged 517 
accounts that are shared among the authorized privileged users. The passwords for these accounts are 518 
typically changed automatically, based on usage or time. For example, account-sharing PAM systems 519 
may be set up to change the password for each account after every session in which it is used, or, if 520 
unused, after a specific amount of time. Some organizations may choose to utilize an account-sharing 521 
PAM system with unique user-specific PAM accounts. This approach may provide simplified log analysis 522 
for forensic and training purposes, as the target system will record each unique user in its logs. 523 
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The components listed above work together to provide the PAM functionality. The user interface utilizes 524 
the identity store and MFA to authenticate privileged users and is the interface through which users 525 
interact with the PAM system. PAM users may be human or systems, such as applications. In PAM 526 
systems that implement privileged account sharing, session management establishes a session for each 527 
user to the system that they choose, based on the policies within the policy management system. 528 
Session management also utilizes the password vault to obtain passwords for the target systems. Each 529 
session is established via the monitoring and session replay systems, according to enterprise policies for 530 
session monitoring and recording. The target system and PAM system log the activity of each privileged 531 
user and send logs to the SIEM for analysis and alerting for anomalous events and conditions. 532 

In PAM systems that implement account escalation techniques to manage privileged users, the session 533 
management system escalates the privilege of each user for the duration of the session with the target 534 
system, based on the policies within the policy management system. Session management monitors the 535 
session to return the account privilege level to its normal state after the user ends the session. Session 536 
management also logs the user account requests and the session request details according to enterprise 537 
policies. The target systems log the activity of each privileged user and send logs to the SIEM. NIST SP 538 
800-92, Guide to Computer Security Log Management [9], was utilized for SIEM implementation and 539 
configuration guidance. The SIEM stores logs generated by each system and performs analytics to 540 
identify anomalous activity. Anomalous activity is reported to security analysts.  541 

Automated account discovery provides the enterprise with continuous monitoring for accounts that may 542 
be considered privileged, and with changes to those accounts. Based on enterprise policies, the PAM 543 
administrators may include these newly identified privileged accounts in the PAM system. Automated 544 
account discovery can also be used to alert security analysts when account changes occur among the 545 
privileged accounts or if a nonprivileged account escalation attempt occurs. The high-546 
availability/replication components are identified in the architecture to highlight the need to ensure 547 
high availability of a PAM system. An enterprise may find that a subset of the components is sufficient to 548 
address its risk mitigation needs. 549 

UBA and high-availability/replication components were not included in the example solutions 550 
implemented in the NCCoE lab. The high-availability/replication component was not included due to the 551 
limited implementation scope of the NCCoE lab representative enterprise instance. 552 

UBA solutions are designed to detect behaviors of concern by combining all relevant data (e.g., network 553 
and client/host-based activity, human resource systems, employee reports, public records, travel 554 
records), and to then look for meaningful patterns of behavior. For example, a UBA solution can detect 555 
that an attack, such as a privilege escalation attack, has been launched (ideally during the early 556 
formative stages of that attack). UBA was not included in the example implementations due to the lack 557 
of relevant data needed for effective pattern-of-behavior analysis. Because UBA techniques vary widely, 558 
UBA for PAM may be considered by organizations that can identify the specific dimensions of behavior 559 
and analysis important in their environment and risk management decisions. 560 
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5 Example Implementations 561 

Multiple PAM implementations are included in this guide to illustrate the varied PAM techniques 562 
available and the various use cases where PAM provides value. Each example implementation illustrates 563 
a different PAM technique or implementation approach. An organization may consider implementing 564 
the PAM technique that best addresses its security needs. The implementations include PAM for IT 565 
infrastructure, business-critical/high-value applications, cloud services, privileged user workstations, and 566 
SIEM. The example implementations are constructed on the NCCoE lab’s infrastructure and consist of 567 
several products to compose each implementation.  568 

The lab infrastructure consists of a VMware vSphere virtualization operating environment. We used 569 
network-attached storage and virtual switches, as well as internet access, to interconnect the solution 570 
components. Both commercially available and open-source technologies are included in the lab 571 
infrastructure. The lab network is not connected to the NIST enterprise network.  572 

Table 5-1 lists (alphabetically) the specific components/capabilities that the NCCoE utilized in the 573 
example implementations to create the desired functionality of PAM. Each component’s functions are 574 
identified by the Component ID number from Table 3-3 in Section 3.6. For example, in Table 5-1, the 575 
Component ID 6 indicates Session Management. Note that many of the products offer capabilities other 576 
than those used in the NCCoE example implementations. The example implementations focus on the 577 
capabilities, rather than the products. The NCCoE is not recommending, assessing, or certifying the 578 
products included in the example implementations. 579 

Table 5-1 Example Implementation Component List 580 

Product Vendor Component (product) Name Component ID 
Bomgar (formerly Lieberman 
Software) 

Red Identity Suite 3, 4, 5, 6, 7, 8 

Ekran System System Client 9, 10 
IdRamp Secure Access 2 
Radiant Logic RadiantOne FID 1, 11 
Remediant SecureONE 3, 4, 8 
RSA SecureID Access 2 
Splunk Splunk Enterprise 11 
TDi Technologies ConsoleWorks 3, 4, 6, 7, 9, 10 
OneSpan (formerly VASCO) DIGIPASS 2 

 
The example implementations described in the following sections are built around typical enterprise 581 
infrastructure components: SAMBA file server, Apache web server, Microsoft Structured Query 582 
Language (SQL) server, and a Microsoft Active Directory server that also runs Microsoft Domain Name 583 
System service, as well as an array of client machines, primarily running Windows 10 and Ubuntu 16.04. 584 
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Open-source router and firewall technologies were used as well. The implementation also included the 585 
Microsoft Azure Active Directory cloud service. The details of the implementations are included in 586 
Volume C of this practice guide. 587 

The NCCoE built three example solutions in its lab. We built these examples to illustrate our modular 588 
approach and the wide variety of PAM techniques and approaches to the organizational management of 589 
privileged accounts. Organizations may identify techniques and or approaches for implementation (in 590 
part or in whole), based on their risk management decisions, regulatory/compliance requirements, and 591 
other resource constraints. The example solutions are described in the following subsections. Each 592 
subsection includes a diagram depicting the example solution implementation and the data flows. In the 593 
example implementations, management networks were implemented to highlight the need to segment 594 
networks for management, and event-log and production traffic as a best practice. Organizations may 595 
choose to segment traffic, based on their risk management decisions. The management network is 596 
described in Volume C.  597 

5.1 Example Implementation 1: Application Layer PAM 598 

Example Implementation 1 was designed and implemented to illustrate PAM for the application-layer 599 
(including high-value applications) privileged accounts. These accounts are used by accounts payable 600 
administrators and specialists, social media administrators, writers/editors, human resources 601 
administrators, personnel managers, etc. These types of users are authorized to administer or use 602 
applications (including high-value applications) that can have significant (positive or negative) impacts 603 
on an organization. In this example, privileged user workstations have additional monitoring to illustrate 604 
local-workstation PAM capabilities. Where possible, all data-at-rest and data-in-transit are encrypted. 605 

In Example Implementation 1 (Figure 5-1 and Figure 5-2), the NCCoE utilized these products to monitor 606 
and control privileged user access: 607 

 Bomgar (formerly Lieberman) Privileged Identity and Application Launcher provides PAM 608 
capabilities. 609 

 The Ekran agent provides PAM monitoring capabilities for the privileged user workstations. 610 

 RSA Authentication Manager provides onetime-passcode synchronization and authentication 611 
(Option 1, Figure 5-1). 612 

 IdRamp Secure Access, combined with Microsoft Authenticator and Azure Active Directory 613 
services, provides onetime-passcode synchronization and authentication (Option 2, Figure 5-2). 614 

 Microsoft Active Directory provides the enterprise privileged-user identity store (source for 615 
privileged user identity information). 616 

 Splunk Enterprise provides the security monitoring, logging, and auditing component (SIEM) 617 
(see Section 5.5 for a description of the security monitoring component). 618 
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Figure 5-1 Example Implementation 1: Application Layer PAM Architecture (Option 1) 619 

 620 

In this example implementation, the Ekran Agent monitors the privileged user activity on their 621 
workstation. A best practice is that privileged users perform their work from dedicated workstations. 622 
That workstation should not be used for nonprivileged user activities like email, web browsing, and 623 
other organizational activities. The Bomgar Privileged Identity server provides the privileged-user-access 624 
control interface. The user is authenticated based on their user account information within the 625 
privileged user identity store that is implemented by using Microsoft Active Directory. Once the 626 
privileged user authenticates with their username, password, and second authentication factor (a 627 
onetime passcode via a phone application), the user is forwarded to the application launcher. Multiple 628 
onetime-passcode products are utilized to highlight seamless modular implementation approaches to 629 
implementing onetime passcodes for use in PAM implementations. Both RSA and IdRamp utilize a 630 
onetime-passcode mobile application to provide the onetime-passcode second authentication factor.  631 

In this example implementation, the NCCoE chose to integrate IdRamp with the Microsoft Authenticator 632 
service to provide the onetime passcode. Both RSA Authentication Manager and the Microsoft 633 
Authenticator service provide synchronization and authentication of the onetime passcode. The 634 
application launcher gives the user a proxied access to the target system application. This PAM 635 
implementation has used the account sharing PAM technique described in Section 4. The privileged 636 
account required to access this application is used by the application launcher. The username is stored 637 
in the application launcher, and the current password is pulled from a password vault. In this 638 
implementation, we chose to have the password change after each application session is closed. The 639 
session information is optionally monitored and recorded by the application launcher server for one or 640 
more of the following purposes: security, forensics, and training. Logs of the session details are reported 641 
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to a security monitoring system for the detection of anomalous activity. The following list describes the 642 
authentication and access-control steps referenced in Figure 5-1: 643 

1. The user connects to the Bomgar Privileged Identity web interface from their workstation and 644 
enters their username, password, and RSA token from the SecureID Access (Option 1) or 645 
Microsoft Authenticator (Option 2) application on their phone. 646 

2. Bomgar authenticates the user by querying Active Directory to check the username and 647 
password. Active Directory returns an authentication response. 648 

3. Bomgar sends the RSA token to the RSA Authentication Manager by using RADIUS (Option 1), or 649 
the Microsoft token to the Azure Active Directory services using Security Assertion Markup 650 
Language (SAML) via the IdRamp product (Option 2). 651 

4. RSA Authentication Manager (Option 1) or Azure Active Directory services (Option 2) via the 652 
IdRamp product verifies the token and returns the allow/deny response to Bomgar. 653 

5. Bomgar gives the user access to the full web interface, which allows the user to access the 654 
application launcher server. 655 

6. The application launcher provides access to the target system either directly or via a remote 656 
desktop application. 657 

Figure 5-2 Example Implementation 1: Application Layer PAM Architecture (Option 2) 658 

 659 
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5.2 Example Implementation 2: Organization Infrastructure PAM 660 

Example Implementation 2 was designed and implemented to illustrate PAM for the infrastructure of an 661 
organization (e.g., networking devices, servers, workstations, databases, applications). Typical 662 
infrastructure users are configuring network devices, updating server operating systems (OSs) and 663 
application software, among other tasks. These users are the typical system administrators. In this 664 
example, privileged user workstations have additional monitoring to illustrate local-workstation PAM 665 
capabilities. Where possible, all data-at-rest and data-in-transit are encrypted. 666 

In Example Implementation 2 (Figure 5-3), the NCCoE utilized the following products to monitor and 667 
control privileged user access: 668 

 Remediant SecureONE provides PAM for the organization infrastructure and utilizes Google 669 
Authenticator for the MFA second factor for authentication. 670 

 Ekran Agent provides the session monitoring/replay for the privileged user workstations. 671 

 Microsoft Active Directory provides the enterprise privileged-user identity store (source for 672 
privileged user identity information). 673 

 Splunk Enterprise provides the security monitoring, logging, and auditing component (SIEM).  674 

Figure 5-3 Example Implementation 2: Organization Infrastructure PAM Architecture 675 

 676 

In this example implementation, the Ekran Agent monitors the privileged user’s activity on their 677 
workstation. A best practice is that privileged users perform their work from dedicated workstations. 678 
Those workstations should not be used for nonprivileged user activities like email, web browsing, and 679 
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other organizational activities. The Remediant SecureONE server provides the privileged-user-access 680 
control interface. The user is authenticated based on their user account information, which is 681 
authenticated by the user identity store implemented by using Microsoft Active Directory. In this 682 
example implementation, Google Authenticator is used to provide the second authentication factor via 683 
mobile Google Authenticator application. SecureONE includes a Google Authenticator server 684 
application, but can also be configured to utilize other existing MFA solutions. Once the privileged user 685 
authenticates with their username, password, and second authentication factor (a onetime passcode via 686 
Google Authenticator), SecureONE completes a temporary (policy-based time limit) user account 687 
escalation on the target system to enable that user to perform user activities. Once SecureONE 688 
completes the privilege escalation, the user is instructed to connect directly to the target system. When 689 
the user completes their activities on the target system, they disconnect or close the session. After the 690 
policy-based time limit expires, or if manually requested by the user, SecureONE de-escalates the user 691 
account privilege on the target system. 692 

This PAM implementation uses the account escalation PAM technique described in Section 4. In this 693 
technique, the target system user account is temporarily escalated to a privileged user status for a 694 
policy-based time limit. The target system must be configured to log all of the activity needed to 695 
monitor the user activity for normal, privileged, and anomalous activity. The session information is 696 
optionally monitored and recorded by the SIEM and the SecureONE server for one or more of the 697 
following purposes: security monitoring, forensics, and training. Logs from the target system and 698 
SecureONE server are reported to a security monitoring system for detecting anomalous activity. The 699 
following list describes the authentication and access-control steps referenced in Figure 5-2: 700 

1. The user connects to the Remediant SecureONE web interface by using their username, 701 
password, and Google Authenticator onetime passcode. 702 

2. Remediant authenticates the user by querying Active Directory to check the username and 703 
password. 704 

3. Active Directory returns an authentication response. 705 

4. If the user is authenticated, then Remediant SecureONE validates the onetime passcode. 706 

5. Remediant SecureONE confirms that the user is authorized to escalate privileges on the target 707 
system. 708 

6. If the user is authorized, then Remediant SecureONE escalates the user’s privileges on the user-709 
requested target system for a policy-based time-limited duration. 710 

7. The user directly logs into the requested target by using their username and password. 711 

8. The access is automatically de-escalated after the prespecified period of time, or as manually 712 
commanded by the user. 713 
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5.3 Example Implementation 3: SIEM 714 

Example Implementation 3 was designed and implemented to illustrate PAM for the SIEM of an 715 
organization. The SIEM platform is a critical component of any cybersecurity architecture. The SIEM, 716 
provided by Splunk, typically operates and is accessed via the management network within an 717 
enterprise. The privileged accounts that are used to access the SIEM are used by the privileged users 718 
who perform their work functions on the SIEM. Those functions include administering and operating the 719 
SIEM as well as security operations activities. In Example Implementation 3, privileged user workstations 720 
have additional monitors to illustrate additional PAM capabilities. Where possible, all data-at-rest and 721 
data-in-transit are encrypted. 722 

In Example Implementation 3 (Figure 5-4), the NCCoE utilized the following products to monitor and 723 
control privileged user access: 724 

 TDi Consoleworks provides PAM for the security monitoring system.  725 

 Ekran System provides PAM for the privileged user workstations. 726 

 OneSpan (formerly VASCO) Authentication Server provides an interface between the PAM 727 
components and the MFA second factor for authentication (via mobile application). 728 

 Radiant Logic RadiantOne FID provides the privileged user identity store. 729 

 Microsoft Active Directory provides the enterprise standard-user identity store (source for 730 
privileged user identity information). 731 

 Splunk Enterprise provides the security monitoring, logging, and auditing component.  732 
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Figure 5-4 Example Implementation 3: SIEM Architecture 733 

 734 

In this example implementation, the Ekran Agent monitors the privileged user’s activity on their 735 
workstation. A best practice is that privileged users perform their work from dedicated workstations. 736 
Those workstations should not be used for nonprivileged user activities like email, web browsing, and 737 
other organizational activities.  738 

The TDi Technologies ConsoleWorks server provides the privileged-user-access control interface. The 739 
user is authenticated based on their user account information, which is authenticated via the 740 
RadiantOne FID privileged-user identity store. RadiantOne FID forwards the authentication request to 741 
the Microsoft Active Directory for an authentication response. Once the privileged user authenticates 742 
with their username, password, and second authentication factor (a onetime passcode via a phone 743 
application), the user is presented with only their authorized set of target systems. The OneSpan server 744 
provides the second-authentication-factor synchronization and authentication. DIGIPASS is the mobile 745 
device application providing the user with the second-factor onetime passcode. ConsoleWorks provides 746 
the user with proxied access to the target system application.  747 

This PAM implementation uses the account sharing PAM technique described in Section 4. In this 748 
example implementation, the privileged accounts required to access the SIEM and Ekran management 749 
applications are reused by ConsoleWorks. The username and current password are securely stored in 750 
ConsoleWorks. In this implementation, we chose not to have the password change after each session. 751 
The session information is optionally monitored and recorded by ConsoleWorks for one or more of the 752 
following purposes: security, forensics, and training. Logs of the session details are reported to a security 753 
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monitoring system for detecting anomalous activity. The following list describes the authentication and 754 
access-control steps referenced in Figure 5-3: 755 

1. The user connects to the ConsoleWorks web interface by using their username, password, and 756 
OneSpan Authentication Server and DIGIPASS onetime-passcode mobile application. 757 

2. ConsoleWorks authenticates the user by querying the OneSpan server to check the username, 758 
password, and onetime passcode. 759 

3. OneSpan passes the username and password authentication query to RadiantOne FID. 760 

4. RadiantOne FID passes the authentication query to Active Directory, which returns an 761 
authentication response. 762 

5. RadiantOne FID passes the response from Active Directory to OneSpan. 763 

6. OneSpan passes an allow/deny response to ConsoleWorks, based on the response from 764 
RadiantOne FID and the onetime-passcode validation. 765 

7. If authenticated, the user is presented with their authorized target system choices by 766 
ConsoleWorks (the choices are based on pre-established policies). 767 

8. After choosing the target system, ConsoleWorks creates a proxied connection to the target 768 
system. 769 

5.4 Security Monitoring Implementation 770 

Security monitoring is an important aspect of any cybersecurity implementation. The NCCoE based the 771 
security monitoring implementation on the guidance found in the Architecture section of NIST SP 800-772 
92, Guide to Computer Security Log Management [9]. The NCCoE implemented the network 773 
segmentation recommendation from NIST SP 800-92 in the solutions described above for 774 
management/PAM network use by PAM systems for access to the target systems, excluding the 775 
application PAM use. The same management/PAM network would also be used to collect logs from each 776 
of the target systems and PAM systems. Figure 5-5 illustrates the data flow across the 777 
management/PAM network. Where possible, all data-at-rest and data-in-transit are encrypted. 778 
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Figure 5-5 Security Monitoring Implementation Architecture 779 

 780 

5.5 Use Cases 781 

5.5.1 Typical Administrator (Directory, Cloud Service, Etc.) 782 

From time to time, directories, cloud services, and other systems need to be updated or reconfigured. 783 
For example, a new application account may need to be added to support a new or modified 784 
application. 785 

5.5.1.1 Scenario 786 

A new application (on-premises or in the cloud) is developed that requires a new system account to gain 787 
access to an existing database. A directory administrator is assigned to add the account. In this scenario, 788 
the administrator may log into the directory by using a shared privileged account. The password may be 789 
shared among other accounts or administrators. This change may be reported to a SIEM for monitoring 790 
purposes. The report should consist of all of the information necessary to identify the administrator, the 791 
time that the change occurred, the account used to make the change, and a description of the change.  792 
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In this scenario, without PAM, there is no evidence of who made the change, as shared 793 
accounts/passwords are used, and there is no evidence of what actions were taken to create the 794 
change. If a mistake was made, then the investigator (probably an administration manager) would have 795 
to sift through logs and interview the various administrators to understand who made the change and 796 
how it was done. Shared accounts/passwords limit the data available to determine who made a change. 797 
If an inadvertent or purposeful incorrect change occurs, then the change may be difficult to remediate 798 
because a full description of the user’s actions may be difficult to determine.  799 

5.5.1.2 Resolution 800 

The use of a PAM system enables the manager to conclude an investigation without relying on the 801 
administrator’s memories of the event or sifting through logs. MFA ensures that each PAM user is 802 
authorized through strong authentication techniques. Password management ensures that a unique 803 
password is used for each system accessed. Password management provides the password to log into 804 
each system for each new session and can automatically change the password after each session or 805 
other configured aspect. Policy management dictates which systems a user is authorized to access. 806 
Session management controls access to the systems that users are authorized to access. Session 807 
management logs the user activities in each session and can optionally record each session to allow the 808 
manager to review the method or set of commands used to make the change. In addition, session 809 
monitoring provides logs of the event to the security monitoring system or SIEM for correlation with 810 
other enterprise events. If the SIEM is configured to alert on specific PAM events or combinations of 811 
events, then the manager can be proactively notified to review the specific type of changes that are 812 
concerning. In that way, a manager can react as needed versus using their time for monitoring. 813 

5.5.1.3 Other Considerations 814 

A PAM system can offer additional controls and protections such as automated discovery and MFA. 815 
Automated discovery identifies new privileged accounts immediately after they are created. This 816 
function provides an additional layer of monitoring for the enterprise to identify privileged accounts that 817 
are created both pre and post implementation of the PAM system. 818 

5.5.2 Security Analyst 819 

The security analyst accesses the system logs as part of a server-outage investigation. 820 

5.5.2.1 Scenario 821 

In response to an incident or alert, a security analyst requires access to the recorded logs associated 822 
with the incident or alert. The analyst opens the SIEM to review the incident/alert data and identify the 823 
directly and indirectly affected components. Once the components are identified, the analyst must gain 824 
access and review the log data for each component. At this time, the analyst may assess the data that 825 
generated the alert, including interpolating the data relationships and the order of events. The 826 
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assessment includes identifying the users involved, the accounts that they accessed, and the systems 827 
involved. 828 

In this scenario, there is no direct evidence of who caused the incident or what set of actions were taken 829 
that created the outage. To determine who (if a person is responsible) was involved in the incident, the 830 
analyst would have to interview the various administrators to understand who made the change and 831 
how it was done. Shared accounts/passwords limit the data available to determine who made a change. 832 
If an inadvertent or purposeful incorrect change occurs, then the individual involved may be difficult to 833 
identify because a full description of the user’s actions may be difficult to determine.  834 

5.5.2.2 Resolution 835 

The use of a PAM system enables the security analyst to conclude an investigation without relying on 836 
the administrator’s memories of the event, or on sifting through logs if a privileged user is responsible 837 
for the alert/incident. PAM systems log the user activities in each session and can optionally record each 838 
session to allow the manager to review the method or set of commands used to make the change. In 839 
addition, the PAM system provides logs of the event to the security monitoring system or SIEM for 840 
correlation with other enterprise events. If the SIEM is configured to alert on particular PAM events or 841 
combinations of events, then the manager can be proactively notified to review specific changes that 842 
are concerning. In that way, a manager can react as needed versus using their time for monitoring.  843 

5.5.2.3 Other Considerations 844 

PAM systems can also incorporate session recording. The session recording can be useful for 845 
determining the most expedient course of action to reverse/remediate the undesirable system changes 846 
that caused the incident. 847 

5.5.3 Business-Critical/High-Value Application Access 848 

Social media accounts are high-value applications due to the potential impact of misuse. Other examples 849 
of high-value applications are accounts-payable and human-resources systems or any other application 850 
that could significantly impact an organization’s operations. 851 

5.5.3.1 Scenario 852 

A marketing manager decides to manipulate the organization’s brand loyalty by posting a negative 853 
report in the company Twitter account. The marketing manager’s plan includes using the shared account 854 
password to ensure that there is no direct indication of the manager logging into the account. The 855 
manager knows that the password has previously been used by at least four other people in the 856 
organization. The marketing manager posts the negative report by using the shared account. After the 857 
post becomes public, the company posts a retraction and begins an investigation into the negative post. 858 
Where does the enterprise look for the chain of events that led to the “mistaken” announcement?  859 
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5.5.3.2 Resolution 860 

A PAM system can enable the enterprise to control and manage users of social media accounts. Any 861 
approved user can use the PAM system to access the social media accounts. The PAM system can log 862 
user activity in each session and can optionally record each session to allow the organization to review 863 
the set of commands (including all entries) used to create social media posts. In addition, the PAM 864 
system provides logs of the event to the security monitoring system or SIEM for correlation with other 865 
enterprise events. 866 

If the organization used a PAM system to manage access to social media accounts, then all activity could 867 
be recorded for after-action reporting and forensic investigations. In the scenario described above, the 868 
PAM system could have recorded the activity that led to the negative post and could have enabled the 869 
organization to quickly identify the rogue employee. 870 

5.5.3.3 Other Considerations 871 

A PAM system can offer additional controls and protections, such as two-person control. Two-person 872 
control can enforce review policies that might require a second person (possibly the social media 873 
manager) to review all changes prior to posting. This type of control can occur in real time. 874 

6 Security Characteristic Analysis 875 

This section discusses the results of a comprehensive security evaluation of the reference design shown 876 
in Figure 4‑2. This evaluation focuses on the security of the reference design itself. In addition, it 877 
explains the security benefits and drawbacks of the example solutions. The analysis, and the results 878 
documented herein, supports the program goals, efforts, and activities necessary to protect, and to 879 
achieve compliance with, organizational security requirements for PAM. The security characteristic 880 
analysis of the PAM reference design is organized as follows: 881 

 Section 6.4, Analysis of the Reference Design’s Support for Cybersecurity Framework 882 
Subcategories, analyzes the reference architecture in terms of the specific subcategories of the 883 
Cybersecurity Framework that it supports. This section identifies the security benefits of each of 884 
the reference design capabilities and discusses how the reference architecture supports specific 885 
cybersecurity activities, as specified in terms of Cybersecurity Framework subcategories.  886 

 Section 6.5, Security of the Reference Design, reviews vulnerabilities and attack vectors that the 887 
reference design might introduce, as well as ways to mitigate them. 888 

 Section 6.6, Deployment Recommendations, highlights the policies and best practices that an 889 
organization may consider when initiating or implementing any part or all of the reference 890 
architecture. This section includes references to NIST best practices that may help secure the 891 
implementation and the greater infrastructure. 892 
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6.1 Assumptions and Limitations 893 

The security characteristic evaluation has the following limitations: 894 

 It is neither a comprehensive test of all security components nor a red-team exercise. 895 

 It cannot identify all weaknesses. 896 

 It does not include the lab infrastructure. It is assumed that an organization’s infrastructure is 897 
hardened against known threats. Security testing of the lab example implementations would not 898 
be relevant to those adopting the reference design. 899 

6.2 Build Testing 900 

The purpose of the security characteristic analysis is to examine the extent to which the example 901 
solution meets its objective of demonstrating PAM functionality as defined in Section 3.2. In addition, it 902 
is intended to explain the security benefits and drawbacks of the reference design. 903 

6.3 Scenarios and Findings 904 

One aspect of our security evaluation involved assessing how well the reference design addresses the 905 
security characteristics that it was intended to support. The Cybersecurity Framework subcategories 906 
were used to provide structure to the security assessment. The cited sections provide validation points 907 
that the example solution would be expected to exhibit. Using the Cybersecurity Framework 908 
subcategories as a basis for organizing our analysis allowed us to systematically consider how well the 909 
reference design supports the intended security characteristics. 910 

6.4 Analysis of the Reference Design’s Support for Cybersecurity 911 

Framework Subcategories 912 

Table 6-1 lists reference design capabilities, their functions, and the addressed subcategories, along with 913 
the products that we used to instantiate each capability in the example implementation. The focus of 914 
the security evaluation is not on these specific products, but on the Cybersecurity Framework 915 
subcategories, because, in theory, any number of commercially available products could be substituted 916 
to provide the Cybersecurity Framework support represented by a given reference design capability. 917 

The “Cybersecurity Framework Subcategories” column of Table 6-1 lists the Cybersecurity Framework 918 
subcategories that each capability of the reference design supports. The references provide solution 919 
validation, listing specific security functions and controls that a solution supporting the desired 920 
Cybersecurity Framework would include. Using the Cybersecurity Framework subcategories as a basis 921 
for organizing our analysis allowed us to systematically consider how well the reference design supports 922 
specific security activities and provides structure to our security analysis. The remainder of this 923 
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subsection describes how the reference design and implemented products support each of the 924 
identified Cybersecurity Framework subcategories. 925 

Table 6-1 PAM Reference Design Capabilities and Supported Cybersecurity Framework Subcategories 926 

Component Specific Product Function Cybersecurity Framework 
Subcategories 

1. Identity 
Store LDAP 

Radiant Logic 
RadiantOne FID 

1. An identity repository 
specifically reserved for 
the privileged users of 
the organization 

2. Account change monitor-
ing and reporting 

ID.AM-6: Cybersecurity 
roles and responsibilities for 
the entire workforce and 
third-party stakeholders 
(e.g., suppliers, customers, 
partners) are established.  
ID.GV-1: Organizational in-
formation security policy is 
established.  
ID.GV-2: Information secu-
rity roles and responsibilities 
are coordinated and aligned 
with internal roles and ex-
ternal partners.  
PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers.  
PR.AC-4: Access permissions 
are managed, incorporating 
the principles of least privi-
lege and separation of du-
ties. 

2. MFA RSA SecureID 
Access 
 
IdRamp Secure 
Access combined 
with Microsoft 
Authenticator and 
Azure Active 
Directory services 
 

3. Add-on MFA capabilities 
for PAM system user 
login authentication 

4. Logs of each authentica-
tion attempt 

PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers. 
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Component Specific Product Function Cybersecurity Framework 
Subcategories 

OneSpan 
(Formerly VASCO) 
DIGIPASS 

3. User 
Interface  

Bomgar (formerly 
Lieberman 
Software) Red 
Identity Suite 
 
Remediant 
SecureONE 
 
TDi Technologies 
ConsoleWorks 

5. Login authentication and 
a user-to-PAM-system 
interactive interface 
through which users in-
teract to establish work 
sessions for each system 
that they administer or 
access to perform their 
work functions 

N/A 

4. Policy 
Management  

Bomgar (formerly 
Lieberman 
Software) Red 
Identity Suite 
 
Remediant 
SecureONE 
 
TDi Technologies 
ConsoleWorks 

6. The enterprise privi-
leged-user access and 
control policies, such as 
privileged user sessions, 
are limited to four hours. 

ID.AM-6: Cybersecurity 
roles and responsibilities for 
the entire workforce and 
third-party stakeholders 
(e.g., suppliers, customers, 
partners) are established.  
ID.GV-1: Organizational in-
formation security policy is 
established. 
ID.GV-2: Information secu-
rity roles and responsibilities 
are coordinated and aligned 
with internal roles and ex-
ternal partners.  
ID.GV-4: Governance and 
risk management processes 
address cybersecurity risks.  
PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers.  
PR.AC-4: Access permissions 
are managed, incorporating 
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Component Specific Product Function Cybersecurity Framework 
Subcategories 
the principles of least privi-
lege and separation of du-
ties. 

5. Password 
Management  

Bomgar (formerly 
Lieberman 
Software) Red 
Identity Suite 

7. Management and en-
forcement of the enter-
prise password policies 

ID.GV-4: Governance and 
risk management processes 
address cybersecurity risks.  
PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers. 

6. Session 
Management  

Bomgar (formerly 
Lieberman 
Software) Red 
Identity Suite 
 
TDi Technologies 
ConsoleWorks 

8. The session start and 
stop functionality 

9. Enforces the enterprise 
access and control poli-
cies within each work 
session, such as limiting 
sessions to Secure Shell 
(SSH) or Remote Desktop 
Protocol (RDP) or limiting 
allowed application use 
on the target system 

PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers.  
PR.DS-2: Data in transit is 
protected.  
PR.PT-3: Access to systems 
and assets is controlled, in-
corporating the principle of 
least functionality. 
PR.PT-4: Communications 
and control networks are 
protected. 

7. Password 
Vault 

Bomgar (formerly 
Lieberman 
Software) Red 
Identity Suite 
 
TDi Technologies 
ConsoleWorks 

10. Provides secure storage 
of the current password 
for each privileged ac-
count managed by the 
PAM system 

PR.DS-1: Data at rest is pro-
tected. 

8. Emergency 
Access  

Bomgar (formerly 
Lieberman 
Software) Red 
Identity Suite 
 

11. PAM use in unpredicted 
or emergency situations 
when access to privi-
leged accounts is re-
quired by unanticipated 

ID.BE-5: Resilience require-
ments to support delivery of 
critical services are estab-
lished.  
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Component Specific Product Function Cybersecurity Framework 
Subcategories 

Remediant 
SecureONE 
 
TDi Technologies 
ConsoleWorks 

users (privileged or 
nonprivileged)required 
by unanticipated users 
(privileged or nonprivi-
leged) 

ID.GV-1: Organizational in-
formation security policy is 
established.  
ID.GV-2: Information secu-
rity roles and responsibilities 
are coordinated and aligned 
with internal roles and ex-
ternal partners.  
ID.GV-4: Governance and 
risk management processes 
address cybersecurity risks.  
PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers.  
PR.AC-4: Access permissions 
are managed, incorporating 
the principles of least privi-
lege and separation of du-
ties. 

9. Automated 
Account 
Discovery  

Bomgar (formerly 
Lieberman 
Software) Red 
Identity Suite 
 
Remediant 
SecureONE 

12. Automated search of the 
enterprise for evidence 
and identification of priv-
ileged accounts, such as 
domain administrators 
or accounts that directly 
or indirectly (through in-
heritance of privileges) 
have privileged-account-
level authority 

ID.GV-4: Governance and 
risk management processes 
address cybersecurity risks.  
PR.AC-1: Identities and cre-
dentials are managed for 
authorized devices and us-
ers.  
PR.AC-4: Access permissions 
are managed, incorporating 
the principles of least privi-
lege and separation of du-
ties.  
DE.CM-7: Monitoring for un-
authorized personnel, con-
nections, devices, and soft-
ware is performed. 
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Component Specific Product Function Cybersecurity Framework 
Subcategories 

10. Session 
Monitoring 

Ekran System 
Client 
 
TDi Technologies 
ConsoleWorks 

13. A mechanism to identify, 
log, and alert on anoma-
lous privileged-account 
activity 

DE.CM-3: Personnel activity 
is monitored to detect po-
tential cybersecurity events. 

11. Session 
Replay  

Ekran System 
Client 
 
TDi Technologies 
ConsoleWorks 

14. Session review for train-
ing and event review and 
investigations 

RS.AN-3: Forensics are per-
formed. 

12. Security 
Monitoring 

Splunk Enterprise 
 
Radiant Logic 
RadiantOne FID 

15. Logging and auditing 
provide log storage, anal-
ysis, and alerting compo-
nents 

DE.AE-2: Detected events 
are analyzed to understand 
attack targets and methods.  
DE.AE-3: Event data are ag-
gregated and correlated 
from multiple sources and 
sensors. 
DE.AE-5: Incident alert 
thresholds are established.  
DE.CM-3: Personnel activity 
is monitored to detect po-
tential cybersecurity events.  
DE.CM-7: Monitoring for un-
authorized personnel, con-
nections, devices, and soft-
ware is performed.  
PR.PT-1: Audit/log records 
are determined, docu-
mented, implemented, and 
reviewed in accordance with 
policy.  
RS.CO-2: Events are re-
ported consistent with es-
tablished criteria. 

13. Lab 
Environment  

Miscellaneous 16. Virtual machines, net-
working, routing, fire-
walls, etc. 

PR.AC-5: Network integrity 
is protected, incorporating 
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Component Specific Product Function Cybersecurity Framework 
Subcategories 
network segregation where 
appropriate.  
PR.DS-5: Protections against 
data leaks are implemented. 

 927 
Note: Table 6-1 describes only the product capabilities and the Cybersecurity Framework subcategory 928 
support that the reference architecture addresses. Many of the products have additional security 929 
capabilities that are not listed in this table. 930 

6.4.1 Supported Cybersecurity Framework Subcategories 931 

The reference design is created to identify a set of capabilities and their relationship to provide a PAM 932 
solution. These capabilities ensure that privileged accounts are protected from potential cyber attacks 933 
and breaches. The Cybersecurity Framework (i.e., functions, categories, and subcategories) defines the 934 
capabilities and processes needed to implement a cybersecurity program. Within this practice guide 935 
(Table 3-1), the NCCoE has identified the Cybersecurity Framework subcategory capabilities and 936 
processes that are desirable to implement a PAM solution. In the following subsections, we review how 937 
the PAM reference design addresses the Cybersecurity Framework subcategories included in Table 3-1 938 
with technical capabilities. The following subsections also include the Cybersecurity Framework 939 
subcategory processes from Table 3-1 that are beyond the scope of the PAM solution, but important for 940 
organizations to address. Some Cybersecurity Framework subcategories are supported by individual 941 
components of the reference design, and other subcategories are supported by the reference design as 942 
a whole. Still, other Cybersecurity Framework subcategories are relevant as long as the reference design 943 
is predicated upon them being addressed by the enterprise-wide security architecture, policies, and 944 
programs. 945 

6.4.1.1 ID.AM-3: Organizational Communication and Data Flows Are Mapped 946 

All communication paths, flows of data, directories, and connectivity between the directories and other 947 
components that are within the reference design are clearly defined and identified. This supports the 948 
ability to determine and control information flows, data sources, where the data is stored, who is 949 
responsible for the data, and who is authorized to access the data throughout the organization. It also 950 
allows policy administrators and managers to conduct risk assessments when data or the flow of data is 951 
modified. In addition, the reference design ensures that all resources are properly classified and mapped 952 
according to the needs of the organization. The reference design can support Cybersecurity Framework 953 
Subcategory ID.AM-3 with respect to managing data flows associated with the use of privileged 954 
accounts and the authentication of privileged users. 955 
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6.4.1.2 ID.AM-6: Cybersecurity Roles and Responsibilities for the Entire Workforce and Third-956 
Party Stakeholders Are Established  957 

The reference design is predicated on there being a clearly defined set of roles and responsibilities for 958 
each privileged user that determines that user’s required access. The organization’s policy 959 
administrators define the roles and responsibilities of the privileged users within the workforce and 960 
describe these roles and responsibilities in terms of authorized privileged account use (and at what 961 
level). Once these roles and responsibilities have been established and described within the reference 962 
design, the design then serves as the mechanism for enforcing the privileged-access-control-related 963 
aspects of these roles and responsibilities. The policy management, user interface, and session 964 
management capabilities enforce policies for privileged users and ensure access-policy compliance. 965 

6.4.1.3 ID.BE-5: Resilience Requirements to Support Delivery of Critical Services Are 966 
Established 967 

The reference design supports resilience by identifying system capabilities and processes that maintain 968 
the functionality of the design in degraded environments, including emergency access, security 969 
monitoring, detecting and preventing malicious activity, generating alerts and sending incident 970 
notifications, etc. Emergency access allows the use of the PAM system in unpredicted or emergency 971 
situations when access to privileged accounts is required by unanticipated users (privileged or 972 
nonprivileged). These capabilities support the resilience requirements to deliver critical services for 973 
most operating states (e.g., under duress/attack, during recovery, during normal operations).  974 

6.4.1.4 ID.GV-1: Organizational Cybersecurity Policy Is Established and Communicated 975 

Policy administrators and managers are responsible for establishing policy requirements for privileged 976 
accounts and for the interactions between these accounts and their users. The reference design has 977 
implemented policy enforcement and automated account discovery capabilities to support best 978 
practices, processes, and structures that ensure privileged access policy compliance. It also ensures the 979 
flow of information to all components to prevent and detect any unauthorized access. 980 
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6.4.1.5 ID.GV-2: Cybersecurity Roles and Responsibilities Are Coordinated and Aligned with 981 
Internal Roles and External Partners 982 

The reference design is predicated on there being a clearly defined set of roles and responsibilities for 983 
each privileged user that determines that user’s required access. It is expected that roles and 984 
responsibilities are established within the organization’s information security policies, procedures, 985 
standards, or guidelines for internal employees and contractors. This determines the level of 986 
responsibilities or the functions that are assigned to an individual (including contractors) and at what 987 
level of privilege they are assigned. Within the reference design, this is supported by the policy 988 
management, user interface, and automated account discovery components, which ensure that 989 
privileged users are authorized to perform privileged functions based on their roles and responsibilities 990 
and that any attempts to bypass those roles are detected. It is important that the policy requirements 991 
are communicated to all employees. Organizations adopting the reference design may ensure that 992 
contractors clearly understand their roles and responsibilities as defined by the organization.  993 

6.4.1.6 ID.GV-4: Governance and Risk Management Processes Address Cybersecurity 994 
Risks 995 

Senior management is responsible for the organization’s risk assessment processes. An organization’s 996 
risk management program should include strategies that ensure that risks are identified, registered, and 997 
mitigated. The reference design is based on a risk assessment in Section 3.4. The reference design 998 
capabilities support the risk analysis, risk response/mitigation, and risk monitoring process that address 999 
the cyber risk factors that privileged accounts represent. 1000 

6.4.1.7 PR.AC-1: Identities and Credentials Are Issued, Managed, Verified, Revoked, and 1001 
Audited for Authorized Devices, Users, and Processes 1002 

Organizations establish privileged-account access control policies to ensure that privileged account use 1003 
is limited to authorized personnel, least privilege is implemented, and separation of duties is 1004 
maintained. Access control policies determine the authentication method and authorization processes, 1005 
roles, and responsibilities of the users. The privileged identity store capability deployed within the 1006 
reference design provides a unique repository for privileged users’ identities and credentials. This is 1007 
fundamental to the reference design to segregate the privileged-user community and account 1008 
information from the production components of the organization. This Cybersecurity Framework 1009 
element primarily considers the implementation of privileged access controls via the account sharing 1010 
technique. 1011 
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6.4.1.8 PR.AC-4: Access Permissions and Authorizations Are Managed, Incorporating the 1012 
Principles of Least Privilege and Separation of Duties 1013 

A key strength of the reference design is the ability to enforce policies for privileged accounts, including 1014 
the principles of least privilege and separation of duties. By enforcing these principles, the reference 1015 
design allows limiting unauthorized access to data and systems.  1016 

The policy management capability is the repository for approved-use policies for use by the session 1017 
management and user interface capabilities. The session management capability enforces the access 1018 
policies. The session management and password capabilities ensure the control of privileged sessions 1019 
and of usage of the password vault, through request and approval workflows and (optionally) time-1020 
bound access. Automated account discovery is an important consideration as well, as that functionality 1021 
will detect any attempts to bypass or ignore the principles of least privilege and separation of duties. All 1022 
privileged user activities in the reference design are logged and sent to the monitoring component for 1023 
further analysis. Policy administrators and managers are responsible for setting up, making changes to, 1024 
and managing, all privileged accounts and functions. This Cybersecurity Framework element primarily 1025 
considers the implementation of privileged access controls via the account escalation technique. 1026 

6.4.1.9 PR.AC-5: Network Integrity Is Protected (e.g., Network Segregation, Network 1027 
Segmentation) 1028 

Network segmentation is a key function of this reference design. Segregating the PAM system from the 1029 
production network reduces the risk of session information interception and exposure of privileged 1030 
account information to nonprivileged users and systems, and reduces the risk of being negatively 1031 
impacted from malware or an exploit. The PAM system was implemented on a management network to 1032 
accomplish the network segmentation. Using firewalls and routers to segregate the zones also limits the 1033 
risk to the enterprise, should a vulnerability be exploited within the production network.  1034 

6.4.1.10 PR.DS-1: Data at Rest Is Protected 1035 

Privileged user account information is not encrypted while stored at rest. However, this data is limited 1036 
to the privileged user identity store within the reference design and is situated in its own security 1037 
enclave or subnetwork. The security enclave consists of the physical directory only, without any other 1038 
reference design components, and is separated from the rest of the reference design by a firewall.  1039 

Furthermore, although this information is not encrypted while at rest, its integrity is monitored by the 1040 
security monitoring capability. The security monitoring capability receives logs of privileged account 1041 
information changes from the privileged user identity store and from the underlying enterprise-wide 1042 
identity store and PAM activity log. The monitoring capability correlates and compares the log 1043 
information that it receives from each of the components, to ensure that the information is consistent 1044 
across all sources. In this way, it is possible to verify that each change made to the privileged identity 1045 
store and/or enterprise-wide identity store is the result of an authorized change by an authorized 1046 
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privileged user or system. If a change to an identity store is detected and cannot be correlated with logs 1047 
from other components, then the system generates an alert to signal that this change might be 1048 
unauthorized. File integrity tools are available to monitor for the loss of event integrity within systems 1049 
like an identity store. These tools are not addressed in the reference design. 1050 

6.4.1.11 PR.DS-2: Data in Transit Is Protected 1051 

Privileged user access information is encrypted while it is in transit within the reference design 1052 
components, where possible. In the example implementation, multiple applications are used to 1053 
implement the policy management and user interface (access control) components over secure 1054 
protocols (e.g., Transport Layer Security [TLS]) so that all information that flows between the 1055 
components is not transmitted over a network where it would be vulnerable to eavesdropping or 1056 
tampering. If the reference design were built using separate physical components to instantiate the 1057 
policy management and user interface components, then messages exchanged among these 1058 
components would need to be provided with at least data integrity, and preferably confidentiality, 1059 
protections.  1060 

In the current example implementation (Request for Comments 2830), LDAP over SSL [Secure Sockets 1061 
Layer] (LDAPS) is used to perform read-and-write access to the identity store component, ensuring that 1062 
privileged user account information sent across a network to these other components is encrypted. 1063 
Also, when log information is sent to the monitoring component, it is encrypted, resulting in protection 1064 
from disclosure and from unauthorized modification. 1065 

6.4.1.12 PR.DS-5: Protections Against Data Leaks Are Implemented 1066 

The reference design itself, through its focus on managing access permissions, protects the enterprise in 1067 
general against data leaks that might occur. By preventing unauthorized access to information, the 1068 
reference design protects against leaks of that information. The reference design, however, is not 1069 
intended to protect against the exfiltration of information by an authorized user; such an insider threat 1070 
is not addressed. The fact that data flows within the reference design are encrypted serves to ensure 1071 
that, even if data-in-transit within the reference design was exfiltrated, this information would not be in 1072 
plaintext form. For example, administrators may have access to administration and configuration 1073 
directories, but not to directories that contain sensitive data files. The reference design allows logging all 1074 
privileged user access, ensuring that, if a privileged user misuses their privileges and leaks data, this 1075 
activity would be recorded in log files and would generate alerts.  1076 

Within the reference design, a management network is implemented to segment network access and 1077 
can increase the effort needed to exfiltrate data. Automated account discovery is an important 1078 
consideration as well, as that functionality will detect any attempts to bypass these other protections in 1079 
an attempt to leak data by using privileged access. 1080 
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6.4.1.13 PR.PT-1: Audit/Log Records Are Determined, Documented, Implemented, and 1081 
Reviewed in Accordance with Policy 1082 

The reference design ensures the real-time monitoring of privileged sessions and optionally can record 1083 
every session for a detailed audit trail in accordance with requirements defined by an organization’s 1084 
policies and compliance requirements. The security monitoring capability ensures that all session activity 1085 
and access-related change activity can be centrally logged, tracked, and managed. All relevant 1086 
information (e.g., about, what, when, who) at each design component is monitored and logged. The 1087 
design leverages automation to collect, protect, and analyze logs; produce log-based reports; and retain 1088 
log data to support investigations. Given that access to the logs in the monitoring capability would 1089 
enable an adversary to delete or modify logs that document adversarial activity, the ability to delete or 1090 
modify such logs should, by policy, require the cooperation of multiple individuals. 1091 

6.4.1.14 PR.PT-3: Access to Systems and Assets Is Controlled, Incorporating the Principle of 1092 
Least Functionality 1093 

Please refer to Section 6.4.1.8 for an explanation of the how the reference design supports this 1094 
Cybersecurity Framework subcategory. 1095 

6.4.1.15 PR.PT-4: Communications and Control Networks Are Protected 1096 

Please refer to Section 6.4.1.9, Section 6.4.1.11, and Section 6.4.1.12 for an explanation of the how the 1097 
reference design supports this Cybersecurity Framework subcategory. 1098 

6.4.1.16 DE.AE-2: Detected Events Are Analyzed to Understand Attack Targets and Methods 1099 

The reference design provides comprehensive-log and advanced-threat analytics to detect malicious 1100 
activity that is near-real-time, accurate, comprehensive, and scalable. These capabilities include 1101 
analyzing logs from the PAM system capabilities and related activities of privileged accounts. 1102 
Comprehensive logs and advanced threat analytics allows analysts and administrators to detect and 1103 
correlate anomalous events in a timely, structured, and constant way. Unauthorized operation/activity 1104 
attempts are detected and analyzed through these capabilities. They also automate the processes 1105 
required to understand suspicious privileged-account access or use attempts. 1106 

6.4.1.17 DE.AE-3: Event Data Are Collected and Correlated from Multiple Sources and Sensors 1107 

The security monitoring capability provides real-time monitoring and aggregates and correlates 1108 
privileged-account or privileged-user logs from the following sources:  1109 

 user interface (access control)  1110 

 password vault  1111 

 identity store (LDAP) 1112 
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 automated account discovery  1113 

 emergency access  1114 

 session management  1115 

6.4.1.18 DE.AE-5: Incident Alert Thresholds Are Established 1116 

The alert thresholds are binary. If the user-access information logs that the security monitoring 1117 
capability receives from each of its sources are not consistent with each other, then an alert is 1118 
generated. If the user-access information logs received from the various components are consistent 1119 
with one another, then no alert will be generated, but the information will be logged. The reference 1120 
design provides capabilities to define thresholds and to log and audit user access information within 1121 
each directory that is consistent with established policies. All incidents and events in the reference 1122 
design are clearly communicated. Policy managers define and categorize the incident reporting process 1123 
(e.g., a user logging into an account, a web server receiving a request for a specific web page, a user 1124 
accessing files on network share, a firewall blocking a connection attempt). For additional information, 1125 
please refer to NIST SP 800-61, Computer Security Incident Handling Guide [15]. 1126 

In addition, the monitoring capability of the reference design ensures that logs received from any 1127 
privileged operation are consistent with each another. If any inconsistences in the logs are detected, 1128 
then an alert is generated based on the threshold defined by policy managers. This analysis may help 1129 
identify unauthorized access attempts and can be supplemented to detect some Kerberos-based 1130 
attacks. 1131 

6.4.1.19 DE.CM-3: Personnel Activity Is Monitored to Detect Potential Cybersecurity Events 1132 

All activity associated with privileged accounts in the reference design is monitored on a continuous 1133 
basis. This includes all activity that administrators, policy administrators, and other privileged users 1134 
perform. It also includes alerts when an anomalous activity of an individual is detected. User-interface 1135 
and session monitoring allow configuring and recording proxy-level sessions. The logs are forwarded to 1136 
the monitoring components. For example, a malicious insider or malware attempting (successful or not) 1137 
to access an asset outside defined policies can be detected. Additionally, these capabilities can create an 1138 
unalterable audit trail of privileged account activity; improve incident response times; and provide a rich 1139 
data set from which to understand how, when, and why a security incident occurred. 1140 
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6.4.1.20 DE.CM-7: Monitoring for Unauthorized Personnel, Connections, Devices, and 1141 
Software Is Performed 1142 

The reference design continuously monitors all unauthorized activity and access to restricted resources 1143 
and generates alerts when a potential incident or event is detected. The user interface (access control) 1144 
and configuration components also allow configuring and recording proxy-level sessions. This ensures 1145 
the tracking and detection of suspicious activities of individuals associated with a privileged account or 1146 
system (including the secret mounting of unauthorized drives or devices). The logs are forwarded to the 1147 
monitoring components (SIEM) for proper notification. Automated account discovery is an important 1148 
consideration as well, as that functionality will detect any attempts to disable protections against 1149 
unauthorized access. 1150 

6.4.1.21 RS.CO-2: Incidents Are Reported Consistent with Established Criteria 1151 

The reference design provides the ability to collect logs from multiple sources. Any security incidents 1152 
associated with unauthorized account activity that are consistent with established policies will be 1153 
detected and reported (see Section 6.4.1.22 for more details). It is important to develop a structured 1154 
incident response program by implementing incident response strategies that can detect and resolve 1155 
security incidents. An effective incident response program should include the following stages: 1156 

 incident response process 1157 

 incident investigation life cycle 1158 

 incident remediation 1159 

 incident response 1160 

6.4.1.22 RS.AN-3: Forensics Are Performed 1161 

The reference design incorporates monitoring capabilities for complete visibility and control and 1162 
consolidates identity across all privileged systems, which improves reporting and reduces the audit time 1163 
as well as forensics investigations. This allows all privileged sessions and privileged user activities to be 1164 
recorded. The recording provides details on the user and their activities. This creates accountability to 1165 
support forensic investigations, troubleshoot system failures, and audit reports. For additional 1166 
information, please refer to NIST SP 800-86, Guide to Integrating Forensic Techniques into Incident 1167 
Response [16]. 1168 

6.5 Security of the Reference Design 1169 

The purpose of the security characteristic analysis is to understand the extent to which the use case 1170 
meets its objective of demonstrating PAM. In addition, the analysis seeks to understand the security 1171 
benefits and drawbacks of the reference design. The list of reference design capabilities in Table 3-1 1172 
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focuses on the capabilities needed to ensure the integrity of system data and to manage and secure the 1173 
reference design. To this end, this section focuses on the security of the reference design itself. 1174 

The following measures were implemented to protect the reference design from outside attack:  1175 

 installed an MFA system to provide an additional layer of security 1176 

 installed session management capabilities to track and manage all privileged user sessions, 1177 
integrated with the password manager 1178 

 installed policy management  1179 

 installed a management network to isolate log and PAM-system traffic from the production 1180 
(business operations) networks 1181 

 limited the use of, and access to, privileged accounts 1182 

 monitored identity stores to detect unapproved insertion, modification, or deletion 1183 

 monitored individual endpoints to detect unapproved privileged access allocation 1184 

 recorded and logged all privileged-account use and access activities 1185 

 used encryption and integrity protection of identity-store-access and system logs while this 1186 
information was in transit  1187 

The security evaluation focuses on the capabilities, rather than the products. The NCCoE is not assessing 1188 
or certifying the security of the products included in the example implementations. We assume that an 1189 
organization already deploys network security, such as firewalls and intrusion detection devices, that are 1190 
configured using best practices. The focus of this section is securing capabilities introduced by the 1191 
reference design and minimizing their exposure to threats. The list in Table 3-2 also includes capabilities 1192 
for managing and securing the PAM reference design. 1193 

6.5.1 Securing New Attack Surfaces 1194 

The reference design introduces new capabilities into an organization, and with any new capability 1195 
comes the potential for new attack surfaces. Hence, it is imperative that reference design capabilities 1196 
and their contents be secured to minimize their potential to introduce new vulnerabilities into the 1197 
enterprise. The threat landscape is dynamic. Therefore, maintaining the security of the reference design 1198 
requires establishing and maintaining privileged account control and control of security events from 1199 
multiple sources, while being responsive to perceived threats and malicious activities. However, if an 1200 
organization deploys the reference design, then the organization will also have additional capabilities 1201 
that must be safeguarded—namely, the policy management, user interface (access control), session 1202 
management, password vault, monitoring, and emergency access. Each capability must be protected 1203 
from unauthorized access so that the information that they contain is safeguarded from unauthorized 1204 
modification. One method that assists with this protection is automated account discovery, as that 1205 
function detects attempts to bypass or otherwise defeat existing information security protections. 1206 
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Points of entry. The user interface provides the primary point of entry for a PAM system. Therefore, the 1207 
protection of the user interface and authentication method for PAM users is critically important. The 1208 
reference design addresses the user authentication by implementing MFA to reduce the chance of a 1209 
successful impersonation of an authorized PAM user. The user interface system must be protected 1210 
within the organization by limiting access to the underlying support systems (e.g., OS, physical 1211 
hardware). A successful attack on the user interface system could allow an attacker to compromise any 1212 
of the PAM system capabilities. For example, if an adversary could compromise the policy management, 1213 
password vault, or user interface (access control) capabilities, then the attacker would be able to access 1214 
the PAM system for unauthorized use. Inappropriate or unauthorized use of these capabilities could 1215 
change the authorization levels for anyone in the enterprise.  1216 

Disabling monitoring. Continuous monitoring is critical to detect anomalous system changes or 1217 
activities. The monitoring capability must be protected from physical and logical access. Example 1218 
Implementation 3 provides an example of logical access control for the monitoring capability. Further, 1219 
automated account discovery is an important consideration to protect the fidelity of the monitoring and 1220 
to ensure that no attempts to bypass, redirect, or disable the continuous monitoring facility have been 1221 
made. 1222 

Sabotaging detection. Unauthorized access to the PAM user interface, password vault, and security 1223 
monitoring capabilities must be prevented because of the value of the information that they maintain 1224 
and store. The monitoring capability forms the locus of the reference design’s analytic capabilities for 1225 
detecting access control security events. The aggregation of privileged-account information and logs in 1226 
the monitoring capability provides enormous potential in terms of anomaly detection. If an adversary 1227 
could access the password vault and the monitoring capabilities to modify or delete information or to 1228 
alter the rules used to analyze information, then the ability to monitor and detect access control 1229 
anomalies could be severely impaired. The example solution illustrates one of the techniques for 1230 
protecting the PAM and security monitoring capability through a network segmentation technique. With 1231 
network segmentation, attackers are required to identify the management network, and to cross over 1232 
the network boundaries undetected, before unauthorized access to the PAM system and security 1233 
monitoring capabilities can be achieved. Network segmentation is an important defense-in-depth tactic. 1234 

Safeguarding the enterprise. The following sections discuss mechanisms that are used to secure these 1235 
reference design capabilities and to safeguard user access and policy information. In all cases, restricting 1236 
logical and physical access to these capabilities is key to protecting them. Standard users are never given 1237 
accounts on, or given authorization to access, any reference design capabilities. Each reference design 1238 
capability should permit access by only one or two privileged users who have the authority and 1239 
responsibility to administer that (and only that) reference design capability, or, by policy, the 1240 
cooperation of multiple individuals should be required to access any single reference design capability, 1241 
thereby decreasing the probability that any capability could be subverted by a single inside adversary. 1242 
No administrative users should reuse the same workstation or administrative activities account that 1243 
they use for other business use, such as email, word processing, or other business applications. 1244 
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Furthermore, access to the consoles/management interfaces of the machines and applications on which 1245 
the reference design capabilities reside must be protected. The PAM implementation can be used to 1246 
administer portions of the implementation, or another PAM system might be considered to administer 1247 
the primary PAM system, based on the needs and risk management decisions of the organization. Any 1248 
passwords needed for PAM system administration should be stored separately in a manner consistent 1249 
with the organization’s risk management decisions. This helps ensure that all access to any reference 1250 
design capability must be performed via the PAM (rather than directly via the machine console) or in 1251 
another secure manner.  1252 

6.5.2 Securing Access to the LDAP Directory 1253 

The identity store (LDAP) is the authoritative source for privileged account information. The security of 1254 
the identity store can be maximized by ensuring that direct connection to consoles of the machines on 1255 
which these capabilities reside is physically secured and that console passwords are secure according to 1256 
organization risk management decisions. This approach will minimize the possibility that any reference 1257 
design machine could be accessed directly, rather than via the PAM. In addition, the reference design 1258 
implements the MFA capability to ensure that all privileged access requests can be authenticated using a 1259 
strong method.  1260 

6.5.3 Securing Access to the Policy Management Capability 1261 

The ability to create and modify privileged account policies within the policy management capability 1262 
must also be carefully controlled. By policy, workflows should be established to ensure that no single 1263 
administrator can create or modify policies in isolation. Workflows based on the principles of least 1264 
privilege and separation of duties should be defined to ensure that multiple administrators and/or 1265 
multiple administrative approvals are received before updates are performed. It should not be possible 1266 
to submit policies that have not been properly vetted and approved by using an approved workflow.  1267 

6.5.4 Securing Access to the User Interface (Access Control) Capability 1268 

The user interface capability provides login authentication and an interactive interface through which 1269 
users interact to establish work sessions for each target system that they administer or access to 1270 
perform their privileged functions. This establishes the single entry point into the reference design. The 1271 
reference design should not accept direct input from any source other than the user interface (or an 1272 
associated and equally well-authenticated application programming interface [API]). The identity store 1273 
and MFA capabilities provide additional layers of security to ensure the use of a strong authentication 1274 
method. 1275 
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6.5.5 Securing Password Vault Capability 1276 

The password vault capability of the reference design stores and manages all passwords for every 1277 
privileged user, according to the account sharing technique. Because the vault stores sensitive data, it 1278 
becomes a target for attackers. Therefore, it is critical to protect the password vault from unauthorized 1279 
access. Access to the password vault should require two-person control to increase the resistance to a 1280 
single malicious actor acting independently. MFA should also be incorporated to further increase the 1281 
resistance to an attack that is performed via the impersonation of an authorized user. 1282 

6.5.6 Securing Emergency Access Capability 1283 

The emergency access capability provides additional privileged account access to the PAM components 1284 
when normal access control to the password vault is broken down or when outages and failure happen 1285 
in the enterprise infrastructure. This may be the only access point to restore the PAM system to normal 1286 
operation or to use the PAM system when the unanticipated or unauthorized personnel require access 1287 
to privileged accounts. For example, if privileged users are locked out of the password vault, then the 1288 
senior administrator can log into the password vault and get the credentials for the privileged users in all 1289 
cases, even if (for example) the LDAP infrastructure is down and no one can log into the PAM system in 1290 
the usual manner. Policy administrators and managers may write down and store the emergency access 1291 
passwords in a physical vault. In such cases, the physical vault is placed in a secure location with limited 1292 
access. 1293 

6.5.7 Securing Access to the Security Monitoring and Analytics Capability 1294 

The security monitoring capability, which provides complete management and visibility within the 1295 
reference design, collects and tracks all privileged user activity in real time. Therefore, if an adversary 1296 
could modify the contents of the monitoring capability without detection, then that would negatively 1297 
impact the ability of the reference design to monitor all privileged account changes. By policy, only 1298 
security analysts, whose role is to be notified of alerts and to examine the logs pertinent to those alerts 1299 
to determine if there is a genuine security event, should be able to view logs, and the logs should be 1300 
accessible only via read-only access. Workflows based on the principles of least privilege and separation 1301 
of duties should be defined to ensure that multiple administrators and/or multiple administrative 1302 
approvals are received before any changes to the monitoring analytics are performed. It should not be 1303 
possible to create or modify analytics that have not been properly vetted and approved. Example 1304 
Implementation 3 illustrates one approach to secure a security monitoring capability. 1305 

6.5.8 Ensuring Information Integrity 1306 

Within the reference design, multiple capabilities have been implemented to prevent unauthorized 1307 
modification or deletion of access policies, privileged account information, and analytics information 1308 
stored in these capabilities. In addition to preventing access to information while it is stored in these 1309 
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capabilities, the information must be protected from modification while it is in transit between 1310 
reference design capabilities. If privileged accounts or policy information were to be deleted, modified, 1311 
or falsified while in transit between capabilities, then the result would be a loss of confidence in the 1312 
access authorization and authentication of users. It is essential that the user-access and policy 1313 
information have integrity protection, and ideally confidentiality protection, when in transit between 1314 
capabilities. Securing communications among all capabilities is essential to securing the reference 1315 
design. To provide this protection, all information sent to and from LDAP is encrypted using the TLS 1316 
protocol.  1317 

All logs sent within the reference design are encrypted in transit to ensure confidentiality and integrity 1318 
from the reference design capability to the monitoring capability. Once the log file is transmitted to the 1319 
monitoring capability, it is stored in the clear (i.e., in plaintext form), where it would be vulnerable to 1320 
modification or deletion if an adversary were able to gain unauthorized access to the monitoring 1321 
capability. 1322 

6.5.9 Protecting Privileged Accounts 1323 

In any organization that adopts the reference design, we would expect there to be several classes of 1324 
privileged users who are authorized to access reference design capabilities or the machines on which 1325 
they are running, for administering those capabilities and machines. It is important to limit privileged 1326 
users and accounts by enforcing the principle of least-privilege access controls. The reference design 1327 
implements the automatic account discovery capability, which ensures the detection of all privileged 1328 
account changes within the privileged identity store and of the assets administered or otherwise 1329 
accessed by using privileged accounts. 1330 

6.5.10 Preventing Insider Threats 1331 

Insider threats are difficult to detect. The attacks perpetuated by insiders, and the consequences 1332 
resulting from such attacks, can be very costly. The reference design supports the principles of least 1333 
privilege and separation of duties. These principles restrict privileged users to only those resources to 1334 
which their role gives them access, and limit privileged users in what they are authorized to do with 1335 
those resources. The implementation of these policies does not prevent inside attacks; however, it can 1336 
reduce the scope of the damage that an insider can cause. The privileged account identity store and 1337 
MFA capabilities in the reference design prevent an unauthorized user from using privileged accounts. 1338 
These measures ensure that the reference design itself is secure from any nonprivileged user insider 1339 
threat. Any organization adopting the reference design should ensure the integration of these protective 1340 
mechanisms and other solutions that it may see fit in its implementation against insider threats.  1341 
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6.5.11 Addressing Attacks 1342 

The specific challenge of the reference design is the abuse of privileged account credentials. Once these 1343 
accounts are compromised, an adversary can create additional accounts to avoid detection, escalate 1344 
their privileges, and disrupt critical services. To address these and other related challenges in a 1345 
comprehensive way, we used the Adversarial Tactics, Techniques, and Common Knowledge (ATT&CK) 1346 
model and framework developed by The MITRE Corporation, to identify the following adversary tactics 1347 
and techniques against which the reference design protects: 1348 

 Privilege escalation and credential access result when an adversary obtains or modifies a higher 1349 
level of permissions on a system or network than they are authorized to have.  1350 

• An adversary employing the tactic of privilege escalation might use the technique to modify 1351 
their privilege information attributes that are stored in LDAP, so that these attributes 1352 
permit the adversary to have more access authority than entitled. In this attack technique, 1353 
the adversary tries to circumvent the principle of least privilege. The reference design 1354 
protects against circumventing the principle of least privilege, through MFA, password 1355 
managers, session management, automated account discovery, logging, and security 1356 
monitoring, which enables it to detect changes in privileged account information that is 1357 
stored in LDAP. 1358 

• Alternatively, an adversary attempting to abuse privileges could use the technique of 1359 
creating a secret account in one of the enterprise’s directories and giving that new account 1360 
the desired higher level of privilege for malicious purposes. This means that the adversary 1361 
is not using the PAM user interface. The monitoring and logging system is designed to 1362 
detect and generate an alert when an unauthorized new account is created. 1363 

• Similarly, an adversary could create a local account (outside the scope of the enterprise 1364 
directory) and grant it privileged access. The unauthorized new account will be detected 1365 
only if the automated account discovery capability has been deployed and includes in its 1366 
scan scope such local accounts. 1367 

• Credential access results when an adversary obtains unauthorized privileged access to 1368 
enterprise resources or when an adversary modifies credential information in unapproved 1369 
ways. An adversary employing the tactic of privileged credential access abuse could use the 1370 
technique of trying to obtain legitimate privileged user credentials that belong to another 1371 
user by eavesdropping on these credentials as they are sent to and from directories in the 1372 
network. The reference design protects against such privileged credential access abuse 1373 
through its use of LDAPS (SSL-based encrypted traffic between LDAP servers and clients) 1374 
and MFA, which prevents the network sniffing of another privileged user’s credentials. 1375 
Further, use of the account escalation (rather than account sharing) design pattern can 1376 
mitigate the risk of credential access by minimizing the value of stolen credentials. 1377 
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6.5.12 User Behavior Analytics 1378 

UBA tracks a system’s user and their interactions with the system, rather than security events or 1379 
devices. UBA solutions detect behaviors of concern by combining all relevant data (e.g., network and 1380 
client/host-based activity, human resource systems, employee reports, public records, travel records) 1381 
and then looking for meaningful patterns of behavior. UBA offers the potential for organizations to 1382 
improve their security posture by detecting that an attack—such as a privilege escalation attack—has 1383 
been launched or is to be imminently launched, allowing the organization to take preventive, corrective, 1384 
and investigative action as appropriate. Detection ideally occurs during the early formative stages of an 1385 
attack or before the technical implementation of an attack has been launched, but can also extend until 1386 
after the primary phase of an attack has been launched. 1387 

Various analytic approaches exist that UBA solutions can leverage to detect privilege escalation attacks, 1388 
including static event and threshold analysis, whereby specific patterns of network and client activity are 1389 
deemed to signify behaviors of concern. Other approaches include anomaly detection that identifies an 1390 
attack based on deviations from a baseline at the organizational, job-role, or individual-employee level. 1391 
These baselines can be generated with or without machine learning algorithms, though the level of 1392 
computational power required increases with system complexity. 1393 

For this build, a UBA capability was not implemented. The low volume of user, client, and network data 1394 
transmitted across the example implementations would have been insufficient for a UBA capability to 1395 
meaningfully identify patterns or develop a baseline. Furthermore, the selection of a UBA should be 1396 
tailored to the business operations and technical infrastructure of an organization. Our test build did not 1397 
have the wider set of system operations and connectivity to adequately simulate a financial institution.  1398 

Nonetheless, there are some UBA considerations that will be consistent across financial institutions that 1399 
wish to select a UBA capability as part of the defense against privilege escalation attacks and other 1400 
forms of cyber attacks. Organizations should consider the following issues when contemplating adding 1401 
UBA to their security architecture: 1402 

 Can the UBA detect or enable other types of attacks? Privilege escalation attacks are only one 1403 
attack of many that financial organizations face. Organizations may consider UBA for the 1404 
detection of alternative avenues of attack or for obscuring alternative types of attack from 1405 
detection. 1406 

 Organizations should consider how UBA can most effectively and efficiently add to the 1407 
situational awareness that a privilege escalation attack (or any attack) is underway. Good 1408 
situational awareness can involve a combination of notifications, visualizations, administration 1409 
and automated system actions, and business processes that are regularly drilled, trained, 1410 
evaluated, and based on best practices from the fields of behavioral sciences and human 1411 
factors. Failure to act quickly—whether through prevention, mitigation, or investigation—can 1412 
generate significant reputational, financial, productivity, legal, and cultural risks that UBA 1413 
solutions would be unable to remedy. 1414 
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6.6 Deployment Recommendations 1415 

When deploying the reference design in an operational environment, organizations should follow 1416 
security best practices to address potential vulnerabilities and to ensure that all assumptions upon 1417 
which the solution relies are valid, to minimize any risk to the production network. Organizations 1418 
leveraging the reference design should adhere to the recommended best practices that are designed to 1419 
reduce risk (see the subsections below). Please note that the example implementations of the reference 1420 
design did not implement every security recommendation. Organizations should not consider this list of 1421 
recommended best practices to be comprehensive; merely following this list will not guarantee a secure 1422 
environment. Planning for the deployment of the design gives an organization the opportunity to go 1423 
back and audit the privileged account information in their directories and get a more global, correlated, 1424 
disambiguated view of the user access roles and attributes. 1425 

6.6.1 Patch, Harden, Scan, and Test 1426 

Vulnerability assessment programs establish controls and processes to help identify weaknesses within 1427 
the organization’s information system components, which could be exploited by attackers to gain 1428 
unauthorized access, to disrupt business operations, and to steal or leak sensitive data. The vulnerability 1429 
assessment focuses on identifying controls and processes that will provide appropriate protection 1430 
against threats that could adversely affect the security of the information system or data entrusted on 1431 
the information system. The controls implemented need to be consistent with established policy 1432 
requirements to secure against known vulnerabilities in OSs and application software. The following 1433 
activities provide additional steps to the IT infrastructure: 1434 

 Keep OSs up-to-date by patching, version control, and monitoring indicators of compromise 1435 
(e.g., performing virus and malware detection, keeping antivirus signatures up-to-date). 1436 

 Harden all capabilities by deploying on securely configured OSs that use long and complex 1437 
passwords and are configured per best practices. Built-in accounts with privileged access rights 1438 
should be disabled or closely monitored. 1439 

 Scan OSs for vulnerabilities and unexpected changes in privileged access. 1440 

 Test individual capabilities to ensure that they provide the expected Cybersecurity Framework 1441 
subcategory support and that they do not introduce unintended vulnerabilities.  1442 

 Evaluate reference design implementations before going operational with them. 1443 

It is also recommended that additional network security strategies are implemented that utilize secure 1444 
protocols and processes. However unlikely a targeted attack is for the reference design, the most potent 1445 
area of risk remains from within the network itself. Pushing audit log capabilities beyond system log 1446 
(syslog) and auditing services into a security monitoring platform increases the likelihood that exploited 1447 
trust relationships would be detected quickly. Such deployments would support a defense-in-depth 1448 
strategy and assist in transitioning the reference design toward a more resilient state. Specifically, check 1449 
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external accounting logs, external syslog logs, booting information (periodically) for information about 1450 
the last time that the firewall was reloaded, and the configuration checksum (on a regular basis), and 1451 
periodically verify the integrity of other software loaded on the firewall. 1452 

6.6.2 Other Security Best Practices 1453 

 Install, configure, and use each capability of the reference design per the security guidance 1454 
provided by the capability vendor.  1455 

 Change the default password when installing software. 1456 

 Identify and understand which predefined administrative and other accounts each capability 1457 
comes with by default, to eliminate any inadvertent backdoors into these capabilities. Disable all 1458 
unnecessary predefined accounts, and, even though they are disabled, change the default 1459 
passwords in case a future patch enables these accounts. 1460 

 Segregate reference design capabilities on their own subnetwork, separate from the production 1461 
network, either physically or by using virtual private networks and port-based authentication or 1462 
similar mechanisms. 1463 

 Protect the various reference design subnetworks from each other and from the production 1464 
network by using security capabilities, such as firewalls and intrusion detection devices, that are 1465 
configured per best practices.  1466 

 Configure firewalls to limit connections between the reference design network and the 1467 
production network, except for the connections needed to support required internetwork 1468 
communications to specific internet protocol (IP) address and port combinations in certain 1469 
directions.  1470 

 Configure and verify firewall configurations to ensure that data transmission to and from 1471 
reference design capabilities is limited to interactions that are needed. Restrict all permitted 1472 
communications to specific protocols and IP address and port combinations in specific 1473 
directions. 1474 

 Monitor the firewalls that separate the various reference design subnetworks from each 1475 
another. 1476 

 Volume C, How-To Guides, contains the firewall configurations that show the rules implemented 1477 
in each of the firewalls for an example implementation. These configurations are provided to 1478 
enable the reader to reproduce the traffic filtering/blocking that was achieved in the 1479 
implementation. 1480 

 Apply encryption or integrity-checking mechanisms to all information exchanged between 1481 
reference design capabilities (i.e., to all user access, policy, and log information exchanged), so 1482 
that tampering can be detected. Use only encryption and integrity mechanisms that conform to 1483 
the most-recent industry best practices. Note that, in the case of directory reads and writes, the 1484 
protected mode is defined as the use of Lightweight Directory Access. 1485 
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 Strictly control physical access to all assets.  1486 

 Deploy a configuration management system to serve as a “monitor of monitors” to ensure that 1487 
any changes made to the list of information are logged and reported to the monitoring system 1488 
or to the analytics in the monitoring system, and that notifications are generated. Such a system 1489 
could also monitor whether reference design monitoring capabilities, such as log integrity 1490 
capabilities or the monitoring system itself, go offline or stop functioning, and could generate 1491 
alerts when these capabilities become unresponsive. 1492 

 Deploy a system that audits and analyzes directory content to create a description of who has 1493 
access to what resources, and to validate that these access permissions correctly implement the 1494 
enterprise’s intended business process and access policies. 1495 

6.6.3 Deployment Phases 1496 

The key to effective PAM solution implementation is to develop and adopt a comprehensive 1497 
deployment plan to align security components in the existing infrastructure with and around the PAM 1498 
efforts. It is recommended that a phased approach be developed to deploy the PAM solution and that 1499 
ensures that short-term and long-term goals can be addressed. It is usually a good practice to develop a 1500 
maintenance structure that can address additional and future implementations as well as operational 1501 
and security requirements. The following key activities should be considered when adopting the 1502 
reference design: 1503 

 Phase 0: Define the business and technical objectives for the PAM deployment. 1504 

 Phase I: initial setup and infrastructure preparation to ensure that all of the resources needed to 1505 
deploy, operate, and maintain the PAM solution are available. This includes identifying and 1506 
documenting privileged users, accounts, critical assets, etc. to management, as well as their 1507 
functions. The results of automated account discovery are often useful in this preparation.  1508 

 Phase II: Deploy the solutions in the reference design to a test set of systems, and tune the 1509 
configuration for the desired performance and feature functionality to ensure that appropriate 1510 
security events can be identified and logged, that privileged account information and functions 1511 
are clearly defined, etc. Measure achievement against the objectives defined in Phase 0; make 1512 
rollout or objective changes as needed. 1513 

 Phase III: broad deployment with use-cases-based testing. It is a good practice to test the 1514 
adopted solution and test, based on use cases. Measure achievement against the objectives 1515 
defined in Phase 0. 1516 

 Phase IV: Evaluate the performance of the reference design, and perform a risk assessment to 1517 
assess performance and to identify any weaknesses that can compromise the overall security 1518 
objectives, based on the identified needs and the defined use case. Measure achievement 1519 
against the objectives defined in Phase 0. 1520 

 Phase V: Manage logs and ensure continuous monitoring. Log management and ongoing events 1521 
tuning can be complicated by a large volume of security data. It is important to create processes 1522 
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and procedures for collecting, storing, and analyzing security logs from multiple sources and to 1523 
prioritize security activities. Integrate with other information security tools in the ecosystem in 1524 
ways that support the achievement of the objectives defined in Phase 0. 1525 

Each of the phases described above should be designed to fit the needs of the organization. 1526 

6.6.4 Policy Recommendations 1527 

 Define the access policies to enforce the principles of least privilege and separation of duties.  1528 

 Configure the monitoring capability with comprehensive analytics to identify anomalous 1529 
situations that can signal a cyber event. Define enterprise-level workflows that include business 1530 
and security rules, to determine each user’s access control authorizations and to ensure that 1531 
enterprise access control policy is enforced as completely and accurately as possible.  1532 

 Develop an attack model to help determine the types of events that should generate alerts. 1533 

 Ensure that the reference design, when adopted, supports flexible data collection. 1534 

 Grant only a few users (e.g., human resource administrators) the authority to modify 1535 
(e.g., initiate, change, delete) employee access information. Require the approval of more than 1536 
one individual to update employee access information. Log all employee access information 1537 
modifications. Define workflows to enforce these requirements. 1538 

 Define applicable doctrine and guidance for feedback processes, monitoring capabilities, and 1539 
expected outcome, and develop alternative operational methods to ensure resiliency. 1540 

7 Functional Evaluation 1541 

A functional evaluation of the PAM example implementation, as constructed in our laboratory, was 1542 
conducted to verify that it meets its objective of demonstrating the ability to manage and control access 1543 
to the myriad privileged accounts across an enterprise. The evaluation verified that the example 1544 
implementation could perform the following functions: 1545 

 enforce privileged-account-access and privileged-account-use policies 1546 

 protect against unauthorized access to, and/or use of, privileged accounts 1547 

Section 7.1 describes the format and components of the functional test cases. Each functional test case 1548 
is designed to assess the capability of the example implementation to perform the functions listed 1549 
above and is detailed in Section 7.1.1. 1550 

7.1 PAM Functional Test Plan 1551 

One aspect of our security evaluation involved assessing how well the reference design addresses the 1552 
security characteristics that it was intended to support. The Cybersecurity Framework subcategories 1553 
were used to provide structure to the security assessment by consulting the specific sections of each 1554 
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standard that are cited in reference to that subcategory. The cited sections provide validation points 1555 
that the example solution is expected to exhibit. Using the Cybersecurity Framework subcategories as a 1556 
basis for organizing our analysis allowed us to systematically consider how well the reference design 1557 
supports the intended security characteristics. 1558 

This plan includes the test cases necessary to conduct the functional evaluation of the PAM example 1559 
implementation, which is currently deployed in a lab at the NCCoE. The implementation tested is 1560 
described in Section 5. 1561 

Each test case consists of multiple fields that collectively identify the goal of the test, the specifics 1562 
required to implement the test, and how to assess the results of the test. Table 7-1 describes each field 1563 
in the test case. 1564 

Table 7-1 Test Case Fields 1565 

Test Case Field Description 

Parent requirement Identifies the top-level requirement, or the series of top-level require-
ments, leading to the testable requirement 

Testable requirement Drives the definition of the remainder of the test case fields, and specifies 
the capability to be evaluated 

Associated security con-
trols 

The NIST SP 800-53 Rev. 4 controls addressed by the test case 

Description Describes the objective of the test case 

Associated test cases In some instances, a test case may be based on the outcome of another 
test case(s). For example, analysis-based test cases produce a result that is 
verifiable through various means (e.g., log entries, reports, alerts). 

Preconditions The starting state of the test case. Preconditions indicate various starting 
state items, such as a specific capability configuration required or specific 
protocol and content. 

Procedure The step-by-step actions required to implement the test case. A procedure 
may consist of a single sequence of steps, or multiple sequences of steps 
(with delineation), to indicate variations in the test procedure. 

Expected results The expected results for each variation in the test procedure 

Actual results The observed results 

Overall result The overall result of the test as pass/fail. In some test case instances, the 
determination of the overall result may be more involved, such as deter-
mining pass/fail based on a percentage of errors identified. 
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7.1.1 PAM Use Case Requirements 1566 

Table 7-2 identifies the PAM functional evaluation requirements that are addressed in the test plan, and 1567 
the associated test cases. 1568 

Table 7-2 PAM Functional Requirements 1569 

Capability 
Requirement 
(CR) ID 

Parent Requirement Subrequirement 1 Test Case 

CR 1 The PAM example implemen-
tation shall enforce access 
and use policies. 

N/A N/A 

CR 1.a N/A Access denied  PAM-1 

CR 1.b N/A Access allowed PAM-1 

CR 2 The PAM example implemen-
tation shall hide passwords 
from users. 

Verify password is not displayed 
to users 

PAM-2 (not ap-
plicable to PAM 
systems utilizing 
privilege escala-
tion) 

CR 3 The PAM example implemen-
tation shall provide replay of 
user actions. 

Replay a user session PAM-3 

CR 4 The PAM example implemen-
tation shall support two-fac-
tor authentication of users.  

N/A N/A 

CR 4.a N/A Verify two-factor authentication 
is operational by using RSA token 
and that it fails without the token 

PAM-4 

CR 4.b N/A Verify two-factor authentication 
is operational by using OneSpan 
(formerly VASCO) token and that 
it fails without the token 

PAM-4 

CR 4.c N/A Verify two-factor authentication 
is operational by using IdRamp 
(Microsoft Authenticator) and 
that it fails without the token 

PAM-4 
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Capability 
Requirement 
(CR) ID 

Parent Requirement Subrequirement 1 Test Case 

CR 5 The PAM example implemen-
tation shall log activity, in-
cluding failed login attempts. 

N/A N/A 

CR 5.a N/A Verify logs are collected by the se-
curity monitoring system 

PAM-5 

CR 5.b N/A Alert is generated for failed login 
attempt  

PAM-5 

CR 6 The PAM example implemen-
tation shall include the capa-
bility to change account pass-
words automatically. 

N/A N/A 

CR 6.a N/A Password change policy can be 
set to change the password auto-
matically for an account 

PAM-6 

CR 6.b N/A Password changes after each ses-
sion 

PAM-6 

CR 7 The PAM example implemen-
tation shall include an emer-
gency access (also called 
break glass) capability. 

Use of the emergency access al-
lows access to any privileged ac-
count within policy 

PAM-7 

CR 8 The PAM example implemen-
tation shall include auto-
mated privileged account dis-
covery. 

Verify that accounts known to be 
privileged are discovered and re-
ported 

PAM-8 

7.1.2 Test Case: PAM-1 1570 

Table 7-3 describes each field in the PAM-1 test case. 1571 

Table 7-3 Test Case ID: PAM-1 1572 

Parent Requirement (CR 1) The PAM example implementation shall enforce access poli-
cies and use policies. 

Testable Requirement 
(CR 1.a) Access denied 
(CR 1.b) Access allowed 

Description Show that the PAM solution can enforce access and use policies 
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Associated Test Cases N/A 
Associated Cybersecurity 
Framework Subcategories 

ID.AM-6, ID.GV-1, ID.GV.2, ID.GV-4, PR.AC-4, PR.PT-3  

Preconditions 
Access policies and user accounts are configured with the policy man-
agement system. The systems to be managed/administered are con-
figured and operational.  

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the PAM system user interface. 
2. Identify a system (A) known to be unavailable (access outside 

policy) to the PAM user. 
3. Identify a system (B) known to be available (access within policy) 

to the PAM user. 
4. Request access to System A. (In some PAM systems, these sys-

tems may not be an option.) 
5. Request access to System B. 
6. Attempt to perform a common action on System A if access is al-

lowed. 
7. Attempt to perform a common action on System B if access is al-

lowed. 

Expected Results (Pass) 
Access is denied to System A (CR 1.a). 
Access is allowed to System B (CR 1.b). 

Actual Results 

PAM Build 1 results: 
 CR 1.a – Access is denied to System A. 
 CR 1.b – Access is allowed to System B. 

PAM Build 2 results: 
 CR 1.a – Access is denied to System A. 
 CR 1.b – Access is allowed to System B. 

PAM Build 3 results: 
 CR 1.a – Access is denied to System A. 
 CR 1.b – Access is allowed to System B. 

Overall Result Pass 
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7.1.3 Test Case: PAM-2 1573 

Table 7-4 describes each field in the PAM-2 test case. 1574 

Table 7-4 Test Case ID: PAM-2 1575 

Parent Requirement (CR 2) The PAM example implementation shall hide passwords from 
users. 

Testable Requirement (CR 2) Verify password is not displayed to users 

Description Show that the PAM solution can hide passwords from users 

Associated test cases PAM-1 
Associated Cybersecurity 
Framework Ssubcategories 

ID.AM-3, ID.GV-4, PR.AC-1, PR.PT-4 

Preconditions The systems are established as configured for CR 1. 

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the PAM system user interface. 
2. Identify a system (B) known to be available (access within policy) 

to the PAM user. 
3. Request access to System B. 
4. Attempt to perform a common action on System B if access is al-

lowed. 

Expected Results (Pass) The password used for authentication to System B is used and is not 
displayed to the PAM user (CR 2). 

Actual Results 

PAM Build 1 results: 
 CR 2 – The password used for authentication to System B is used 

and is not displayed to the PAM user. 
PAM Build 2 results: 
 CR 2 – The password used for authentication to System B is used 

and is not displayed to the PAM user. 
PAM Build 3 results: 
 CR 2 – The password used for authentication to System B is used 

and is not displayed to the PAM user. 

Overall Result Pass 
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7.1.4 Test Case: PAM-3 1576 

Table 7-5 describes each field in the PAM-3 test case. 1577 

Table 7-5 Test Case ID: PAM-3 1578 

Parent Requirement (CR 3) The PAM example implementation shall provide session re-
play capabilities. 

Testable Requirement (CR 3) Replay a user session 

Description Show that the PAM solution can provide session replay functionality 
for use in training or forensic activities 

Associated Test Cases PAM-2 
Associated Cybersecurity 
Subcategories 

PR.PT-1, RS.AN-3 

Preconditions This test can be run after CR 1 or CR 2. 

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the PAM system user interface. 
2. Request replay of a session known to have occurred. Any ses-

sion established in CR 1 or CR 2 is sufficient. 
3. Replay the session. 

Expected Results (Pass) 
The session replay is successful (CR 3). 
The details of the activity during the session are replayed (CR 3). 

Actual Results 

PAM Build 1 results: 
 CR 3 – The session replay is successful. The details of the activity 

during the session are replayed. 
PAM Build 2 results: 
 CR 3 – The session replay is successful. The details of the activity 

during the session are replayed. 
PAM Build 3 results: 
 CR 3 – The session replay is successful. The details of the activity 

during the session are replayed. 

Overall Result Pass 
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7.1.5 Test Case: PAM-4 1579 

Table 7-6 describes each field in the PAM-4 test case. 1580 

Table 7-6 Test Case ID: PAM-4 1581 

Parent Requirement (CR 4) The PAM example implementation shall support two-factor 
authentication. 

Testable Requirement 

(CR 4.a) Two-factor authentication is operational using a RSA token 
(CR 4.b) Two-factor authentication is operational using the OneSpan 
token mobile solution 
(CR 4.c) Two-factor authentication is operational using the IdRamp 
(Microsoft Authenticator) mobile solution 

Description Show that the PAM solution can enforce the use of MFA 

Associated Test Cases PAM-2 
Associated Cybersecurity 
Framework Subcategories 

ID.GV-4, PR.AC-1, PR.PT-3 

Preconditions This test can be run after CR 1 or CR 2.  

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the PAM system user interface. 
2. Log into the PAM system (two-factor authentication must be en-

abled). 
3. Log in by using the correct second factor. 
4. Attempt login with an incorrect second factor. 

Expected Results (Pass) 
Two-factor authentication is operational (CR 4.a, CR 4.b, CR 4.c). 
Login is prevented without a proper second factor (CR 4.a, CR 4.b, 
CR 4.c). 

Actual Results 

PAM Build 1 results: 
 CR 4.a, CR 4.b, CR 4.c – Two-factor authentication is operational. 

Login is prevented without a proper second factor. 
PAM Build 2 results: 
 CR 4.a, CR 4.b, CR 4.c – Two-factor authentication is operational. 

Login is prevented without a proper second factor. 
PAM Build 3 results: 
 CR 4.a, CR 4.b, CR 4.c – Two-factor authentication is operational. 

Login is prevented without a proper second factor. 

Overall Result Pass 
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7.1.6 Test Case: PAM-5 1582 

Table 7-7 describes each field in the PAM-5 test case. 1583 

Table 7-7 Test Case ID: PAM-5 1584 

Parent Requirement (CR 5) The PAM example implementation shall log activity, including 
failed login attempts. 

Testable Requirement 
(CR 5.a) Verify logs are collected by the security monitoring system 
(CR 5.b) Alert is generated for failed login attempts 

Description Show that the PAM solution can record event logs and integrates with 
the security monitoring system (both normal and anomalous events) 

Associated Test Cases PAM-4 
Associated Cybersecurity 
Framework Subcategories 

DE.AE-2, DE.AE-3, DE.AE-5, DE.CM-3, DE.CM-7, RS.CO-2 

Preconditions CR 4  

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the security monitoring system. 
2. View collected logs. 
3. Set up alerts for anomalous events that need to be identified. 

Expected Results (Pass) 

The security monitoring system records events for each component 
(CR 5.a). 
The security monitoring system provides alerts when a predefined 
anomalous activity is detected (failed login attempt) (CR 5.b). 

Actual Results 

PAM Build 1 results: 
 CR 5.a – The security monitoring system records events for each 

component. 
 CR 5.b – The security monitoring system provides alerts when a 

predefined anomalous activity is detected (failed login attempt). 
PAM Build 2 results: 
 CR 5.a – The security monitoring system records events for each 

component. 
 CR 5.b – The security monitoring system provides alerts when a 

predefined anomalous activity is detected (failed login attempt). 
PAM Build 3 results: 
 CR 5.a – The security monitoring system records events for each 

component. 
 CR 5.b – The security monitoring system provides alerts when a 

predefined anomalous activity is detected (failed login attempt). 
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Overall Result Pass 

7.1.7 Test Case: PAM-6 1585 

Table 7-8 describes each field in the PAM-6 test case. 1586 

Table 7-8 Test Case ID: PAM-6 1587 

Parent Requirement (CR 6) The PAM example implementation shall include the capabil-
ity to change account passwords automatically. 

Testable Requirement 
(CR 6.a) Password change policy can be set to change the password 
automatically for an account 
(CR 6.b) Password changes after each session 

Description Show that the PAM solution can be configured to automatically 
change account passwords 

Associated Test Cases PAM-1 
Associated Cybersecurity 
Framework Subcategories 

ID.GV-4, PR.AC-1, PR.PT-3 

Preconditions CR 4: The packet capture is set up to capture the login username and 
password from the PAM system. 

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the PAM policy management system. 
2. Create a password change policy to change the password after 

each session. 
3. Access the PAM system user interface. 
4. Identify a system (B) known to be available (access within pol-

icy) to the PAM user. 
5. Activate the packet capture for the sessions with System B. 
6. Request access to System B. 
7. Attempt to perform a common action on System B if access is 

allowed. 
8. Close the session. 
9. Request access to System B (second time). 
10. Close the session. 

Expected Results (Pass) 
The PAM password management system can be configured to change 
passwords after each session (CR 6.a). 
Passwords are changed after each session (CR 6.b). 
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Actual Results 

PAM Build 1 results: 
 CR 6.a – The PAM password management system can be config-

ured to change passwords after each session. 
 CR 6.b – Passwords are changed after each session. 

PAM Build 2 results: 
 CR 6.a – The PAM password management system can be config-

ured to change passwords after each session. 
 CR 6.b – Passwords are changed after each session. 

PAM Build 3 results: 
 CR 6.a – The PAM password management system can be config-

ured to change passwords after each session. 
 CR 6.b – Passwords are changed after each session. 

Overall Result Pass 

7.1.8 Test Case: PAM-7 1588 

Table 7-9 describes each field in the PAM-7 test case. 1589 

Table 7-9 Test Case ID: PAM-7 1590 

Parent Requirement (CR 7) The PAM example implementation shall include an emer-
gency access (also called break glass) capability. 

Testable Requirement (CR 7) Use of the emergency access allows access to any privileged 
account within policy 

Description Show that the PAM solution can provide emergency access to any 
privileged account within policy 

Associated Test Cases PAM-2 
Associated Cybersecurity 
Framework Subcategories 

ID.BE-4 

Preconditions This test can be run after CR 1 or CR 2.  

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the PAM system user interface. 
2. Request an emergency session using a predefined emergency 

credential. 
3. Request access to System B. 
4. Attempt to perform a common action on System B if access is 

allowed. 
5. Close the emergency session. 
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6. Request an emergency session using an incorrect emergency 
credential. 

7. Request access to System B. 
8. Attempt to perform a common action on System B if access is 

allowed. 

Expected Results (Pass) 

Emergency access using the predefined emergency credential results 
in access to the desired system (B) (CR 7). 
Emergency access without the predefined emergency credential re-
sults in no access allowed (CR 7). 

Actual Results 

PAM Build 1 results: 
 CR 7 – Emergency access using the predefined emergency cre-

dential results in access to the desired system (B). Emergency 
access without the predefined emergency credential results in 
no access allowed. 

PAM Build 2 results: 
 CR 7 – Emergency access using the predefined emergency cre-

dential results in access to the desired system (B). Emergency 
access without the predefined emergency credential results in 
no access allowed. 

PAM Build 3 results: 
 CR 7 – Emergency access using the predefined emergency cre-

dential results in access to the desired system (B). Emergency 
access without the predefined emergency credential results in 
no access allowed. 

Overall Result Pass 

7.1.9 Test Case: PAM-8 1591 

Table 7-10 describes each field in the PAM-8 test case. 1592 

Table 7-10 Test Case ID: PAM-8 1593 

Parent Requirement (CR 8) The PAM example implementation shall include automated 
privileged account discovery. 

Testable Requirement (CR 8) Verify that accounts known to be privileged are discovered and 
reported 

Description Show that the PAM solution can automatically discover privileged ac-
counts 

Associated Test Cases PAM-2 
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Associated Cybersecurity 
Framework Subcategories 

PR.AC-1, DE-AE-2, RS.CO-2 

Preconditions This test can be run after CR 1 or CR 2.  

Procedure 

Perform the following procedures on each PAM build instance: 
1. Access the PAM system user interface. 
2. Request an automated privileged account discovery process for 

a selected directory. 
3. Review the results of the process. 
4. Add a privileged account to a directory. 
5. Request an automated privileged account discovery process for 

the selected directory. 
6. Review the results of the process. 

Expected Results (Pass) Automated privileged account discovery should identify the newly 
created account (CR 8). 

Actual Results 

PAM Build 1 results: 
 CR 8 – Automated privileged account discovery should identify 

the newly created account. 
PAM Build 2 results: 
 CR 8 – Automated privileged account discovery should identify 

the newly created account. 
PAM Build 3 results: 
 CR 8 – Automated privileged account discovery should identify 

the newly created account. 

Overall Result Pass 
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Appendix A List of Acronyms 
API Application Programming Interface 

ATT&CK Adversarial Tactics, Techniques, and Common Knowledge 

CAT Cybersecurity Assessment Tool 

COI Community of Interest 

CR Capability Requirement 

DE Detect 

FFIEC Federal Financial Institutions Examination Council 

FID Federated Identity 

FIPS Federal Information Processing Standards 

IaaS Infrastructure as a Service 

ID Identify 

IdAM Identity and Access Management 

IEC International Electrotechnical Commission 

IP Internet Protocol 

ISO International Organization for Standardization 

IT Information Technology 

LDAP Lightweight Directory Access Protocol 

LDAPS Lightweight Directory Access Protocol over SSL 

MFA Multifactor Authentication 

N/A Not Applicable 

NCCoE National Cybersecurity Center of Excellence 

NICE National Initiative for Cybersecurity Education 

NIST National Institute of Standards and Technology 

OMB Office of Management and Budget 

OS Operating System 
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PaaS Platform as a Service 

PAM Privileged Account Management 

PR Protect 

RDP Remote Desktop Protocol 

RS Respond 

SaaS Software as a Service 

SAML Security Assertion Markup Language 

SIEM Security Information and Event Management 

SP Special Publication 

SQL Structured Query Language 

SSH Secure Shell 

SSL Secure Sockets Layer 

Syslog System Log 

TLS Transport Layer Security 

UBA User Behavior Analytics 
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DISCLAIMER 

Certain commercial entities, equipment, products, or materials may be identified in this document in 

order to describe an experimental procedure or concept adequately. Such identification is not intended 

to imply recommendation or endorsement by NIST or NCCoE, nor is it intended to imply that the 

entities, equipment, products, or materials are necessarily the best available for the purpose. 
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You can improve this guide by contributing feedback. As you review and adopt this solution for your 

own organization, we ask you and your colleagues to share your experience and advice with us.  

Comments on this publication may be submitted to: financial_nccoe@nist.gov. 

Public comment period: September 28, 2018 through November 30, 2018 

All comments are subject to release under the Freedom of Information Act (FOIA). 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 

and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 

academic institutions work together to address businesses’ most pressing cybersecurity issues. This 

public-private partnership enables the creation of practical cybersecurity solutions for specific 

industries, as well as for broad, cross-sector technology challenges. Through consortia under 

Cooperative Research and Development Agreements (CRADAs), including technology partners—from 

Fortune 50 market leaders to smaller companies specializing in information technology (IT) security—

the NCCoE applies standards and best practices to develop modular, easily adaptable example 

cybersecurity solutions using commercially available technology. The NCCoE documents these example 

solutions in the NIST Special Publication 1800 series, which maps capabilities to the NIST Cyber Security 

Framework and details the steps needed for another entity to recreate the example solution. The NCCoE 

was established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 

Md. 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 

https://www.nist.gov. 

NIST CYBERSECURITY PRACTICE GUIDES 

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 

challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 

adoption of standards-based approaches to cybersecurity. They show members of the information 

security community how to implement example solutions that help them align more easily with relevant 

standards and best practices, and provide users with the materials lists, configuration files, and other 

information they need to implement a similar approach. 

The documents in this series describe example implementations of cybersecurity practices that 

businesses and other organizations may voluntarily adopt. These documents do not describe regulations 

or mandatory practices, nor do they carry statutory authority.  

ABSTRACT 

Privileged account management (PAM) is a domain within identity and access management (IdAM) that 

focuses on monitoring and controlling the use of privileged accounts. Privileged accounts include local 

and domain administrative accounts, emergency accounts, application management, and service 

accounts. These powerful accounts provide elevated, often nonrestricted, access to the underlying IT 

resources and technology, which is why external and internal malicious actors seek to gain access to 

them. Hence, it is critical to monitor, audit, control, and manage privileged account usage. Many 

organizations, including financial sector companies, face challenges in managing privileged accounts.  

https://www.nccoe.nist.gov/
https://www.nist.gov/
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The goal of this project is to demonstrate a PAM capability that effectively protects, monitors, and 

manages privileged account access, including life-cycle management, authentication, authorization, 

auditing, and access controls. 

KEYWORDS 

Access control, auditing, authentication, authorization, life-cycle management, multifactor 

authentication, PAM, privileged account management, provisioning management  
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1 Introduction 104 

The following volumes of this guide show information technology (IT) professionals and security 105 

engineers how we implemented this example solution. We cover all of the products employed in this 106 

reference design. We do not recreate the product manufacturers’ documentation, which is presumed to 107 

be widely available. Rather, these volumes show how we incorporated the products together in our 108 

environment. 109 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 110 

for these products that are out of scope for this reference design. 111 

1.1 Practice Guide Structure 112 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 113 

standards-based reference design and provides users with the information they need to replicate the 114 

privileged account management (PAM) example solution. This reference design is modular and can be 115 

deployed in whole or in part. 116 

This guide contains three volumes: 117 

▪ NIST Special Publication (SP) 1800-18A: Executive Summary 118 

▪ NIST SP 1800-18B: Approach, Architecture, and Security Characteristics – what we built and why 119 

▪ NIST SP 1800-18C: How-To Guides – instructions for building the example solution (you are 120 
here) 121 

Depending on your role in your organization, you might use this guide in different ways: 122 

Business decision makers, including chief security and technology officers, will be interested in the 123 

Executive Summary, NIST SP 1800-18A, which describes the following topics: 124 

▪ challenges enterprises face in managing privileged accounts 125 

▪ example solution built at the National Cybersecurity Center of Excellence (NCCoE) 126 

▪ benefits of adopting the example solution 127 

Technology or security program managers who are concerned with how to identify, understand, assess, 128 

and mitigate risk will be interested in NIST SP 1800-18B, which describes what we did and why. The 129 

following sections will be of particular interest: 130 

▪ Section 3.4, Risk, provides a description of the risk analysis we performed 131 

▪ Section 3.4.2, Security Control Map, maps the security characteristics of this example solution to 132 
cybersecurity standards and best practices 133 
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You might share the Executive Summary, NIST SP 1800-18A, with your leadership team members to help 134 

them understand the importance of adopting standards-based PAM. 135 

IT professionals who want to implement an approach like this will find this whole practice guide useful. 136 

You can use this How-To portion of the guide, NIST SP 1800-18C, to replicate all or parts of the build 137 

created in our lab. This How-To portion of the guide provides specific product installation, configuration, 138 

and integration instructions for implementing the example solution. We do not recreate the product 139 

manufacturers’ documentation, which is generally widely available. Rather, we show how we 140 

incorporated the products together in our environment to create an example solution. 141 

This guide assumes that IT professionals have experience implementing security products within the 142 

enterprise. While we have used a suite of commercial products to address this challenge, this guide does 143 

not endorse these particular products. Your organization can adopt this solution or one that adheres to 144 

these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 145 

parts of a PAM system to manage and monitor the use of privileged accounts. Your organization’s 146 

security experts should identify the products that will best integrate with your existing tools and IT 147 

system infrastructure. We hope that you will seek products that are congruent with applicable standards 148 

and best practices. Section 3.6, Technologies, of Volume B lists the products that we used and maps 149 

them to the cybersecurity controls provided by this reference solution. 150 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 151 

draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 152 

success stories will improve subsequent versions of this guide. Please contribute your thoughts to 153 

financial_nccoe@nist.gov. 154 

1.2 Build Overview 155 

The NCCoE built a hybrid virtual-physical laboratory environment to explore methods to effectively 156 

manage and monitor the authorized use of privileged accounts and to explore techniques to protect 157 

against and detect the unauthorized use of these accounts. The NCCoE also explored the issues of 158 

auditing and reporting that IT systems use to support incident recovery and investigations. The servers 159 

in the virtual environment were built to the hardware specifications of their specific software 160 

components. 161 

The NCCoE worked with members of the Financial Sector Community of Interest to develop a diverse 162 

(but noncomprehensive) set of use-case scenarios against which to test the reference implementation. 163 

These use-case scenarios are detailed in Volume B, Section 5.5. For a detailed description of our 164 

architecture, see Volume B, Section 4. 165 

mailto:financial_nccoe@nist.gov
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1.3 Typographic Conventions 166 

The following table presents typographic conventions used in this volume. 167 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For detailed definitions of terms, see 
the NCCoE Glossary. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
on-screen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

2 Product Installation Guides 168 

This section of the practice guide contains detailed instructions for installing and configuring all of the 169 

products used to build an instance of the example solution. 170 

2.1 Microsoft Active Directory 171 

2.1.1 How It’s Used 172 

Microsoft Active Directory (AD) serves as the privileged account identity repository, the Domain Name 173 

System (DNS) server, and the certificate authority (CA). 174 

2.1.2 Virtual Machine Configuration 175 

The Microsoft AD virtual machine is configured as follows: 176 

▪ 4 central processing unit (CPU) cores 177 

▪ 16 gigabytes (GB) of random-access memory (RAM) 178 

https://www.nccoe.nist.gov/
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▪ 120 GB hard disk drive (HDD) 179 

▪ 1 network adapter 180 

Network Configuration (Interface 1): 181 

▪ Internet protocol version 4 (IPv4): manual 182 

▪ Internet protocol version 6 (IPv6): disabled 183 

▪ Internet protocol (IP) address: 172.16.3.10 184 

▪ Netmask: 255.255.255.0 185 

▪ Gateway: 172.16.3.1 186 

▪ DNS name servers: 172.16.3.10 187 

▪ DNS-search domains: AcmeFinancial.com 188 

2.1.3 Installation 189 

Install the AD domain services and CA according to the instructions provided at the following links: 190 

https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-directory-191 

domain-services--level-100- 192 

https://docs.microsoft.com/en-us/windows-server/networking/core-network-guide/cncg/server-193 

certs/install-the-certification-authority 194 

2.1.4 DNS Configuration 195 

1. Create the host records and reverse entries in the AcmeFinancial.com DNS service for the 196 

following servers: 197 

a. Bomgar Privileged Identity 198 

b. TDi ConsoleWorks 199 

c. Splunk Enterprise 200 

d. Radiant Logic Federated Identity (FID) 201 

e. Ekran System 202 

f. Remediant SecureONE 203 

g. RSA Authentication Manager 204 

h. OneSpan IDENTIKEY 205 

https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-directory-domain-services--level-100-
https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-directory-domain-services--level-100-
https://docs.microsoft.com/en-us/windows-server/networking/core-network-guide/cncg/server-certs/install-the-certification-authority
https://docs.microsoft.com/en-us/windows-server/networking/core-network-guide/cncg/server-certs/install-the-certification-authority
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2.1.5 Group Policy Object Configuration 206 

1. Open Group Policy Management. 207 

2. Under the Default Domain Policy, make the following changes under Computer Configuration > 208 

Policies > Windows Settings > Security Settings > Advanced Audit Configuration: 209 

 210 

2.1.6 Scripts 211 

The following scripts were created to easily import and correlate data once forwarded to Splunk 212 

Enterprise. 213 

The following Python script parses data extracted from the Windows security event log. The script is 214 

located at c:\. 215 

import csv 216 

import re 217 

from subprocess import check_output 218 
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csvfile = open('Final_AD.csv', 'w+') 219 

wr = csv.writer(csvfile, quoting=csv.QUOTE_ALL) 220 

csvlist = ["Event", "UserSubject", "UserObject", "Timestamp"] 221 

wr.writerow(csvlist) 222 

with open('ADLOG.csv', 'r') as f: 223 

 reader = csv.reader(f) 224 

 zerothrow = 1 225 

 for row in reader: 226 

  csvlist = [] 227 

  if zerothrow == 1: 228 

   zerothrow = 0  229 

  else: 230 

   parse_list =  row[1].split('\n') 231 

   #print parse_list 232 

   #break    233 

csvlist.append(parse_list[0].replace('\t', '').replace('\r', '')) 234 

csvlist.append(parse_list[4].replace('\t', '').replace('\r', 235 
'').replace('Account Name:', '')) 236 

if row[4] == "4728": 237 

win_command = parse_list[10].replace('\t', '').replace('\r', 238 
'').replace('Account Name:', '') 239 

win_command = win_command[:3] + '"' + win_command[3:] 240 

sec_index = win_command.index(",CN=") 241 

win_command = win_command[:sec_index] + '"' + 242 
win_command[sec_index:] 243 

win_command = "dsquery * " + win_command + " -scope base -attr 244 
sAMAccountName" 245 

account = check_output(win_command, shell  = True).decode() 246 

account = account.replace('sAMAccountName', '').replace('\n', 247 
'').replace(' ', '') 248 

csvlist.append(account) 249 

else: 250 
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   csvlist.append(parse_list[10].replace('\t', '').replace('\r', 251 
'').replace('Account Name:', '')) 252 

   csvlist.append(row[2].replace('\t', '').replace('\r', '')) 253 

   wr.writerow(csvlist) 254 

#temp = check_output("dir C:", shell=True).decode() 255 

#print(temp) 256 

csvfile.close() 257 

The following PowerShell script extracts data from the Windows security event log and executes the 258 

Python script above: 259 

Set-Variable -Name EventAgeDays -Value 2     #we will take events for the latest 2 days 260 

Set-Variable -Name Computer -Value "AD-Production"   # replace it with your server 261 
names 262 

Set-Variable -Name LogNames -Value "Security"  # Checking app and system logs 263 

Set-Variable -Name EventTypes -Value @(7001, 7002, 4720, 4722, 4725, 4726, 4728, 4738)   264 

# Loading only Errors and Warnings 265 

Set-Variable -Name ExportFolder -Value "C:\" 266 

$el_c = @()   #consolidated error log 267 

$now=get-date 268 

$startdate=$now.adddays(-$EventAgeDays) 269 

$ExportFile=$ExportFolder + "ADLOG.csv"  # we cannot use standard delimiteds like ":" 270 

Write-Host Processing $Computer\$LogNames 271 

$el = get-eventlog -ComputerName $Computer -log $Lognames -After $startdate -272 
InstanceId $EventTypes 273 

$el_c += $el  #consolidating 274 

$el_sorted = $el_c | Sort-Object TimeGenerated    #sort by time 275 

Write-Host Exporting to $ExportFile 276 

$el_sorted|Select EntryType, Message, TimeGenerated, Source, EventID, MachineName | 277 
Export-CSV $ExportFile -NoTypeInfo  #EXPORT 278 

Write-Host Done! 279 

python adparse.py 280 
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2.1.7 Splunk Universal Forwarder 281 

Install Splunk Universal Forwarder by following the instructions provided at 282 

http://docs.splunk.com/Documentation/Forwarder/7.1.3/Forwarder/Abouttheuniversalforwarder. 283 

Edit the inputs.conf file to monitor the Final_AD.csv file created from the Python script above and to 284 

forward logs to the demo index at Splunk Enterprise. 285 

 286 

2.2 Bomgar Privileged Identity 287 

Bomgar Privileged Identity is a PAM solution that manages account passwords in Microsoft AD. 288 

2.2.1 How It’s Used 289 

Privileged Identity is used as a PAM provider in the example implementation. It provides a web 290 

application server that users log into with unprivileged accounts. These users are then allowed to launch 291 

applications as privileged users, based on the policy and configuration in Privileged Identity. 292 

2.2.2 Virtual Machine Configuration 293 

The Privileged Identity virtual machine is configured as follows: 294 

▪ Windows Server 2012 R2 295 

▪ 4 CPU cores 296 

▪ 16 GB of RAM 297 

▪ 60 GB of storage 298 

▪ 1 network interface controller/card (NIC) 299 

http://docs.splunk.com/Documentation/Forwarder/7.1.3/Forwarder/Abouttheuniversalforwarder
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Network Configuration (Interface 1): 300 

▪ IPv4: manual 301 

▪ IPv6: disabled 302 

▪ IPv4 address: 172.16.1.10 303 

▪ Netmask: 255.255.255.0 304 

▪ Gateway: 172.16.1.1 305 

▪ DNS name servers: 172.16.3.10 306 

▪ DNS-search domains: not applicable (N/A) 307 

2.2.3 Prerequisites 308 

▪ Before Privileged Identity can be installed, Microsoft Structured Query Language (SQL) Server 309 
must be installed. In a test environment, Microsoft SQL Server Express also is acceptable. 310 

▪ The web application server’s requirements include Internet Information Services (IIS) and 311 
Microsoft .NET Framework 4.5.2 or later. 312 

▪ A full list of requirements can be found in the Installation Guide on Bomgar’s website. 313 

2.2.4 Installing Privileged Identity 314 

To configure IIS for use with Bomgar’s web application server, a certificate signed by AD Certificate 315 

Services was created. 316 

1. Open Server Manager. 317 

2. Click Tools > Internet Information Services (IIS) Manager. 318 

3. Click on the name of the server (in this case, Bomgar-PI), and select Server Certificates. 319 

https://www.bomgar.com/docs/privileged-identity/documents/privileged-identity-installation-guide-5-5-3-1.pdf
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 320 

4. On the right, click Create Certificate Request. 321 

5. Fill out the Distinguished Name Properties, and then click Next. 322 

6. Select a bit length of 2048, and then click Next. 323 

7. Give the certificate a file name, and then click Finish. 324 

8. Using the certreq command in the Command Prompt, enter certreq -attrib 325 

“CertificateTemplate:WebServer”. 326 

9. Select the certificate file that was created in Step 7, and then click Open. 327 
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 328 

10. Choose the Domain Controller CA from the Certification Authority List, and then click OK. 329 



DRAFT 

 
NIST SP 1800-18C: Privileged Account Management for the Financial Services Sector 12 

 330 

11. Go back to the IIS Manager, and click Bomgar-PI. Select Server Certificates. 331 

12. On the right, click Complete Certificate Request. 332 

13. Fill out the pop-up window with the signed-certificate file name and a friendly name (e.g., 333 

Bomgar-PI), and store it in the Personal certificate store. 334 

 335 
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14. Click OK 336 

15. Create a Secure Sockets Layer (SSL) binding with that certificate by following documentation 337 

from Microsoft. 338 

You are now ready to begin following further installation instructions that are publicly available on 339 

Bomgar’s website. 340 

2.2.5 Configuration 341 

Using the Bomgar Privileged Identity Admin Guide, complete the configuration steps provided in the 342 

following subsections. 343 

2.2.5.1 Management Set 344 

1. Create a new management set for the AD domain. 345 

2. Configure the management set to include systems by querying AD. 346 

3. Configure the management set to scan for the target type by scanning for a Secure Shell (SSH) 347 

server. Set the default to Windows if there is no match. 348 

https://docs.microsoft.com/en-us/iis/manage/configuring-security/how-to-set-up-ssl-on-iis
https://docs.microsoft.com/en-us/iis/manage/configuring-security/how-to-set-up-ssl-on-iis
https://www.bomgar.com/docs/privileged-identity/documents/privileged-identity-installation-guide-5-5-3-1.pdf
https://www.bomgar.com/docs/privileged-identity/documents/privileged-identity-admin-guide-5-5-3-1.pdf
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 349 

4. Configure the management set to have a second inclusion from a Static list of targets, and 350 

include the domain name (AcmeFinancial.com). Manually set the target type to Windows. 351 

5. Set the management set to update dynamically each day. 352 
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 353 

2.2.5.2 Delegation Identities 354 

To allow a user to have access to the web console, a Delegation Identity must be created for that user. 355 

Add the following users as Delegation Identities by following the steps provided below: 356 

1. Add the following regular user accounts as Delegation Identities by selecting Delegation > 357 

Delegation Identities and then clicking Add. 358 

a. ACMEFINANCIAL\udb1 359 
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b. ACMEFINANCIAL\twitteruser 360 

2. For the Role Type, select Windows Domain User, and then enter the username in the field next 361 

to it. 362 

3. Click OK. 363 

2.2.6 Installing Privileged Identity Application Launcher 364 

To allow users to proxy connections as privileged users, the Privileged Identity application launcher must 365 

be installed on another server. Detailed prerequisite and installation instructions are available on 366 

Bomgar’s website. 367 

Using the Bomgar documentation, complete the following steps: 368 

1. Create a new virtual machine: 369 

a. Windows Server 2012 R2 370 

b. 1 CPU core 371 

c. 4 GB of RAM 372 

d. 60 GB of storage 373 

e. 1 NIC 374 

i. IPv4: manual 375 

ii. IPv6: disabled 376 

iii. IPv4 address: 172.16.1.31 377 

iv. Netmask: 255.255.255.0 378 

v. Gateway: 172.16.1.1 379 

vi. DNS-search domains: N/A 380 

2. Install Remote Desktop Services. 381 

3. DO NOT install Desktop Experience. 382 

4. Install Application Launcher without Session Recording. 383 

5. Configure Remote Desktop Services to publish LiebsoftLauncher.exe and ssms.exe. 384 

6. Configure the web launcher settings in the Bomgar RED Identity Management Console. 385 

https://www.bomgar.com/docs/privileged-identity/documents/privileged-identity-app-launcher-and-recording.pdf
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2.2.7 Configure Bomgar Privileged Identity with IdRamp SAML Authentication 386 

Use the following steps to configure the Security Assertion Markup Language (SAML) authentication for 387 

the Bomgar Privileged Identity Manager, using IdRamp as an identity provider and broker to Azure AD. 388 

1. Open the Bomgar RED Identity Management Console desktop application. 389 

2. Navigate to Delegation > Web Application Global Delegation Permissions. 390 

 391 

3. Click Add at the lower left corner. 392 

4. Select Role-Based Mapping, enter a friendly name in the field, and then click OK. 393 
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 394 

5. Select the role that you just created, and then click Assign Role. 395 

6. In the SAML Username field, enter the identities or usernames of the users to whom you would 396 

like to assign this role. Click Add after each username that you enter. 397 

 398 

7. Click OK. 399 

8. Make sure that the role that you created is selected, and then select the Logon and Grant All 400 

Access check boxes. 401 
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 402 

9. Click OK. 403 

10. To log onto the Bomgar Privileged Identity Manager by using SAML authentication, navigate 404 

your web browser to https://<serverhostname>/PWCWeb/. 405 

11. Select SAML authentication on the login page, click Login, and then follow the authentication 406 

prompts. 407 

 408 
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2.2.8 Configuring Microsoft SQL Server Access 409 

Prerequisites: 410 

▪ Microsoft SQL Server has hybrid authentication. 411 

▪ Microsoft SQL Server Management Studio (SSMS) has already been added as an application in 412 
the application launcher. 413 

The following instructions configure Bomgar Privileged Identity to allow the udb1 to request permission 414 

to launch Microsoft SSMS and to log in as the sa account on Microsoft SQL Server in the production 415 

environment. 416 

1. Open the Bomgar RED Identity Management Console on Bomgar-PI. Right-click SQL Server 417 

Instances, and then select Add SQL Server Instance. 418 

 419 
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2. Fill out the SQL Server Instance Settings. Enter the host name of the SQL Server in the System 420 

Name field. Populate the Login Account Name and Login Account Password fields with the 421 

username and password of the sa account. Note: This will work only if hybrid authentication is 422 

enabled on the SQL Server. 423 

 424 

3. Click Test Connection. The connection should be successful. Click OK. 425 

4. Expand SQL Server Instances by clicking on the plus sign to the left of the item name, and then 426 

expand SQL-SERVER.ACMEFINANCIAL.COM. Right-click the sa account, and then select Change 427 

Password. 428 
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 429 

5. Select strong password policy options, such as increasing both the length of the password and 430 

its compliance with password standards. 431 

6. On the Schedule tab, set the Job Scheduling Period to Immediately, and write a Job Comment 432 

to describe why this action is being taken. 433 

7. Click OK, and then let the operation complete. 434 

8. Click Delegation > Web Application Identity to Shadow Account Mappings. 435 
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 436 

9. Click Add Mapping. 437 
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 438 

10. Choose the ACMEFINANCIAL\udb1 account, and then click OK. Choose the sa account from the 439 

list on the next screen, and then click OK. 440 

 441 

11. Click OK again. 442 
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12. Click Delegation > Web Application Per-Account Permissions. 443 

 444 

13. Right-click the sa account, and then select Edit Managers for Account. 445 
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 446 

14. Click Add Identity to List. 447 
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 448 

15. Select the ACMEFINANCIAL\udb1 account. You should see it appear in the list. Click OK. 449 

 450 
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16. Expand the sa account by clicking the plus sign to the left, right-click the ACMEFINANCIAL\udb1 451 

account, and then select Edit Permissions of Manager. 452 

 453 

17. Give the account the View Account and Request Remote Access permissions. Click OK. Click OK 454 

again to exit the Web Application Per-Account Permissions window. 455 

18. Click Delegation > Web Application Remote Application Permissions. 456 
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 457 

19. Click Add. 458 
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 459 

20. Select the ACMEFINANCIAL\udb1 account from the list of Delegation Identities. Click OK. Next, 460 

select SQL Server Management Studio from the list of Remote Applications.  461 
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 462 

21. Select Yes for the pop-up about Shadow Account Restriction. 463 
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22. Select the ACMEFINANCIAL\udb1 to [SQL Server]\sa shadow account mapping, and then click 464 

OK. 465 

 466 

23. Select No for pop-up about the System Target Restriction. 467 

24. You should see that the ACMEFINANCIAL\udb1 user now has access to SQL Server 468 

Management Studio with the [SQL Server]\sa shadow account. Click OK.  469 
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 470 

2.2.9 Configuring Twitter Account Launching 471 

The Bomgar application launcher comes with some premade scripts to launch various applications. One 472 

of these scripts launches Internet Explorer and automatically signs the user into a Twitter account. The 473 

following steps detail the process of configuring the script. 474 

To launch Twitter, Bomgar-PI needs the Twitter account password. The following steps detail how to 475 

add an external password to Bomgar-PI: 476 

1. In the RED Identity Management Console, select Manage > Import Password Information > 477 

Import Password into Password Store. 478 

2. In the Import Single Account Password window, enter the following configuration: 479 

a. Account type: OS_TYPE_EXTERNAL 480 

b. System Name: Twitter 481 
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c. Account Name: <the Twitter account username> 482 

d. Password: <the Twitter account password> 483 

e. Re-enter Password: <the Twitter account password> 484 

 485 

3. Click Import Account. 486 

We can now configure Bomgar-PI to use that account to launch Twitter: 487 

1. Go to Settings > Manage Web Application > Application Launch. 488 

2. Scroll down, and double-click Twitter. 489 

3. In the Remote Application Configuration window, enter the following information: 490 

a. Run on the jump server: BOMGAR-APPLNCH.AcmeFinancial.com 491 

i. This check box should be selected. 492 

b. Automation URL: https://twitter.com/login 493 

c. Always use the specified account when starting this application: This check box should 494 

be selected. 495 

d. System Name: Twitter 496 

e. Namespace: [External] 497 

f. Account Name: <the Twitter account username> 498 
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 499 

4. Click OK, then OK, and then OK again. 500 

To allow users to launch Twitter, follow these steps: 501 

1. Open Delegation > Web Application Remote Application Permissions. 502 

2. Click Add. 503 

3. Select the identity that should be allowed to launch Twitter. More identities can be added by 504 

clicking Add Identity. 505 

4. Click OK. 506 

5. Select the Remote Application Twitter, and then click OK. 507 

6. Select No for the pop-up about Shadow Account Restriction. 508 

7. Select No for the pop-up about System Target Restriction. 509 

8. Click OK. 510 
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2.2.10 Configuring Multifactor Authentication with RSA 511 

The following steps detail how Bomgar Privileged Identity was configured to authenticate users by using 512 

a SecurID from RSA. In summary, Bomgar acts as a RADIUS client to an RSA Authentication Manager. 513 

Bomgar is configured to prompt for a onetime passcode after authenticating the user with AD. 514 

1. In the RED Identity Management Console, select Delegation > External 2 Factor Configuration. 515 

 516 

2. Fill out the Configure 2 Factor Authentication window with the following settings: 517 

a. Authenticator Type: RADIUS 518 

b. Authenticator Label: RSA Auth 519 

c. IP address: 172.16.2.15 (the IP address of the RSA Authentication Manager) 520 
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d. Port: 1812 521 

e. Shared Secret: <the shared secret from RSA for RADIUS clients> 522 

f. Timeout: 6 523 

g. Connection Retry Count: 3 524 

h. PAP Communication: This check box should be selected. 525 

 526 

3. Click OK. 527 

4. Click Manage Web App.  528 



DRAFT 

 
NIST SP 1800-18C: Privileged Account Management for the Financial Services Sector 38 

 529 

5. In the Manage Web Application Instances window, double-click the Web Application Instance. 530 
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 531 

6. Click Yes. 532 

7. Click the tab labeled Multi-Factor Authentication (MFA). 533 

 534 

8. Select Enable external MFA (RADIUS and native integrations), Use simple username for 535 

external MFA login checks, and Require MFA for all interactive web application logins.  536 
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 537 

9. Click OK. Click OK again in the pop-up window. 538 

10. Click Close. 539 

2.2.11 Splunk Universal Forwarder 540 

Install Splunk Universal Forwarder by following the instructions provided at 541 

http://docs.splunk.com/Documentation/Forwarder/7.1.3/Forwarder/Abouttheuniversalforwarder. 542 

Edit the inputs.conf file to monitor and forward logs from the UsageLog.txt file to the demo index at 543 

Splunk Enterprise. Use the built-in _json sourcetype. 544 

http://docs.splunk.com/Documentation/Forwarder/7.1.3/Forwarder/Abouttheuniversalforwarder
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 545 

2.3 TDi ConsoleWorks 546 

TDi ConsoleWorks is a PAM solution that allows for proxying terminal and web connections through a 547 

web interface. 548 

2.3.1 How It’s Used 549 

TDi ConsoleWorks provides PAM for accounts accessing Splunk and the router/firewall configuration 550 

web page. 551 

2.3.2 Virtual Machine Configuration 552 

The TDi ConsoleWorks virtual machine is configured as follows: 553 

▪ CentOS 7 554 

▪ 2 CPU cores 555 

▪ 8 GB of RAM 556 

▪ 75 GB of storage 557 

▪ 1 NIC 558 

Network Interface Configuration: 559 

▪ IPv4: manual 560 

▪ IPv6: disabled 561 

▪ IPv4 address: 172.16.4.11 562 

▪ Netmask: 255.255.225.0 563 
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▪ Gateway: 172.16.4.1 564 

▪ DNS servers: 172.16.3.10 565 

▪ DNS-search domain: N/A 566 

2.3.3 Installation 567 

Installation documentation is provided on TDi’s website, but an account with TDi Technologies is 568 

necessary to access it. A basic installation was used in this project. 569 

2.3.4 Configuration of Back-End Authentication 570 

The following steps describe how ConsoleWorks was configured to authenticate users with the 571 

IDENTIKEY Authentication Server. 572 

1. Log in as a user with the CONSOLE_MANAGER role. 573 

2. Click SECURITY > External Authentication. 574 

http://support.tditechnologies.com/tags/installation-guides
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 575 

3. Click Add. 576 

4. Fill out the External Authentication Record with the following information for the IDENTIKEY 577 

Authentication Server: 578 

a. Record Name: IDENTIKEY 579 

b. Enabled: This check box should be selected. 580 
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c. Library: radius 581 

d. Parameter 1: 172.16.2.208:1812/fspam 582 

Note: Parameter 1 specifies the IP address (or host name) of the RADIUS server, 583 

followed by the port and then the shared secret in the format [ip 584 

address]:[port]/[shared secret]. 585 

 586 

5. Click Next, and then click Next again. 587 

6. Check that the verification passed. The user should be denied. Click Next. 588 

 589 
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7. Click Save. 590 

8. Make sure that the Enable External Authentication check box is selected in the SECURITY: 591 

External Authentication window. 592 

 593 

9. Click Save if available. 594 

2.3.5 Creating Users 595 

Each privileged user must have an account in ConsoleWorks to log into ConsoleWorks. The following 596 

steps detail the process of creating accounts for AD users in ConsoleWorks. For this example, we will 597 

create a ConsoleWorks account for the splunk_admin@acmefinancial.com AD account. This user will 598 

manage the Splunk virtual-machine OS. 599 

1. In ConsoleWorks, click USERS > Add as a CONSOLE_MANAGER account. 600 

mailto:splunk_admin@acmefinancial.com
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 601 

2. Fill out the pop-up window with the following information: 602 

a. Name: SPLUNK_ADMIN_ACMEFINANCIAL_COM 603 

b. Use External Authentication: This check box should be selected. 604 

c. Enter a dummy password in the Password field, and then retype it in the Retype 605 

Password field. 606 

d. Require Password Change on Next Login: This check box should not be selected. 607 

Note: The format USERNAME_DOMAIN_NAME is important. This is how ConsoleWorks expects 608 

a user with the fully qualified domain name (FQDN) username@domain.name to be named in 609 

the product. 610 

3. Click Save. 611 
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 612 

2.3.6 Creating Tags 613 

Tags in ConsoleWorks allow consoles to be easily identified as part of a certain group. We will create a 614 

tag for the consoles that should be accessible to users who need OS-level access to the Splunk virtual 615 

machine. 616 

1. Click SECURITY > Tags > Add. 617 

2. Fill out the pop-up window with the following information: 618 

a. Name: SPLUNK_OS 619 

b. (optional) Description: Splunk OS Consoles 620 

3. Click Save. 621 

2.3.7 Creating SSH Consoles 622 

Managed assets must have a “console” entry in ConsoleWorks for privileged users to connect to them. 623 

The following steps detail how to create a console for SSH access to the Splunk virtual machine that an 624 

administrator (admin) (e.g., splunk_admin) would use. 625 

1. Click CONSOLES > Add. 626 



DRAFT 

 
NIST SP 1800-18C: Privileged Account Management for the Financial Services Sector 48 

2. Fill out the pop-up window with the following information: 627 

a. Name: SPLUNK_SSH 628 

b. (optional) Description: Splunk SSH Console 629 

c. Connector: SSH with Password 630 

d. Connection Details: 631 

i. Host IP: 172.16.4.2 632 

ii. Port: 22 633 

iii. Username: root 634 

iv. Password: fspam@nccoe1 635 

v. Retype Password: fspam@nccoe1 636 

e. TAGS: Add the tag SPLUNK_OS, which we created earlier, to this console by clicking Add 637 

and then entering SPLUNK_OS. 638 

 639 

3. Click Save. 640 
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2.3.8 Creating Web Consoles 641 

The following steps describe how to create a console for a web application. ConsoleWorks will proxy a 642 

connection to the managed asset, allowing for monitoring of user activity on the managed asset. These 643 

steps were completed twice: once for the Splunk web interface and again for a pfSense router/firewall. 644 

The following steps describe the configuration for pfSense: 645 

1. On the AD Domain Controller, which acts as a DNS server, open DNS Manager. 646 

2. Double-click the AcmeFinancial.com object. 647 

3. Double-click the Forward Lookup Zone object. 648 

4. Right-click in the area with DNS records, and select New Host (A or AAAA). 649 

5. In the Name field, enter pfsenseweb. 650 

6. In the IP address field, enter the IP address of the ConsoleWorks virtual machine. In this case, it 651 

is 172.16.4.11. 652 

7. Click Add Host. 653 

8. In ConsoleWorks’ web interface, log in as a CONSOLE_MANAGER. 654 

9. Click CONSOLES > Add. 655 

10. Fill out the window CONSOLES: Add window with the following information: 656 

a. Name: PFSENSE 657 

b. Description: Web Console for pfSense 658 

c. Connector: Web Forward 659 

d. Connection Details: 660 

i. Bind Name: DEFAULTWEB 661 

ii. Host Header: pfsenseweb.acmefinancial.com 662 

iii. URL: https://172.16.4.1 663 

iv. Profile: CONSOLE_MANAGER 664 
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 665 

Note: In the case where the URL is not just the host name, the rest of the URL after the 666 

forward slash should be put in Relative URL. 667 

11. Click Save. 668 

2.3.9 Assigning Tags to Consoles 669 

We created a unique tag to identify each group of consoles. Specifically, we created tags for the 670 

following console groups: 671 

▪ pfSense consoles 672 

▪ Splunk application-level consoles 673 

▪ Splunk OS-level consoles 674 

▪ Ekran Server consoles 675 

Even though each of these groups has only one console in it, organizing the consoles this way makes it 676 

easy to add more consoles to the groups later. 677 
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The following steps describe the process for assigning a tag to a console: 678 

1. In ConsoleWorks, click CONSOLES > View. 679 

2. Select a console (e.g., PFSENSE). 680 

3. Click Edit. 681 

4. Open the TAGS menu, and then click Add. 682 

5. Move the pfSense consoles’ tag to the list on the right, and then click OK. 683 

6. Click Save. 684 

2.3.10 Creating Profiles for Users 685 

Profiles in ConsoleWorks are like groups in Windows. Users can be added to profiles, and those profiles 686 

can be assigned permissions, such as access to a specific set of consoles. 687 

The following steps describe creating a SPLUNK_ADMIN profile that will eventually allow users who have 688 

access to this profile to access the Splunk OS-level console: 689 

1. Click USERS > Profiles > Add. 690 

2. Fill out the USERS: Profiles: Add pop-up window with the following information: 691 

a. Name: SPLUNK_ADMIN 692 

b. Description: Admins of Splunk’s OS 693 

3. Under USERS, click Add. 694 

4. Move the SPLUNK_ADMIN_ACMEFINANCIAL_COM user to the list on the right, and then click 695 

OK. 696 

5. Click Save. 697 
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 698 

Use the same procedure provided above (while just changing the Name, Description, and USERS 699 

chosen) to create profiles for each group of users who should have access to a specific set of consoles. In 700 

this case, it was Splunk OS-level consoles. Next, it could be Splunk application-level consoles. 701 

2.3.11 Assigning Permissions to Profiles 702 

Profiles were given access to the consoles through Access Control Rules in ConsoleWorks. The following 703 

steps create an Access Control Rule for Splunk OS-level admins: 704 

1. In ConsoleWorks, click SECURITY > Access Control > Add. 705 

2. Fill out the SECURITY: Access Control: Add window with the following information: 706 

a. Name: SPLUNK_OS_CONSOLES 707 

b. Description: Access to Splunk OS consoles 708 

c. Order: 10 709 

d. Allow or Deny: ALLOW 710 

e. Component Type: Console 711 

3. Open Profile Selection, and select the Simple tab. 712 

4. Move the SPLUNK_ADMIN profile to the list on the right. 713 

5. Open Resource Selection, and select the Simple tab. 714 

6. Change the drop-down from Is one of these Consoles to Has one of these Tags. 715 
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7. Move the SPLUNK_OS tag to the list on the right. 716 

8. Open Privileges, and select the following privileges (these are the same for both SSH and web 717 

consoles): 718 

a. Aware 719 

b. Connect 720 

c. Disconnect 721 

d. View 722 

 723 

9. Click Save. 724 

2.4 Ekran System 725 

Ekran System is a monitoring solution that provides session recording and playback. A server records the 726 

actions of users on multiple clients. 727 
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2.4.1 How It’s Used 728 

Ekran System is used to create “privileged stations” that privileged users use to access their privileged 729 

accounts. Ekran monitors the actions taken by privileged users, and reports to Splunk. 730 

2.4.2 Virtual Machine Configuration 731 

The Ekran System server is installed on one virtual machine, while the client is on another virtual 732 

machine. Ekran recommends increasing the storage of the virtual machine based on how many clients 733 

are being monitored. 734 

The Ekran System server virtual machine is configured as follows: 735 

▪ Windows Server 2016 736 

▪ 1 CPU core 737 

▪ 8 GB of RAM 738 

▪ 150 GB of storage 739 

▪ 1 NIC 740 

Network Configuration (Interface 1): 741 

▪ IPv4: manual 742 

▪ IPv6: disabled 743 

▪ IPv4 address: 172.16.1.20 744 

▪ Netmask: 255.255.255.0 745 

▪ Gateway: 172.16.1.1 746 

▪ DNS name servers: 172.16.3.10 747 

▪ DNS-search domains: N/A 748 

2.4.3 Prerequisites 749 

Ekran System requires Microsoft SQL Server, although, in the lab environment, Microsoft SQL Server 750 

Express was used. Ekran System also requires IIS to be installed. A full list of requirements can be found 751 

on Ekran’s website. 752 

2.4.4 Installing Ekran System 753 

Full installation instructions are available on Ekran’s website. 754 

The Ekran System server and agent are installed in the privileged user station and are used to monitor 755 

privileged users. 756 

https://www.ekransystem.com/sites/default/files/file_resources/Ekran_help_1.pdf
https://www.ekransystem.com/sites/default/files/file_resources/Ekran_help_1.pdf
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2.5 Radiant Logic 757 

Radiant Logic FID is a virtual directory that performs a federated identity service. 758 

2.5.1 How It’s Used 759 

Radiant Logic FID is used in two capacities in this example implementation. First, FID acts as the identity 760 

provider for users accessing TDi ConsoleWorks to view security dashboards within Splunk. Users are 761 

forced to use MFA with VASCO IDENTIKEY. Second, FID acts as a monitoring service where privileged 762 

user accounts are monitored for changes, logged, and forwarded to Splunk. 763 

2.5.2 Virtual Machine 764 

The Radiant Logic virtual machine is configured as follows: 765 

▪ Windows Server 2016 766 

▪ 3 CPU cores 767 

▪ 20 GB of RAM 768 

▪ 120 GB of storage 769 

▪ 1 NIC 770 

Network Configuration (Interface 1): 771 

▪ IPv4: manual 772 

▪ IPv6: disabled 773 

▪ IPv4 address: 172.16.3.218 774 

▪ Netmask: 255.255.255.0 775 

▪ Gateway: 172.16.1.1 776 

▪ DNS name servers: 172.16.3.10 777 

▪ DNS-search domains: N/A 778 

2.5.3 Prerequisites 779 

The minimum system requirements are as follows: 780 

▪ Hardware 781 

• Cluster nodes must be deployed on hardware that is configured for optimal redundancy and 782 
highly reliable connectivity between the cluster nodes/machines.  783 

• Processor: Intel Pentium or AMD Opteron, minimum dual core  784 
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• Processor speed: 2 gigahertz or higher 785 

• Memory: 16 GB minimum. For most production deployments, more than 16 GB of memory 786 
is required.  787 

• Hard drive: 100 GB of disk space. The hard-disk usage will vary depending on the log 788 
types/levels that are enabled and the desired log history to maintain.  789 

▪ Software 790 

• OS: Windows 2008 R2 Server, Windows Server 2012 R2, Windows Server 2016 791 

2.5.4 Installation 792 

To install FID, see the documentation provided with the software. The FID installation guide can also be 793 

found on the Radiant Logic support website. A support account is required. 794 

2.5.5 Configure FID 795 

The steps for configuring FID are as follows: 796 

1. Add server back-ends: 797 

a. While logged in as the Directory Manager, navigate to Settings > Server Backend > LDAP 798 

Data Sources. 799 

b. Click Add. 800 

 801 

c. Name the data source, and then enter the parameters. For AD, the parameters used are 802 

shown in the following screenshot. Click Save. 803 

http://www.radiantlogic.com/support/knowledge-database/
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 804 

2. Create a proxy view to the back-end directories: 805 

a. On the Directory Namespace tab, select New Naming Context (the plus sign) at the top 806 

left of the screen. 807 

b. Select the LDAP Backend radio button, and enter the naming context, such as o=test. 808 

Click Next. 809 

 810 

c. For the Data Source, select the name of the AD back-end created earlier. Browse and 811 

select the Remote Base DN of the domain. Click OK. 812 
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 813 

2.5.6 Configure Logging 814 

To log changes to each directory object, you must create a cache for the proxy view created in the 815 

previous section. To create the cache and to log changes made to the back-end directories, complete 816 

the following steps: 817 

1. Navigate to the Sync Monitoring tab. Press the play ( )button to start the glassfish server. 818 

 819 

2. In the Directory Namespace tab, highlight Cache in the left window pane. Select Persistent 820 

Cache with Automated Refresh. Click Create Persistent Cache. 821 
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 822 

3. Browse and select the Lightweight Directory Access Protocol (LDAP) proxy created in the 823 

previous steps. Click OK. FID creates the cache. 824 

 825 

4. Under Cache in the lower left window, select the cache that you created. Click Initialize to make 826 

the cache active. 827 
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828 

 829 

5. Select Create a new LDIF file from a snapshot of the virtual directory branch. Click OK. This 830 

step may take a few minutes. 831 

6. Once complete, click Save. 832 
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7. Select the Connectors tab. 833 

 834 

8. There will be a connector for the back-end directory and for the connector itself. Highlight the 835 

AD connector. Click Configure. Change the connector type to Capture [Snapshot]. Click OK. 836 

 837 

9. Install Splunk Universal Forwarder to monitor the file at 838 

C:\radiantone\vds\r1syncsvcs\log\cf_o_acmefinancial\object_generic_dv_so_o_acmefinancial_c839 

apture.log 840 

2.5.7 Configure SSL 841 

In this implementation, AD serves as the CA. 842 

1. Create the initial FID private key: 843 

Navigate to c:\radiantone\vds\jdk\jre\bin, and run keytool -genkey -alias rli -844 
keyalg RSA -keystore C:\radiantone\vds\vds_server\conf\rli.keystore -dname 845 

“cn=radiant-logic, dc=acmefinancial,dc=com". 846 

2. Download the certificate from the CA. 847 
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3. Create the certificate signing request: 848 

Navigate to c:\radiantone\vds\jdk\jre\bin, and run keytool -certreq -alias rli –849 
keystore C:\radiantone\vds_server\conf\rli.keystore -file 850 
C:\radiantone\vds_server\conf\vdsserver.csr. 851 

4. Submit the request to the CA. 852 

5. Import the trusted CA certificate into the keystore and cacerts database on FID: 853 

a. Navigate to c:\radiantone\vds\jdk\jre\bin, and run keytool -import -trustcacerts -854 
file C:\radiantone\vds\vds_server\conf\certca.cer -keystore 855 

C:\radiantone\vds\vds_server\conf\rli.keystore. 856 

b. Run keytool -import -trustcacerts -file 857 
C:\radiantone\vds\vds_server\conf\certca.cer -keystore 858 

C:\radiantone\vds\jdk\jre\lib\security\cacerts. 859 

6. Import the signed server certificate from the request into FID: 860 

Navigate to c:\radiantone\vds\jdk\jre\bin, and run keytool -import -file 861 
C:\radiantone\vds\vds_server\conf\rli.cer -keystore 862 

C:\radiantone\vds\vds_server\conf\rli.keystore -v -alias rli. 863 

7. Restart FID. 864 

2.5.8 Splunk Universal Forwarder 865 

Install Splunk Universal Forwarder by following the instructions provided at 866 

http://docs.splunk.com/Documentation/Forwarder/7.1.3/Forwarder/Abouttheuniversalforwarder.  867 

Edit the inputs.conf file to monitor the object_generic_dv_so_o_acmefinancial_capture.txt file created 868 

by Radiant Logic FID and to forward logs to the demo index at Splunk Enterprise. 869 

http://docs.splunk.com/Documentation/Forwarder/7.1.3/Forwarder/Abouttheuniversalforwarder
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 870 

2.6 IdRamp 871 

2.6.1 How It’s Used 872 

IdRamp is used for MFA in this build. The majority of the IdRamp configuration is performed by the 873 

IdRamp team. 874 

2.6.2 Prerequisites 875 

▪ premium Azure account 876 

▪ AD installed 877 

2.6.3 Installation 878 

1. Set up Azure AD sync with password hash synchronization: 879 

https://docs.microsoft.com/en-us/azure/active-directory/connect/active-directory-aadconnect-880 

get-started-express 881 

2. Enable MFA in Azure for certain privileged users: 882 

a. In the Azure AD admin center at https://aad.portal.azure.com, click Azure Active 883 

Directory. 884 

b. Click SECURITY > Conditional access. 885 

c. Click New policy. 886 

https://docs.microsoft.com/en-us/azure/active-directory/connect/active-directory-aadconnect-get-started-express
https://docs.microsoft.com/en-us/azure/active-directory/connect/active-directory-aadconnect-get-started-express
https://aad.portal.azure.com/
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d. Give the policy a name, such as Privileged 2FA. 887 

e. Click Users and groups. Under Include, click users and groups, and select Users and 888 

groups check box. 889 

f. Click the region labeled as Select. 890 

g. Select the privileged users from the list. 891 

h. Once all of those users are selected, click Done. 892 

i. Click Cloud apps, and then select All cloud apps. Click Done. 893 

j. Under Access Controls, click Grant. 894 

k. Make sure that the Grant access check box is selected, and select the check box labeled 895 

as Require multi-factor authentication. 896 

l. Click Select. 897 

m. Click On under Enable policy, and then click Create. 898 

3. Disable logins of all other accounts: 899 

a. For each user that you do not want to allow to sign in with Azure AD at all, click their 900 

user account under All users in the Azure AD admin center. 901 

b. Click Yes next to Block sign in. 902 

4. Configure sign-in to block incoming requests, except from your organization’s network: 903 

a. Under SECURITY > Conditional access in the Azure AD admin center, select Named 904 

locations. 905 

b. Click New location, and then give the location a name. 906 

c. Select the check box labeled as Mark as trusted location. 907 

d. Enter the IP range of the network to which you want to restrict access. 908 

e. Click Create. 909 

f. Complete steps 2a–2c above. 910 

g. Give the policy a name, such as Block Remote Access. 911 

h. For users of this policy, select the privileged users. 912 

i. Select all cloud apps for the Cloud apps assignment. 913 
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j. Under Conditions, select Locations. 914 

k. Select Yes under Configure, and select Any location under Include. 915 

l. Click Exclude, and then click Select. 916 

m. Select the Named location that we just created, and then click Select. 917 

n. Click Done. 918 

o. Click Grant under Access controls, and then click Block access. 919 

p. Click Select. 920 

q. Click On under Enable policy, and then click Create. 921 

2.7 OneSpan IDENTIKEY Authentication Server 922 

OneSpan IDENTIKEY Authentication Server, now known as OneSpan Authentication Server, is a two-923 

factor authentication (2FA) solution with user, policy, and token management. DIGIPASS is the name of 924 

their two-factor token, and it can be hardware-based or software-based. 925 

2.7.1 How It’s Used 926 

IDENTIKEY Authentication Server provides 2FA to TDi ConsoleWorks. The Authentication Server acts as a 927 

RADIUS server, which allows a variety of clients to authenticate through it. The Authentication Server, 928 

based on a user-defined policy, checks the onetime passcode from a DIGIPASS. Additionally, the server 929 

binds to Radiant Logic by using LDAPS to authenticate the user’s password. 930 

2.7.2 Virtual Machine Configuration 931 

The IDENTIKEY Authentication Server virtual machine is configured with Ubuntu Server 16.04 LTS. 932 

The text search acmefinancial.com should be saved in resolv.conf file. 933 

2.7.3 Prerequisites 934 

The product can be installed on both Windows and Linux. This project used Linux. 935 

The prerequisite software for a basic installation could be installed with the following command: 936 

sudo apt install unixodbc libaio1 libdbi-perl socat openjdk-8-jre-headless 937 

The license key should be located on the server where the Authentication Server is going to be installed. 938 
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2.7.4 Installation 939 

The following instructions lead through a basic installation of IDENTIKEY Authentication Server: 940 

1. Mount the .iso file with the server installer: 941 

mkdir /mnt/dvd 942 

mount /dev/dvd /mnt/dvd 943 

2. Run the installation script: 944 

cd /mnt/dvd 945 

sudo ./install.sh 946 

3. Begin following the installation wizard, and choose basic installation. 947 

4. Accept the licenses. 948 

5. Select Yes to encrypt the embedded database. 949 

2.7.5 Configuration 950 

After completing the installation, configuration happens immediately: 951 

1. Press Enter to choose Next. 952 

2. Enter the IP address of the server (in this case, 172.16.2.208). 953 

3. Enter the location of the license key on the server. 954 

 955 

4. Accept the server functionality, and then select Next. 956 

5. Create a username and password for the first admin account, and then select Next. 957 
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 958 

6. Create a password for the certificate, and then select Next. 959 

 960 

7. Set up the server to act as a stand-alone RADIUS server, and then select Next. 961 

8. Create the first RADIUS client, with the IP address and a shared secret. The first client will be 962 

ConsoleWorks. Select Next. 963 

9. Verify that all of the options shown on the screen are consistent with the above instructions. 964 

Select Proceed. 965 

10. Verify that the configuration succeeded as shown below. 966 
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 967 

11. Respond No to the question “Do you want to import a DIGIPASS file? (yes/no)” as you will do 968 

this later. 969 

2.7.6 Creating a Domain and Policies 970 

After completing installation and basic configuration with the terminal, the following steps are 971 

completed with the web interface: 972 

1. Open the web interface at https://172.16.2.208:8443. 973 

2. Log in by using the admin account that was created during configuration. 974 

3. Click ORGANIZATION > Add domain. 975 
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 976 

4. Enter the Domain Name acmefinancial.com and then click CREATE. 977 
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 978 

5. Click POLICIES > Create. 979 

6. Enter the Policy ID ACME_2FA, write a short Description, and choose for it to inherit from 980 

Identikey Back-End Authentication. Click CREATE. 981 
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 982 

7. Choose to manage the policy, and click EDIT. 983 

8. Select Digipass Only for Local Authentication, Always for Back-End Authentication, and 984 

Microsoft Active Directory for Back-End Protocol. Click SAVE. 985 

 986 

9. Click CLIENTS > List. 987 
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10. Click the RADIUS client. 988 

11. Select ACME_2FA for the Policy ID, which was just created. Click SAVE. 989 

 990 

2.7.7 Importing DIGIPASSes 991 

The following steps import demo DIGIPASSes that were included in the installation .iso file: 992 

1. In the web interface, click DIGIPASS > Import. 993 

2. Click Choose File next to Get DPX file, and select the demo DIGPASSApp.dpx file, which came in 994 

the .iso file. Within the DIGPASSApp.dpx file is a set of mobile-application DIGIPASSes. Click 995 

Open. 996 
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 997 

3. Enter the transport key for that file. For the demo files, the transport key is 998 

11111111111111111111111111111111 (32 1s). 999 

4. Click UPLOAD. 1000 

5. Select ACTIVATION as the application name. Click NEXT. 1001 

6. On the next screen, import the DIGIPASSes as ACTIVE, and set the Domain to be            1002 

acmefinancial.com. 1003 

7. Click IMPORT. 1004 

8. Choose to run the task immediately. 1005 

2.7.8 Configuring to Use Radiant Logic as a Back-End Authentication Server 1006 

With Radiant Logic configured to replicate users and groups from AD, OneSpan can use Radiant Logic as 1007 

an AD back-end. This works, as OneSpan connects to Radiant by using LDAP over SSL, and Radiant Logic 1008 

contains a virtual directory that presents like AD. 1009 

2.7.8.1 Installing the AD CA Certificate in the OneSpan Server OS 1010 

For OneSpan to trust the certificate used by Radiant Logic during the SSL handshake, the AD CA 1011 

certificate needs to be installed. Because the Radiant Logic certificate was signed by the AD CA, once 1012 

OneSpan trusts the CA, it trusts Radiant Logic. The following instructions detail how to export the AD CA 1013 

certificate and how to install it in Ubuntu: 1014 

1. On AD-PRODUCTION, the AD Domain Controller, open Server Manager. 1015 
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2. In the top right corner, click Tools > Certification Authority. 1016 

 1017 

3. Under Certification Authority (Local), right-click AcmeFinancial-AD-PRODUCTION-CA, and then 1018 

select Properties. 1019 
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 1020 

4. Click Certificate #0, and then click View Certificate. 1021 

5. Tab over to Details, and then click Copy to File. 1022 

6. Click Next. 1023 

7. Select the format option Base-64 encoded X.509 (.CER), and then click Next. 1024 

8. Select a location and file name for saving the certificate. For example, 1025 

C:\Users\Administrator\Desktop\AD-PRODUCTION-CA-PEM.cer. 1026 

9. Click Next, and then click Finish. 1027 

10. Copy the file over to the OneSpan server. 1028 

11. On the OneSpan server, copy the file to the /usr/local/share/ca-certificates directory, and give it 1029 

a .crt file extension. 1030 

12. Update the trusted CA certificates with the following command: 1031 

sudo update-ca-certificates --fresh 1032 
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13. Reboot the OneSpan server machine. 1033 

2.7.8.2 Configuring OneSpan to Use Radiant Logic 1034 

Once the certificate for Radiant Logic will be trusted, the final step (before OneSpan will authenticate 1035 

with Radiant Logic as a back-end) is to add a back-end server entry in OneSpan. The following procedure 1036 

completes this step: 1037 

1. In the IAS Web Administration interface, click BACK-END > Register Active Directory Back-End. 1038 

2. Fill out the pop-up window with the following information: 1039 

a. Back-End Server ID: RADIANT LOGIC 1040 

b. Domain Name: acmefinancial.com 1041 

c. Enable SSL: This check box should be selected. 1042 

d. Location: radiant-logic 1043 

e. Port: 636 1044 

f. Search Base DN: o=AcmeFinancial 1045 

g. Security Principal DN: cn=Directory Manager 1046 

h. Security Principle Password: <the Security Principal Password from Radiant Logic> 1047 

i. Confirm Principle Password: <the Security Principal Password from Radiant Logic> 1048 
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 1049 

3. Click CREATE. 1050 

2.7.9 Integration with TDi ConsoleWorks 1051 

Integrating TDi ConsoleWorks with OneSpan required disabling the NAS-IP-Address RADIUS attribute. 1052 

Instructions for completing this step are available online from OneSpan. 1053 

2.7.10 Installing User Websites 1054 

To allow users to register their own DIGIPASS device without the need of an admin being present, User 1055 

Websites must be installed and then configured with a corresponding license. The following steps detail 1056 

how to install the User Websites on the same server as the Authentication Server: 1057 

1. Mount the .iso file with the server installer: 1058 

mkdir /mnt/dvd 1059 

sudo mount /dev/dvd /mnt/dvd 1060 

2. Run the installation script: 1061 

cd /mnt/dvd/IDENTIKEY\ User\ Websites/ 1062 

sudo ./install-uws.sh 1063 

https://www.vasco.com/images/KB_160031_tcm42-47854.pdf
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3. Accept the licenses for the server. 1064 

2.7.11 Creating Component Records in IDENTIKEY Authentication Server 1065 

Before User Websites can be used to assign a user a DIGIPASS, the IDENTIKEY Authentication Server 1066 

must be configured to accept connections from the User Websites. We will create two component 1067 

records for the websites: one general User Websites client record and another UWS MDL Provisioning 1068 

client record for provisioning DIGIPASSes. 1069 

1. In IAS Web Administration, click CLIENTS > Register. 1070 

2. Fill out the Create new Client page with the following information: 1071 

a. Client Type: IDENTIKEY User Websites 1072 

b. Location: 172.16.2.208 1073 

c. Policy ID: IDENTIKEY Provisioning for Multi-Device Licensing 1074 

 1075 

3. Click CREATE. 1076 
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4. Click Click here to manage IDENTIKEY User Websites. 1077 

5. Tab over to License. 1078 

6. Click LOAD LICENSE KEY. 1079 

7. Click Choose File, and then provide it with the User Websites license. 1080 

8. Click FINISH. 1081 

9. Click CLIENTS > Register again. 1082 

10. Fill out the Create new Client page with the following information: 1083 

a. Client Type: UWS MDL Provisioning (type it in) 1084 

b. Location: 172.16.2.208 1085 

c. Policy ID: IDENTIKEY Provisioning for Multi-Device Licensing 1086 

 1087 

11. Click CREATE. 1088 
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12. Click POLICIES > List. 1089 

13. Find the policy IDENTIKEY Provisioning for Multi-Device Licensing, and then click it. 1090 

14. Click EDIT. 1091 

15. Change the Back-End Protocol from RADIUS to Microsoft AD. 1092 

16. Click SAVE. 1093 

17. Tab over to User. 1094 

18. Click EDIT, and change Dynamic User Registration to No. This way, only users added by admins 1095 

in IDENTIKEY Authentication Server will be assigned DIGIPASSes. 1096 

19. Click SAVE. 1097 

Users are now able to go to https://vasco.acmefinancial.com:9443/selfmgmt to assign themselves 1098 

DIGIPASSes. Details about and instructions for using the DIGIPASS application are available from 1099 

OneSpan. 1100 

2.8 Base Linux OS 1101 

The base Linux image used in this project is an Ubuntu 16.04 Server OS. It is open-source and freely 1102 

available. 1103 

2.8.1 Virtual Machine Configuration 1104 

The base Linux virtual machine is configured as follows: 1105 

▪ Ubuntu Linux 16.04 LTS 1106 

▪ 1 CPU core 1107 

▪ 8 GB of RAM 1108 

▪ 40 GB of storage 1109 

▪ 1 NIC 1110 

Network Configuration: 1111 

▪ IPv4: manual 1112 

▪ IPv6: disabled 1113 

▪ IPv4 address: 172.16.x.x 1114 

▪ Netmask: 255.255.255.0 1115 

▪ Gateway: 172.16.x.1 1116 
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▪ DNS name servers: 172.16.3.10 1117 

▪ DNS-search domain: acmefinancial.com 1118 

2.8.2 Domain Join Configuration 1119 

The base system used was configured to be a part of the project’s AD domain, as demonstrated by the 1120 

following steps: 1121 

1. Ensure that the system has the DNS IP address pointing to the AD server IP address. 1122 

 1123 

2. Restart the networking by entering the following command: 1124 

systemctl restart networking 1125 

3. Verify changes by checking the /etc/resolv.conf file. Enter the following command: 1126 

cat /etc/resolv.conf 1127 

4. Install the packages required for the AD domain join as described above, using the following 1128 

command: 1129 

 1130 

5. If prompted to enter your Kerberos 5 realm name, enter your domain name in capital letters. 1131 

The Kerberos 5 default realm is ACMEFINANCIAL.COM. 1132 
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6. Install the chrony ntp client by entering the following command: 1133 

 1134 

7. Add the following line, which points to the NTP server: 1135 

server 172.16.3.10 1136 

 1137 

8. Restart the chrony service as shown below: 1138 

 1139 

9. Request an AD domain join by using a domain admin account or a user with appropriate 1140 

privileges. Perform the domain join by running the following commands: 1141 

a. kinit administrator@ACMEFINANCIAL.COM 1142 

b. Enter the password when prompted. 1143 

c. realm -v join acmefinancial.com –user-principal = 1144 
yourlinuxhost.acmefinancial.com/administrator@ACMEFINANCIAL.COM 1145 

d. systemctl restart realmd 1146 

10. Set fallback-homedir = /home/%u/%d to create Linux home directories for domain users, and 1147 

access_provider = ad to allow domain users to log into Linux end points via SSH: 1148 

mailto:administrator@ACMEFINANCIAL.COM
mailto:yourlinuxhost.acmefinancial.com/administrator@ACMEFINANCIAL.COM
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 1149 

2.9 Microsoft SQL Server Installation on Ubuntu Linux 1150 

Microsoft SQL Server is a relational database management system developed and provided by the 1151 

Microsoft Corporation. Microsoft SQL Server has different editions that target different audiences. The 1152 

Express edition, which is freely available, was used in this build. 1153 

2.9.1 How It’s Used 1154 

Microsoft SQL Server is used in the example implementation as a managed asset. It represents a critical 1155 

asset that would naturally exist in most enterprises. Access to the server by privileged users is controlled 1156 

by the policies configured on the PAM system.  1157 

2.9.2 Virtual Machine Configuration 1158 

The Microsoft SQL Server virtual machine is configured as follows: 1159 

▪ Ubuntu Linux 16.04 LTS 1160 

▪ 1 CPU core 1161 

▪ 4 GB of RAM 1162 

▪ 40 GB of storage 1163 

▪ 1 NIC 1164 

Network Configuration: 1165 

▪ IPv4: manual 1166 

▪ IPv6: disabled 1167 
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▪ IPv4 address: 172.16.3.12 1168 

▪ Netmask: 255.255.255.0 1169 

▪ Gateway: 172.16.3.1 1170 

▪ DNS name servers: 172.16.3.10 1171 

▪ DNS-search domain: acmefinancial.com 1172 

2.9.3 Firewall Configuration 1173 

   ufw allow 1433/tcp 1174 

   ufw allow 22/tcp 1175 

   ufw default deny incoming 1176 

2.9.4 Installation and Initial Configuration 1177 

Use the following steps to install Microsoft SQL Server Express 2017 and to configure it to authenticate 1178 

to AD: 1179 

1. Install Microsoft SQL Server on Ubuntu Linux by using the instructions provided at 1180 

https://docs.microsoft.com/en-us/sql/linux/quickstart-install-connect-ubuntu?view=sql-server-1181 

linux-2017. 1182 

2. Create a service account by entering the following Powershell command: 1183 

New-ADuser mssql -AccountPassword (Read_host -AsSecureString “Enter password”) 1184 
-PasswordNeverExpires $true -Enabled $true. 1185 

a. Enter the password when prompted. 1186 

3. Give the account the Log on as a service right by going to Server Manager > Group Policy 1187 

Management > Edit > Computer Configuration > Policies > Windows Settings > Security 1188 

Settings > Local Policies > User Rights Assignment. 1189 

https://docs.microsoft.com/en-us/sql/linux/quickstart-install-connect-ubuntu?view=sql-server-linux-2017
https://docs.microsoft.com/en-us/sql/linux/quickstart-install-connect-ubuntu?view=sql-server-linux-2017
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 1190 

4. Create a Service Principal Name by entering the following command: 1191 

setspn -A MSSQLSvc/sql-server.acmefinancial.com:1433 mssql 1192 

5. Request the information needed to create a keytab file by entering the following commands: 1193 

a. Enter the following command: 1194 

kinit mssql@ACMEFINANCIAL.COM 1195 

i. Enter the account password when prompted. 1196 

b. Retrieve the kvno value by entering the following command: 1197 

kvno MSSQLSvc/sql-server.acmefinancial.com:1433 1198 

 1199 

6. Create a keytab file by entering the commands shown below: 1200 

 1201 

7. Exit the ktutil tool by entering the following command: 1202 

quit 1203 

mailto:mssql@ACMEFINANCIAL.COM
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8. Restart SQL Server by entering the following command: 1204 

systemctl restart mssql-server 1205 

9. Install SQL Server command-line tools by using the instructions provided at 1206 

https://docs.microsoft.com/en-us/sql/linux/quickstart-install-connect-ubuntu?view=sql-server-1207 

linux-2017#tools. 1208 

10. Log into the database by entering the following command: 1209 

./sqlcmd -S localhost -U sa 1210 

11. To enable AD-based logins to the database, use the instructions provided at 1211 

https://docs.microsoft.com/en-us/sql/linux/sql-server-linux-active-directory-1212 

authentication?view=sql-server-linux-2017#createsqllogins. 1213 

2.10 Samba File Server 1214 

Samba is an open-source tool that provides file and print services by using the Server Message Block 1215 

(SMB) / Common Internet File System protocol. Samba can also be used to emulate Windows domain 1216 

controllers and member servers in AD environments. 1217 

2.10.1 How It’s Used 1218 

Samba was used in this example implementation to provide file services for AD domain clients. As a file 1219 

server potentially holding confidential information, it was also used as a managed asset for which 1220 

privileged user access was controlled by policies configured on the PAM system. 1221 

2.10.2 Virtual Machine Configuration 1222 

The Samba virtual machine is configured as follows: 1223 

▪ Ubuntu Linux 16.04 LTS 1224 

▪ 1 CPU core 1225 

▪ 8 GB of RAM 1226 

▪ 40 GB of storage 1227 

▪ 1 NIC 1228 

Network Configuration: 1229 

▪ IPv4: manual 1230 

▪ IPv6: disabled 1231 

▪ IPv4 address: 172.16.3.21 1232 

https://docs.microsoft.com/en-us/sql/linux/quickstart-install-connect-ubuntu?view=sql-server-linux-2017#tools
https://docs.microsoft.com/en-us/sql/linux/quickstart-install-connect-ubuntu?view=sql-server-linux-2017#tools
https://docs.microsoft.com/en-us/sql/linux/sql-server-linux-active-directory-authentication?view=sql-server-linux-2017#createsqllogins
https://docs.microsoft.com/en-us/sql/linux/sql-server-linux-active-directory-authentication?view=sql-server-linux-2017#createsqllogins
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▪ Netmask: 255.255.255.0 1233 

▪ Gateway: 172.16.3.1 1234 

▪ DNS name servers: 172.16.3.10 1235 

▪ DNS-search domain: acmefinancial.com 1236 

2.10.3 Firewall Configuration 1237 

ufw allow 137 1238 

ufw allow 138 1239 

ufw allow 139 1240 

ufw allow 445 1241 

ufw allow 22/tcp 1242 

ufw default deny incoming 1243 

2.10.4 Installation and Configuration 1244 

1. Ensure that the DNS server is set to the AD domain controller IP address. Enter the following 1245 

command to verify: 1246 

cat /etc/resolv.conf 1247 

2. Ensure that the search domain is set to your domain (e.g., acmefinancial.com). Enter the 1248 

following command to verify: 1249 

cat /etc/resolv.conf 1250 

 1251 
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3. Install the chrony ntp client by entering the following command: 1252 

sudo apt-get install chrony 1253 

4. Add the following line to the /etc/chrony/chrony.conf file so that chrony points to the NTP 1254 

server: 1255 

server 172.16.3.10 1256 

5. Restart the chrony service by entering the following command: 1257 

systemctl restart chrony 1258 

6. Install the Samba, Kerberos, and winbind packages by entering the following command at the 1259 

terminal: 1260 

apt-get install samba krb5-user krb5-config winbind libpam-winbind libnss-1261 
winbind 1262 

7. Edit the /etc/samba/smb.conf file with the values as shown below: 1263 

 1264 

8. Restart these services by entering the following command: 1265 

systemctl restart smbd winbind 1266 

9. Join the domain by entering the following command: 1267 

net ads join -U administrator 1268 



DRAFT 

 
NIST SP 1800-18C: Privileged Account Management for the Financial Services Sector 89 

10. Enter the domain admin password when prompted. 1269 

11. Enter the following command at the terminal to create a folder to be shared via Samba: 1270 

mkdir /PII2 1271 

12. Enter the following command to change the owning group to domain users: 1272 

chgrp “domain users” /PII2 1273 

13. Enter the following command to ensure that only domain admins have access to the folder: 1274 

chmod 660 /PII2 1275 

14. Edit the /etc/samba/smb.conf file with the information shown below: 1276 

 1277 

15. Restart these services by entering the following command: 1278 

systemctl restart smbd winbind 1279 

2.11 Remediant SecureONE 1280 

SecureONE is a PAM system that controls privileged access to managed assets by adding accounts to or 1281 

removing accounts from administrative groups on the asset’s OSes. SecureONE does not require an 1282 

agent on the managed asset but instead uses Windows Remote Procedure Call and SSH to make 1283 

privilege escalation and de-escalation changes on the end point. 1284 

2.11.1 How It’s Used 1285 

In the example implementation, SecureONE was used as a PAM system that controls administrative 1286 

access to the managed asset’s OS. SecureONE was not used for managing administrative access to any 1287 

application. 1288 

2.11.2 Virtual Machine Configuration 1289 

The Remediant SecureONE virtual machine is configured as follows: 1290 

▪ Ubuntu Linux 16.04 LTS 1291 

▪ 4 CPU cores 1292 
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▪ 16 GB of RAM 1293 

▪ 100 GB of storage 1294 

▪ 1 NIC 1295 

Network Configuration: 1296 

▪ IPv4: manual 1297 

▪ IPv6: disabled 1298 

▪ IPv4 address: 172.16.2.10 1299 

▪ Netmask: 255.255.255.0 1300 

▪ Gateway: 172.16.2.1 1301 

▪ DNS name servers: 172.16.3.10 1302 

▪ DNS-search domain: acmefinancial.com 1303 

2.11.3 Installation and Initial Configuration 1304 

In the example implementation, SecureONE was deployed as a prebuilt virtual-machine appliance from 1305 

the vendor. The appliance was still configured with parameters necessary for our environment. You can 1306 

connect to the SecureONE appliance by navigating your web browser to https://10.33.51.227. Replace 1307 

the IP address with your appliance’s IP address. 1308 

2.11.4 Domain Configuration 1309 

SecureONE needs to be configured to manage systems in an AD environment. The configuration details 1310 

are provided in the following steps: 1311 

1. Create a service account in AD. Name the service account as secureone, and add it to the 1312 

domain admins group. This account will be used by the SecureONE appliance. 1313 

2. Click Configure > Server > Edit Configuration, and fill out the pop-up window with the relevant 1314 

information: 1315 
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 1316 

2.11.5 Managing Systems 1317 

SecureONE manages systems by enrolling them into protected mode. Once a system is enrolled, 1318 

SecureONE can change a user’s group memberships. SecureONE can add or remove users from the local 1319 

admins group or the local sudoers group. Use the following steps to enroll a domain computer: 1320 

1. Navigate to Access > System Search. 1321 

2. In the search bar, enter the host name of the system to be managed. 1322 

3. Change the setting under Protect Mode to Enabled. 1323 



DRAFT 

 
NIST SP 1800-18C: Privileged Account Management for the Financial Services Sector 92 

 1324 

2.11.6 Adding New Users 1325 

1. Once logged in, navigate to Configure > Server > Add User/Group. 1326 

2. In the search bar, type the name of the domain user, and then click Add User/Group. 1327 

 1328 
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3. SecureONE uses a built-in Google Authenticator for 2FA. Once the new user attempts to log in 1329 

with their domain password, a Quick Response (QR) code is presented.  1330 

 1331 

4. Scan the QR code with the Google Authenticator mobile application to receive your onetime 1332 

passcode, which changes every 60 seconds. 1333 

5. Enter your onetime passcode in the 6-Digit Token field below the QR code. 1334 

2.11.7 Requesting Privileged Access to Protected System 1335 

A user can request privileged access to a system by using the following steps: 1336 

1. Navigate to Access > System Search. 1337 

2. In the search bar, enter the host name of the protected system. 1338 

3. Click Access System. 1339 
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 1340 

4. Once access is granted, the session expiration time will be displayed under Expiration. 1341 

 1342 

5. At this point, the user can log onto the protected system with administrative privileges. 1343 
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2.12 RSA Authentication Manager 1344 

RSA Authentication Manager is responsible for maintaining and managing user profiles, personal 1345 

identification numbers (PINs), and tokens. Using its web interface, users can be activated or deactivated, 1346 

PINs can be configured, and tokens can be assigned to users. Users can be created locally or retrieved 1347 

from identity repositories. 1348 

2.12.1 How It’s Used 1349 

In the example implementation, RSA Authentication Manager was configured to retrieve user account 1350 

information from AD. Only accounts for privileged users were retrieved and configured. Tokens that had 1351 

time-sensitive onetime passcodes were assigned to these user accounts, providing 2FA. 1352 

2.12.2 Installation and Initial Configuration 1353 

Authentication Manager was deployed as an appliance in the example implementation. Once the 1354 

appliance boots successfully, the operator will have the opportunity to change or verify the IP address 1355 

settings. Use the following steps to complete the initial configuration: 1356 

1. To log into the system, use the link and the Quick Setup Access Code that are displayed after 1357 

boot: 1358 

 1359 

2. Enter the Quick Setup Access Code, click Next, and then accept the license agreement. 1360 
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 1361 

3. Click Start Primary Quick Setup. 1362 

 1363 

4. Review the information, and then click Start Step 1. 1364 



DRAFT 

 
NIST SP 1800-18C: Privileged Account Management for the Financial Services Sector 97 

 1365 

5. Upload the License File by clicking Choose File, selecting the appropriate file and clicking Open, 1366 

and then clicking Upload. 1367 

 1368 

6. Enter the Hostname or IP Address of the NTP server in your environment, and then click Next. 1369 
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 1370 

7. Enter the credentials for the Authentication Manager’s OS, and then click Next. 1371 

8. On the following screen, enter the credentials for the Operations Console admin and the 1372 

Security Console admin. 1373 

2.12.3 LDAP Integration 1374 

Authentication Manager can be configured to connect to LDAP sources and to retrieve user profiles for 1375 

easy management. The following steps are used to connect to LDAP repositories, to retrieve user 1376 

account information, and to manage tokens assigned to users: 1377 

1. Go to the operations console by navigating your web browser to 1378 

https://<appliance_IP_address>/oc. 1379 

2. Enter the credentials to log into the operations console. 1380 

3. Navigate to Deployment Configuration > Identity Sources > Add New. On the Connection(s) tab 1381 

in the appropriate fields, add the values necessary for your environment: 1382 
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 1383 

4. Enter the value of a domain admin, such as administrator@acmefinancial.com, in the 1384 

Directory User ID field. 1385 

5. Click Test Connection. 1386 

2.12.4 Token Assignment 1387 

To assign a token to a user, use the following steps: 1388 

1. Go to the security console by navigating your web browser to 1389 

https://<appliance_IP_address>/sc. 1390 

2. Enter the credentials to log into the security console. 1391 

3. Navigate to Identity > Users > Manage Existing. 1392 

4. Ensure that the Identity Source field points to your AD server, identified by its unique name 1393 

given in the operations console. 1394 

5. In the Where field, select User ID. 1395 

6. In the search bar, enter the User ID for which you would like to search. 1396 

7. The user account will be retrieved and displayed. 1397 
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 1398 

8. Click on the User ID (by selecting the check box to the left of the User ID), and then click SecurID 1399 

Tokens. 1400 

9. Click Assign Token. 1401 

 1402 

10. Select a serial number (by selecting the check box to the left of the serial number), and then 1403 

click Assign. 1404 

2.12.5 Software Token Profiles and Token Distribution 1405 

Software Token Profiles specify parameters that enable the secure distribution of assigned tokens to 1406 

users. Use the information provided at https://community.rsa.com/docs/DOC-77084 to create a 1407 

software token profile. To distribute an assigned token to a user, follow the instructions provided at 1408 

https://community.rsa.com/docs/DOC-77090. 1409 

https://community.rsa.com/docs/DOC-77084
https://community.rsa.com/docs/DOC-77090
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2.13 Splunk 1410 

Splunk is a security information and event management system that allows collecting and parsing logs 1411 

and data from multiple systems. 1412 

2.13.1 How It’s Used 1413 

Splunk can receive data from a plethora of different sources. The most reliable option is installing 1414 

Splunk’s Universal Forwarder on each system from which you want to collect data. Other options 1415 

include syslogs, file and directory monitoring, and network events. Once data has been collected by 1416 

Splunk, it can then be parsed and displayed by using prebuilt rules or custom criteria. Splunk is used to 1417 

report and alert on unauthorized activity.  1418 

2.13.2 Installation 1419 

Note: You will need a Splunk account to download Splunk Enterprise. The account is free and can be set 1420 

up at https://www.splunk.com/page/sign_up. 1421 

Download Splunk Enterprise from https://www.splunk.com/en_us/download/splunk-enterprise.html. 1422 

This build uses Version 7.0.3. Splunk can be installed on Windows, Linux, Solaris, and Mac OS X. Each of 1423 

these installation instructions is provided at 1424 

http://docs.splunk.com/Documentation/Splunk/7.1.3/Installation/Beforeyouinstall. 1425 

2.13.3 Queries 1426 

Two Splunk reports were created for this build. One of the reports is named DemoBomgar-AD-Auth-1427 

UnauthV1, which captures activities that are authorized or activities that violate the workflow. The 1428 

other report is named DemoRadiant-AD-Event-Details, which captures more details of those events and 1429 

can be used as a secondary monitor for AD. 1430 

2.13.4 DemoBomgar-AD-Auth-UnauthV1 1431 

index="demo" sourcetype=_json OR sourcetype="csv" NOT host="radiant-logic" NOT ("A 1432 
user account was changed" OR "A user account was enabled")|where NOT like(UserObject, 1433 
"UserObject%")|eval BomgarUserSubject=substr('Event.@sOriginatingAccount',15)|table 1434 
_time host Event.@sEventID Event.@sLoginName Event.@sMessage BomgarUserSubject 1435 
UserSubject UserObject Event|eval 1436 
UserSubject=if(isnotnull(BomgarUserSubject),BomgarUserSubject,UserSubject)|transaction 1437 
UserSubject maxspan=240s|eval 1438 
Policy=if((BomgarUserSubject==UserSubject),"Authorized","Unauthorized")|table _time 1439 
host Policy Event.@sEventID Event.@sLoginName UserSubject UserObject Event 1440 

https://www.splunk.com/page/sign_up
https://www.splunk.com/en_us/download/splunk-enterprise.html
http://docs.splunk.com/Documentation/Splunk/7.1.3/Installation/Beforeyouinstall
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2.13.5 DemoRadiant-AD-Event-Details 1441 

index="demo" 1442 
source="C:\\radiantone\\vds\\r1syncsvcs\\log\\cf_o_acmefinancial\\object_generic_dv_so1443 
_o_acmefinancial_capture.log" OR source="c:\\final_ad.csv" NOT ("A user account was 1444 
changed" OR "A user account was enabled") |rex 1445 
"\<sAMAccountName\>(?P<LDAPObject>.+)\<\/sAMAccountName\>" |rex 1446 
"\<RLICHANGETYPE\>(?P<RLICHANGETYPE>\w+)"|rex 1447 
"<RLICHANGES>(?P<RLICHANGES>.+)\<\/RLICHANGES\>"|rex 1448 
"\<userPrincipalName\>(?P<UserObject>\w+)\@"|table _time host UserSubject LDAPObject 1449 
UserObject Event RLICHANGETYPE RLICHANGES|where isnotnull(UserSubject) OR 1450 
isnotnull(UserObject)| where NOT like(UserObject, "MSOL%")|where NOT like(UserObject, 1451 
"UserObject%")|table _time host UserSubject LDAPObject UserObject Event RLICHANGETYPE 1452 
RLICHANGES|where NOT like(RLICHANGES, "replace: logonCount%")|eval 1453 
RLICHANGETYPE=if(LIKE(Event,"%added%"),"update",RLICHANGETYPE)|eval 1454 
RLICHANGETYPE=if(LIKE(Event,"%created%"),"insert",RLICHANGETYPE)|table _time host 1455 
UserSubject UserObject LDAPObject Event RLICHANGETYPE RLICHANGES|eval 1456 
UserObject=if(LIKE(LDAPObject,"%Admin%"),"",UserObject) 1457 

2.13.6 SSL Forwarding 1458 

We took advantage of Splunk’s built-in SSL forwarding capability and configured SSL encryption between 1459 

forwarders and the indexer. Instructions to enable SSL forwarding are provided at 1460 

http://docs.splunk.com/Documentation/Splunk/7.1.3/Security/ConfigureSplunkforwardingtousesignedc1461 

ertificates.  1462 

http://docs.splunk.com/Documentation/Splunk/7.1.3/Security/ConfigureSplunkforwardingtousesignedcertificates
http://docs.splunk.com/Documentation/Splunk/7.1.3/Security/ConfigureSplunkforwardingtousesignedcertificates
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Appendix A List of Acronyms 1463 

2FA Two-Factor Authentication 

AD Active Directory 

CA Certificate Authority 

CPU Central Processing Unit 

DNS Domain Name System 

FID Federated Identity 

FQDN Fully Qualified Domain Name 

GB Gigabyte(s) 

HDD Hard Disk Drive 

IIS Internet Information Services 

IP Internet Protocol 

IPv4 Internet Protocol Version 4 

IPv6 Internet Protocol Version 6 

IT Information Technology 

LDAP Lightweight Directory Access Protocol 

MFA Multi-Factor Authentication 

N/A Not Applicable 

NCCoE National Cybersecurity Center of Excellence 

NIC Network Interface Controller/Card 

NIST National Institute of Standards and Technology 

OS Operating System 

PAM Privileged Account Management 

PIN Personal Identification Number 

QR Quick Response 

RAM Random-Access Memory 
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SAML Security Assertion Markup Language 

SMB Server Message Block 

SP Special Publication 

SQL Structured Query Language 

SSH Secure Shell 

SSL Secure Sockets Layer 

URL Uniform Resource Locator 

 


	fs-pam-nist-sp1800-18-covers
	fs-pam-nist-sp1800-18a-draft
	fs-pam-nist-sp1800-18b-draft
	fs-pam-nist-sp1800-18-covers
	fs-pam-nist-sp1800-18b-draft
	1 Summary
	1.1 Challenge
	1.2 Solution
	1.3 Benefits

	2 How to Use This Guide
	2.1 Typographic Conventions

	3 Approach
	3.1 Audience
	3.2 Scope
	3.3 Assumptions
	3.4 Risk Assessment
	3.4.1 Assessing Risk Posture
	3.4.2 Security Control Map

	3.5 Security Functions and Subcategories Related to FFIEC
	3.6 Technologies

	4 Architecture
	4.1 Architecture Description
	4.1.1 High-Level Architecture
	4.1.2 Reference Design


	5 Example Implementations
	5.1 Example Implementation 1: Application Layer PAM
	5.2 Example Implementation 2: Organization Infrastructure PAM
	5.3 Example Implementation 3: SIEM
	5.4 Security Monitoring Implementation
	5.5 Use Cases
	5.5.1 Typical Administrator (Directory, Cloud Service, Etc.)
	5.5.1.1 Scenario
	5.5.1.2 Resolution
	5.5.1.3 Other Considerations

	5.5.2 Security Analyst
	5.5.2.1 Scenario
	5.5.2.2 Resolution
	5.5.2.3 Other Considerations

	5.5.3 Business-Critical/High-Value Application Access
	5.5.3.1 Scenario
	5.5.3.2 Resolution
	5.5.3.3 Other Considerations



	6 Security Characteristic Analysis
	6.1 Assumptions and Limitations
	6.2 Build Testing
	6.3 Scenarios and Findings
	6.4 Analysis of the Reference Design’s Support for Cybersecurity Framework Subcategories
	6.4.1 Supported Cybersecurity Framework Subcategories
	6.4.1.1 ID.AM-3: Organizational Communication and Data Flows Are Mapped
	6.4.1.2 ID.AM-6: Cybersecurity Roles and Responsibilities for the Entire Workforce and Third-Party Stakeholders Are Established
	6.4.1.3 ID.BE-5: Resilience Requirements to Support Delivery of Critical Services Are Established
	6.4.1.4 ID.GV-1: Organizational Cybersecurity Policy Is Established and Communicated
	6.4.1.5 ID.GV-2: Cybersecurity Roles and Responsibilities Are Coordinated and Aligned with Internal Roles and External Partners
	6.4.1.6 ID.GV-4: Governance and Risk Management Processes Address Cybersecurity Risks
	6.4.1.7 PR.AC-1: Identities and Credentials Are Issued, Managed, Verified, Revoked, and Audited for Authorized Devices, Users, and Processes
	6.4.1.8 PR.AC-4: Access Permissions and Authorizations Are Managed, Incorporating the Principles of Least Privilege and Separation of Duties
	6.4.1.9 PR.AC-5: Network Integrity Is Protected (e.g., Network Segregation, Network Segmentation)
	6.4.1.10 PR.DS-1: Data at Rest Is Protected
	6.4.1.11 PR.DS-2: Data in Transit Is Protected
	6.4.1.12 PR.DS-5: Protections Against Data Leaks Are Implemented
	6.4.1.13 PR.PT-1: Audit/Log Records Are Determined, Documented, Implemented, and Reviewed in Accordance with Policy
	6.4.1.14 PR.PT-3: Access to Systems and Assets Is Controlled, Incorporating the Principle of Least Functionality
	6.4.1.15 PR.PT-4: Communications and Control Networks Are Protected
	6.4.1.16 DE.AE-2: Detected Events Are Analyzed to Understand Attack Targets and Methods
	6.4.1.17 DE.AE-3: Event Data Are Collected and Correlated from Multiple Sources and Sensors
	6.4.1.18 DE.AE-5: Incident Alert Thresholds Are Established
	6.4.1.19 DE.CM-3: Personnel Activity Is Monitored to Detect Potential Cybersecurity Events
	6.4.1.20 DE.CM-7: Monitoring for Unauthorized Personnel, Connections, Devices, and Software Is Performed
	6.4.1.21 RS.CO-2: Incidents Are Reported Consistent with Established Criteria
	6.4.1.22 RS.AN-3: Forensics Are Performed


	6.5 Security of the Reference Design
	6.5.1 Securing New Attack Surfaces
	6.5.2 Securing Access to the LDAP Directory
	6.5.3 Securing Access to the Policy Management Capability
	6.5.4 Securing Access to the User Interface (Access Control) Capability
	6.5.5 Securing Password Vault Capability
	6.5.6 Securing Emergency Access Capability
	6.5.7 Securing Access to the Security Monitoring and Analytics Capability
	6.5.8 Ensuring Information Integrity
	6.5.9 Protecting Privileged Accounts
	6.5.10 Preventing Insider Threats
	6.5.11 Addressing Attacks
	6.5.12 User Behavior Analytics

	6.6 Deployment Recommendations
	6.6.1 Patch, Harden, Scan, and Test
	6.6.2 Other Security Best Practices
	6.6.3 Deployment Phases
	6.6.4 Policy Recommendations


	7 Functional Evaluation
	7.1 PAM Functional Test Plan
	7.1.1 PAM Use Case Requirements
	7.1.2 Test Case: PAM-1
	7.1.3 Test Case: PAM-2
	7.1.4 Test Case: PAM-3
	7.1.5 Test Case: PAM-4
	7.1.6 Test Case: PAM-5
	7.1.7 Test Case: PAM-6
	7.1.8 Test Case: PAM-7
	7.1.9 Test Case: PAM-8
	Appendix A List of Acronyms
	Appendix B References





	fs-pam-nist-sp1800-18c-draft
	fs-pam-nist-sp1800-18-covers
	fs-pam-nist-sp1800-18c-draft
	1 Introduction
	1.1 Practice Guide Structure
	1.2 Build Overview
	1.3 Typographic Conventions

	2 Product Installation Guides
	2.1 Microsoft Active Directory
	2.1.1 How It’s Used
	2.1.2 Virtual Machine Configuration
	2.1.3 Installation
	2.1.4 DNS Configuration
	2.1.5 Group Policy Object Configuration
	2.1.6 Scripts
	2.1.7 Splunk Universal Forwarder

	2.2 Bomgar Privileged Identity
	2.2.1 How It’s Used
	2.2.2 Virtual Machine Configuration
	2.2.3 Prerequisites
	2.2.4 Installing Privileged Identity
	2.2.5 Configuration
	2.2.5.1 Management Set
	2.2.5.2 Delegation Identities

	2.2.6 Installing Privileged Identity Application Launcher
	2.2.7 Configure Bomgar Privileged Identity with IdRamp SAML Authentication
	2.2.8 Configuring Microsoft SQL Server Access
	2.2.9 Configuring Twitter Account Launching
	2.2.10 Configuring Multifactor Authentication with RSA
	2.2.11 Splunk Universal Forwarder

	2.3 TDi ConsoleWorks
	2.3.1 How It’s Used
	2.3.2 Virtual Machine Configuration
	2.3.3 Installation
	2.3.4 Configuration of Back-End Authentication
	2.3.5 Creating Users
	2.3.6 Creating Tags
	2.3.7 Creating SSH Consoles
	2.3.8 Creating Web Consoles
	2.3.9 Assigning Tags to Consoles
	2.3.10 Creating Profiles for Users
	2.3.11 Assigning Permissions to Profiles

	2.4 Ekran System
	2.4.1 How It’s Used
	2.4.2 Virtual Machine Configuration
	2.4.3 Prerequisites
	2.4.4 Installing Ekran System

	2.5 Radiant Logic
	2.5.1 How It’s Used
	2.5.2 Virtual Machine
	2.5.3 Prerequisites
	2.5.4 Installation
	2.5.5 Configure FID
	2.5.6 Configure Logging
	2.5.7 Configure SSL
	2.5.8 Splunk Universal Forwarder

	2.6 IdRamp
	2.6.1 How It’s Used
	2.6.2 Prerequisites
	2.6.3 Installation

	2.7 OneSpan IDENTIKEY Authentication Server
	2.7.1 How It’s Used
	2.7.2 Virtual Machine Configuration
	2.7.3 Prerequisites
	2.7.4 Installation
	2.7.5 Configuration
	2.7.6 Creating a Domain and Policies
	2.7.7 Importing DIGIPASSes
	2.7.8 Configuring to Use Radiant Logic as a Back-End Authentication Server
	2.7.8.1 Installing the AD CA Certificate in the OneSpan Server OS
	2.7.8.2 Configuring OneSpan to Use Radiant Logic

	2.7.9 Integration with TDi ConsoleWorks
	2.7.10 Installing User Websites
	2.7.11 Creating Component Records in IDENTIKEY Authentication Server

	2.8 Base Linux OS
	2.8.1 Virtual Machine Configuration
	2.8.2 Domain Join Configuration

	2.9 Microsoft SQL Server Installation on Ubuntu Linux
	2.9.1 How It’s Used
	2.9.2 Virtual Machine Configuration
	2.9.3 Firewall Configuration
	2.9.4 Installation and Initial Configuration

	2.10 Samba File Server
	2.10.1 How It’s Used
	2.10.2 Virtual Machine Configuration
	2.10.3 Firewall Configuration
	2.10.4 Installation and Configuration

	2.11 Remediant SecureONE
	2.11.1 How It’s Used
	2.11.2 Virtual Machine Configuration
	2.11.3 Installation and Initial Configuration
	2.11.4 Domain Configuration
	2.11.5 Managing Systems
	2.11.6 Adding New Users
	2.11.7 Requesting Privileged Access to Protected System

	2.12 RSA Authentication Manager
	2.12.1 How It’s Used
	2.12.2 Installation and Initial Configuration
	2.12.3 LDAP Integration
	2.12.4 Token Assignment
	2.12.5 Software Token Profiles and Token Distribution

	2.13 Splunk
	2.13.1 How It’s Used
	2.13.2 Installation
	2.13.3 Queries
	2.13.4 DemoBomgar-AD-Auth-UnauthV1
	2.13.5 DemoRadiant-AD-Event-Details
	2.13.6 SSL Forwarding
	Appendix A List of Acronyms







<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.5
  /CompressObjects /All
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo false
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /AgencyFB-Bold
    /AgencyFB-Reg
    /Algerian
    /Arial-Black
    /Arial-BoldItalicMT
    /Arial-BoldMT
    /Arial-ItalicMT
    /ArialMT
    /ArialNarrow
    /ArialNarrow-Bold
    /ArialNarrow-BoldItalic
    /ArialNarrow-Italic
    /ArialRoundedMTBold
    /ArialUnicodeMS
    /Bahnschrift
    /BaskOldFace
    /Bauhaus93
    /BellMT
    /BellMTBold
    /BellMTItalic
    /BerlinSansFB-Bold
    /BerlinSansFBDemi-Bold
    /BerlinSansFB-Reg
    /BernardMT-Condensed
    /BlackadderITC-Regular
    /BodoniMT
    /BodoniMTBlack
    /BodoniMTBlack-Italic
    /BodoniMT-Bold
    /BodoniMT-BoldItalic
    /BodoniMTCondensed
    /BodoniMTCondensed-Bold
    /BodoniMTCondensed-BoldItalic
    /BodoniMTCondensed-Italic
    /BodoniMT-Italic
    /BodoniMTPosterCompressed
    /BookAntiqua
    /BookAntiqua-Bold
    /BookAntiqua-BoldItalic
    /BookAntiqua-Italic
    /BookmanOldStyle
    /BookmanOldStyle-Bold
    /BookmanOldStyle-BoldItalic
    /BookmanOldStyle-Italic
    /BookshelfSymbolSeven
    /BradleyHandITC
    /BritannicBold
    /Broadway
    /BrushScriptMT
    /Calibri
    /Calibri-Bold
    /Calibri-BoldItalic
    /Calibri-Italic
    /Calibri-Light
    /Calibri-LightItalic
    /CalifornianFB-Bold
    /CalifornianFB-Italic
    /CalifornianFB-Reg
    /CalisMTBol
    /CalistoMT
    /CalistoMT-BoldItalic
    /CalistoMT-Italic
    /Cambria
    /Cambria-Bold
    /Cambria-BoldItalic
    /Cambria-Italic
    /CambriaMath
    /Candara
    /Candara-Bold
    /Candara-BoldItalic
    /Candara-Italic
    /Castellar
    /Centaur
    /Century
    /CenturyGothic
    /CenturyGothic-Bold
    /CenturyGothic-BoldItalic
    /CenturyGothic-Italic
    /CenturySchoolbook
    /CenturySchoolbook-Bold
    /CenturySchoolbook-BoldItalic
    /CenturySchoolbook-Italic
    /Chiller-Regular
    /ColonnaMT
    /ComicSansMS
    /ComicSansMS-Bold
    /ComicSansMS-BoldItalic
    /ComicSansMS-Italic
    /Consolas
    /Consolas-Bold
    /Consolas-BoldItalic
    /Consolas-Italic
    /Constantia
    /Constantia-Bold
    /Constantia-BoldItalic
    /Constantia-Italic
    /CooperBlack
    /CopperplateGothic-Bold
    /CopperplateGothic-Light
    /Corbel
    /Corbel-Bold
    /Corbel-BoldItalic
    /Corbel-Italic
    /CourierNewPS-BoldItalicMT
    /CourierNewPS-BoldMT
    /CourierNewPS-ItalicMT
    /CourierNewPSMT
    /CurlzMT
    /Ebrima
    /Ebrima-Bold
    /EdwardianScriptITC
    /Elephant-Italic
    /Elephant-Regular
    /EngraversMT
    /ErasITC-Bold
    /ErasITC-Demi
    /ErasITC-Light
    /ErasITC-Medium
    /FelixTitlingMT
    /FootlightMTLight
    /ForteMT
    /FranklinGothic-Book
    /FranklinGothic-BookItalic
    /FranklinGothic-Demi
    /FranklinGothic-DemiCond
    /FranklinGothic-DemiItalic
    /FranklinGothic-Heavy
    /FranklinGothic-HeavyItalic
    /FranklinGothic-Medium
    /FranklinGothic-MediumCond
    /FranklinGothic-MediumItalic
    /FreestyleScript-Regular
    /FrenchScriptMT
    /Gabriola
    /Gadugi
    /Gadugi-Bold
    /Garamond
    /Garamond-Bold
    /Garamond-Italic
    /Georgia
    /Georgia-Bold
    /Georgia-BoldItalic
    /Georgia-Italic
    /Gigi-Regular
    /GillSansMT
    /GillSansMT-Bold
    /GillSansMT-BoldItalic
    /GillSansMT-Condensed
    /GillSansMT-ExtraCondensedBold
    /GillSansMT-Italic
    /GillSans-UltraBold
    /GillSans-UltraBoldCondensed
    /GloucesterMT-ExtraCondensed
    /GoudyOldStyleT-Bold
    /GoudyOldStyleT-Italic
    /GoudyOldStyleT-Regular
    /GoudyStout
    /Haettenschweiler
    /HarlowSolid
    /Harrington
    /HighTowerText-Italic
    /HighTowerText-Reg
    /HoloLensMDL2Assets
    /Impact
    /ImprintMT-Shadow
    /InformalRoman-Regular
    /JavaneseText
    /Jokerman-Regular
    /JuiceITC-Regular
    /KristenITC-Regular
    /KunstlerScript
    /LatinWide
    /LeelawadeeUI
    /LeelawadeeUI-Bold
    /LeelawadeeUI-Semilight
    /LucidaBright
    /LucidaBright-Demi
    /LucidaBright-DemiItalic
    /LucidaBright-Italic
    /LucidaCalligraphy-Italic
    /LucidaConsole
    /LucidaFax
    /LucidaFax-Demi
    /LucidaFax-DemiItalic
    /LucidaFax-Italic
    /LucidaHandwriting-Italic
    /LucidaSans
    /LucidaSans-Demi
    /LucidaSans-DemiItalic
    /LucidaSans-Italic
    /LucidaSans-Typewriter
    /LucidaSans-TypewriterBold
    /LucidaSans-TypewriterBoldOblique
    /LucidaSans-TypewriterOblique
    /LucidaSansUnicode
    /Magneto-Bold
    /MaiandraGD-Regular
    /MalgunGothic
    /MalgunGothicBold
    /MalgunGothic-Semilight
    /Marlett
    /MaturaMTScriptCapitals
    /MicrosoftHimalaya
    /MicrosoftJhengHeiBold
    /MicrosoftJhengHeiLight
    /MicrosoftJhengHeiRegular
    /MicrosoftJhengHeiUIBold
    /MicrosoftJhengHeiUILight
    /MicrosoftJhengHeiUIRegular
    /MicrosoftNewTaiLue
    /MicrosoftNewTaiLue-Bold
    /MicrosoftPhagsPa
    /MicrosoftPhagsPa-Bold
    /MicrosoftSansSerif
    /MicrosoftTaiLe
    /MicrosoftTaiLe-Bold
    /MicrosoftYaHei
    /MicrosoftYaHei-Bold
    /MicrosoftYaHeiLight
    /MicrosoftYaHeiUI
    /MicrosoftYaHeiUI-Bold
    /MicrosoftYaHeiUILight
    /Microsoft-Yi-Baiti
    /MingLiU-ExtB
    /Ming-Lt-HKSCS-ExtB
    /Mistral
    /MITRE
    /Modern-Regular
    /MongolianBaiti
    /MonotypeCorsiva
    /MS-Gothic
    /MSOutlook
    /MS-PGothic
    /MSReferenceSansSerif
    /MSReferenceSpecialty
    /MS-UIGothic
    /MT-Extra
    /MVBoli
    /MyanmarText
    /MyanmarText-Bold
    /NiagaraEngraved-Reg
    /NiagaraSolid-Reg
    /NirmalaUI
    /NirmalaUI-Bold
    /NirmalaUI-Semilight
    /NSimSun
    /OCRAExtended
    /OldEnglishTextMT
    /Onyx
    /PalaceScriptMT
    /PalatinoLinotype-Bold
    /PalatinoLinotype-BoldItalic
    /PalatinoLinotype-Italic
    /PalatinoLinotype-Roman
    /Papyrus-Regular
    /Parchment-Regular
    /Perpetua
    /Perpetua-Bold
    /Perpetua-BoldItalic
    /Perpetua-Italic
    /PerpetuaTitlingMT-Bold
    /PerpetuaTitlingMT-Light
    /Playbill
    /PMingLiU-ExtB
    /PoorRichard-Regular
    /Pristina-Regular
    /RageItalic
    /Ravie
    /Rockwell
    /Rockwell-Bold
    /Rockwell-BoldItalic
    /Rockwell-Condensed
    /Rockwell-CondensedBold
    /Rockwell-ExtraBold
    /Rockwell-Italic
    /ScriptMTBold
    /SegoeMDL2Assets
    /SegoePrint
    /SegoePrint-Bold
    /SegoeScript
    /SegoeScript-Bold
    /SegoeUI
    /SegoeUIBlack
    /SegoeUIBlack-Italic
    /SegoeUI-Bold
    /SegoeUI-BoldItalic
    /SegoeUIEmoji
    /SegoeUIHistoric
    /SegoeUI-Italic
    /SegoeUI-Light
    /SegoeUI-LightItalic
    /SegoeUI-Semibold
    /SegoeUI-SemiboldItalic
    /SegoeUI-Semilight
    /SegoeUI-SemilightItalic
    /SegoeUISymbol
    /ShowcardGothic-Reg
    /SimSun
    /SimSun-ExtB
    /SitkaBanner
    /SitkaBanner-Bold
    /SitkaBanner-BoldItalic
    /SitkaBanner-Italic
    /SitkaDisplay
    /SitkaDisplay-Bold
    /SitkaDisplay-BoldItalic
    /SitkaDisplay-Italic
    /SitkaHeading
    /SitkaHeading-Bold
    /SitkaHeading-BoldItalic
    /SitkaHeading-Italic
    /SitkaSmall
    /SitkaSmall-Bold
    /SitkaSmall-BoldItalic
    /SitkaSmall-Italic
    /SitkaSubheading
    /SitkaSubheading-Bold
    /SitkaSubheading-BoldItalic
    /SitkaSubheading-Italic
    /SitkaText
    /SitkaText-Bold
    /SitkaText-BoldItalic
    /SitkaText-Italic
    /SnapITC-Regular
    /Stencil
    /Sylfaen
    /SymbolMT
    /Tahoma
    /Tahoma-Bold
    /TempusSansITC
    /TimesNewRomanPS-BoldItalicMT
    /TimesNewRomanPS-BoldMT
    /TimesNewRomanPS-ItalicMT
    /TimesNewRomanPSMT
    /Trebuchet-BoldItalic
    /TrebuchetMS
    /TrebuchetMS-Bold
    /TrebuchetMS-Italic
    /TwCenMT-Bold
    /TwCenMT-BoldItalic
    /TwCenMT-Condensed
    /TwCenMT-CondensedBold
    /TwCenMT-CondensedExtraBold
    /TwCenMT-Italic
    /TwCenMT-Regular
    /Verdana
    /Verdana-Bold
    /Verdana-BoldItalic
    /Verdana-Italic
    /VinerHandITC
    /Vivaldii
    /VladimirScript
    /Webdings
    /Wingdings2
    /Wingdings3
    /Wingdings-Regular
    /YuGothic-Bold
    /YuGothic-Light
    /YuGothic-Medium
    /YuGothic-Regular
    /YuGothicUI-Bold
    /YuGothicUI-Light
    /YuGothicUI-Regular
    /YuGothicUI-Semibold
    /YuGothicUI-Semilight
    /ZWAdobeF
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<


    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e55464e1a65876863768467e5770b548c62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc666e901a554652d965874ef6768467e5770b548c52175370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>



    /HUN <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF adatti per visualizzare e stampare documenti aziendali in modo affidabile. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 6.0 e versioni successive.)
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020be44c988b2c8c2a40020bb38c11cb97c0020c548c815c801c73cb85c0020bcf4ace00020c778c1c4d558b2940020b3700020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200036002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken waarmee zakelijke documenten betrouwbaar kunnen worden weergegeven en afgedrukt. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 6.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>


    /SKY <>

    /SUO <>
    /SVE <>
    /TUR <>

    /ENU (Use these settings to create Adobe PDF documents suitable for reliable viewing and printing of business documents.  Created PDF documents can be opened with Acrobat and Adobe Reader 6.0 and later.)
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice




